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Access lets you trap some errors that can occur during program execution. By using the errortrapping commands mentioned in Chapter 7, “Handling Your Errors in Access with VBA,” you
can anticipate errors and handle them accordingly.
The following table lists both Access 2002 application/VBA errors and Jet 4.0 errors. The error
numbers can potentially go up to 32767, with user-definable errors from 30000 on.
The code in Listing E.1 creates the data in the upcoming table.
LISTING E.1

Storing All Access and Jet Errors to a Table

Sub CreateErrorTable()
Dim cnn As ADODB.Connection
Dim rst As New ADODB.Recordset
Dim lngCurr As Long
Set cnn = CurrentProject.Connection
cnn.Execute “Delete • From tblErrors”
rst.Open “tblErrors”, cnn, adOpenKeyset, adLockOptimistic
For lngCurr = 1 To 33000
If Len(AccessError(lngCurr)) > 0 And AccessError(lngCurr) <> _
“Application-defined or object-defined error” Then
rst.AddNew
rst![Error Number] = lngCurr
rst!Description = AccessError(lngCurr)
rst.Update
End If
Next lngCurr
End Sub

A few items to note:
• Some Jet errors use the | symbol, which is a placeholder for variables passed to the
errors. An example of this is error number 3006, Database ‘|’ is exclusively
locked., in which the pipe would be replaced with the name of the database exclusively
locked.
• It’s best to create user-defined errors by using error numbers 30000 and above. By starting at 30000, you have a smaller chance of Access expanding its own errors up that far.
• Errors in which the message is an • are special errors that Access handles in different
ways.
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• Errors not listed here are either application-defined or object-defined errors, or are
reserved for future use in new versions of Access or with the Jet engine.
ErrorString

5
6
7
9
10
11
13
14
16
17
18
28
47
48
49
51
52
53
54
55
57
58
59
61
62
63
67
68
70
71

Invalid procedure call or argument
Overflow
Out of memory
Subscript out of range
This array is fixed or temporarily locked
Division by zero
Type mismatch
Out of string space
Expression too complex
Can’t perform requested operation
User interrupt occurred
Out of stack space
Too many DLL application clients
Error in loading DLL
Bad DLL calling convention
Internal error
Bad file name or number
File not found
Bad file mode
File already open
Device I/O error
File already exists
Bad record length
Disk full
Input past end of file
Bad record number
Too many files
Device unavailable
Permission denied
Disk not ready
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74
75
76
93
96

Can’t rename with different drive
Path/File access error
Path not found
Invalid pattern string
Unable to sink events of object because the object is already firing
events to the maximum number of event receivers that it supports
Can not call friend function on object which is not an instance of defining class
A property or method call cannot include a reference to a private
object, either as an argument or as a return value
Invalid file format
Can’t create necessary temporary file
Invalid format in resource file
Invalid property value
Invalid property array index
Set not supported at runtime
Set not supported (read-only property)
Need property array index
Set not permitted
Get not supported at runtime
Get not supported (write-only property)
Property not found
Property or method not found
Object required
ActiveX component can’t create object
Class does not support Automation or does not support expected interface
File name or class name not found during Automation operation
Object doesn’t support this property or method
Automation error
Connection to type library or object library for remote process has
been lost. Press OK for dialog to remove reference.
Automation object does not have a default value

97
98
321
322
325
380
381
382
383
385
387
393
394
422
423
424
429
430
432
438
440
442
443
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445
446
447
448
449
450
451

Object doesn’t support this action
Object doesn’t support named arguments
Object doesn’t support current locale setting
Named argument not found
Argument not optional
Wrong number of arguments or invalid property assignment
Property let procedure not defined and property get procedure did not
return an object
Invalid ordinal
Specified DLL function not found
Code resource not found
Code resource lock error
This key is already associated with an element of this collection
Variable uses an Automation type not supported in Visual Basic
Object or class does not support the set of events
Invalid clipboard format
Method or data member not found
The remote server machine does not exist or is unavailable
Class not registered on local machine
Invalid picture
Printer error
Can’t save file to TEMP
Search text not found
Replacements too long
You canceled the previous operation.
You tried to perform an operation involving a function or feature that
was not installed in this version of Microsoft Access.
There isn’t enough memory to perform this operation. Close unneeded
programs and try the operation again.
There isn’t enough free memory to start Microsoft Access. Close
unneeded programs and try again. For information on freeing memory,
search the Microsoft Windows Help index for ‘memory, troubleshooting’.

452
453
454
455
457
458
459
460
461
462
463
481
482
735
744
746
2001
2002
2004
2005
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2006

The object name ‘|’ you entered doesn’t follow Microsoft Access
object-naming rules. For more information about naming objects, click
Help.
You already have an open database object named ‘|.’ Use a different
name for each database object of the same type. If you want this object
to replace the original object, close the original object, and then save
this object using the same name. For more information on renaming a
database object, click Help.
You can’t delete the database object ‘|’ while it’s open. Close the database object, and then delete it.
You can’t rename the database object ‘|’ while it’s open. Close the database object, and then rename it.
You can’t delete the database object ‘|’ while it’s open. Close the database object, and then delete it.
The password you entered is incorrect.
You have given this |1 the same name as an existing |2 in your database. You can’t give a table and a query the same name. Give this
object a name that isn’t already used by another table or query.
There are no registered wizards of this type. Rerun Microsoft Access or
Microsoft Office Setup to reinstall the wizards. If you want to preserve
your security or custom settings, back up the Microsoft Access workgroup information file. For more information on backing up files,
search the Microsoft Windows Help index for ‘backing up files’.
You can’t modify the attributes of System Tables.

2007

2008
2009
2010
2011
2014

2015

2016
2017

2018
2019

2020
2021

This Visual Basic for Applications Project has been protected with a
password. You must supply the password in the Visual Basic Editor
before you can perform this operation.
The data access page name ‘|’ you entered is misspelled or refers to a
data access page that isn’t open or doesn’t exist.
The number you used to refer to the data access page is invalid. Use
the Count property to count the open data access pages and make sure
that the page number is not greater than the number of open data
access pages minus one.
The data access page theme name ‘|’ you entered is misspelled or refers
to a theme name that doesn’t exist.
One or more operators in the filter expression is invalid. For a valid list
of operators refer to the help file.
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2022

You entered an expression that requires a data access page to be the
active window.
The file name you specified for the data access page already exists.
The report snapshot was not created because you don’t have enough
free disk space for temporary work files. To fix this, free up disk space
(for example, empty the Recycle Bin or delete unnecessary files).
The file is not in the correct format for a Microsoft Access project.
Your computer is missing at least one of the Microsoft Access 97
object libraries. Your converted database will not work until you open
this database using Access 97 and then fix any missing references.
Press OK to continue saving this database in the Access 97 format with
missing references, or press Cancel if you no longer wish to save this
database.
This operation is not supported for Microsoft Access 1.X databases.
Microsoft Access was unable to close the database object.
Microsoft Office applications cannot suspend while you have documents open from a network location. Exit the applications or close the
open documents and try again.
The Microsoft Access project ‘|’ will be opened read-only because one
of the following occurred: The file is locked for editing by another
user, or the file (or the folder in which it is located,) is marked as readonly, or you specified that you wanted to open this file read-only.
You can’t convert or enable an MDE file.
Some errors happened during the conversion. No converted database
was generated.
Name conflicts with existing module, project, or object library.
Cannot Compile Project.
Cannot Load Project of wrong version.
Microsoft Access does not support using ADP Projects when running
in Runtime Mode.
Microsoft Access could not perform name AutoCorrect during this
operation. The ‘Log name AutoCorrect’ option is set, but the Data and
Misc. Objects is not checked out.
The file ‘|’ cannot be opened because it has been locked by another
user.
You cannot convert a workgroup file from Microsoft Access2000 to
Access 97. You must create new security settings in Access 97.

2023
2024

2025
2026

2027
2028
2029

2030

2031
2032
2033
2034
2035
2036
2037

2038
2039
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2040
2041
2042

Microsoft Access can’t run.
Microsoft Access couldn’t find file ‘|’. This file is required for startup.
A system error occurred, or there isn’t enough free memory to start
Microsoft Access. Close unneeded programs and try again.
Microsoft Access can’t find the database file ‘|.’ Make sure you entered
the correct path and file name.
You can’t exit Microsoft Access now. If you’re running a Visual Basic
module that is using OLE or DDE, you may need to interrupt the module.
The command line you used to start Microsoft Access contains an
option that Microsoft Access doesn’t recognize. Exit and restart
Microsoft Access using valid command-line options.
The command or action ‘|’ isn’t available now.
• You may be in a read-only database or an unconverted database from
an earlier version of Microsoft Access.
• The type of object the action applies to isn’t currently selected or
isn’t in the active view. Use only those commands and macro actions
that are currently available for this database.
There isn’t enough free memory to open the file ‘|.’ Close unneeded
programs and try again. For more information on freeing memory,
search the Microsoft Windows Help index for ‘memory, troubleshooting’.
The Tahoma font is not present. To restore it, please run Detect and
Repair from the Help menu.
Enter an OLE/DDE Timeout setting from 0 through 300 seconds.
The object name ‘|1’ can’t be longer than |2 characters according to
Microsoft Access object-naming rules.
There isn’t enough free memory to update the display. Close unneeded
programs and try again.
The command name can’t be blank. Please choose a name.
Microsoft Access is unable to load the Visual Basic for Applications
dynamic-link library (DLL) Vbe6. Rerun the Microsoft Access Setup
program.
The expression ‘|’ you entered is invalid.
Microsoft Access can’t supply context-sensitive Help.
There isn’t enough stack memory left to perform the operation. The
operation is too complicated. Try simplifying the operation.

2043
2044

2045

2046

2048

2049
2050
2051
2052
2053
2054

2055
2056
2057
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2058

The file ‘|’ is incompatible. Microsoft Access needs to be reinstalled.
Run Setup to reinstall Microsoft Access. If you want to preserve your
security or custom settings, back up the Microsoft Access workgroup
information file. For more information on backing up files, search the
Microsoft Windows Help index for ‘backing up files’.
Microsoft Access cannot find the object ‘|’. Make sure the object exists
and that you spell its name correctly.
You can’t create a field list based on the action query ‘|.’ Action queries
don’t have fields. A form or report must be based on a table, or on a
select or crosstab query. Change the RecordSource property for the
form or report, or open the action query and change it to a select query.
Enter a zero or greater-than-zero number for this option.
The command name must be shorter than 255 Characters. Please
choose a name.
Microsoft Access can’t create, open, or write to the index file ‘|’; the
information (.inf) file it uses to keep track of dBASE indexes. The
index file may be damaged, or you may not have read/write permission
for the network drive you’re trying to link to. You can link to the
dBASE file without specifying any dBASE indexes, but the existing
indexes will not be used with the linked table.
The menu bar value ‘|’ is invalid. You supplied an argument to the
DoMenuItem method that refers to a menu bar that is invalid. Use an
intrinsic constant or numeric value that refers to a valid menu bar
value, such as acFormbar.
The name for the menu, command, or subcommand you entered is
invalid. You supplied an argument to the DoMenuItem method that
refers to a menu name, command, or subcommand that is invalid. Use
an intrinsic constant or numeric value that refers to a valid menu, command, or subcommand value, such as acRecordsMenu.
A video adapter resolution of at least 640 x 480 pixels is required to
run Microsoft Access.
A menu bar macro can only be run if the menu bar macro name is the
setting used by particular properties or options. You tried to run a menu
bar macro containing the AddMenu action. Set one of the following
properties or options to the name of the menu bar macro:
• The MenuBar property of a form or report.
• The ShortcutMenuBar property of a form, report, or control.

2059
2060

2061
2062
2063

2064

2065

2066
2067
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2068

2069

2070
2071

2072
2073
2074
2075
2076
2077
2078

2079
2080
2081
2082

ErrorString
• The Menu Bar or Shortcut Menu Bar option in the Startup dialog
box.
This error also occurs if Microsoft Access attempts to run a menu bar
macro containing an AddMenu action that follows an action that makes
some other object the active object. For example, the OpenForm action.
The selected item is customized and doesn’t have context-sensitive
Help. For more information on creating custom Help for a form, report,
or control, click Help.
The key or key combination |1 in |2 has invalid syntax or is not
allowed. Use the SendKeys syntax to specify the key or key combinations. For the allowed key or key combinations, click Help.
You already assigned the key or key combination |1 in |2 to another
macro. Only the first key or key combination will be used.
The Docking property can’t be set to ‘|1’ at this time. If you want to set
the Docking property to ‘|2’, move the toolbar from its current position
and try again.
Successfully imported ‘|’.
Successfully exported ‘|’.
This operation is not supported within transactions.
This operation requires an open database.
Successfully linked ‘|’.
This Recordset is not updateable.
Help isn’t available due to lack of memory or improper installation of
Microsoft Windows or Microsoft Access. For more information on
troubleshooting a low memory problem, search the Microsoft Windows
Help index for ‘memory, troubleshooting’. If you need to reinstall
Microsoft Access, you may want to preserve your security or custom
settings. To do so, back up the Microsoft Access workgroup information file. For more information on backing up files, search the
Microsoft Windows Help index for ‘backing up files’.
Form is read-only, because the Unique Table property is not set.
The toolbar or menu | already exists. Do you want to replace the existing toolbar or menu?
The Create From Macro command only works when a macro is
selected in the Database window.
Only fields from the Unique Table can be edited.
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2083

The database ‘|’ is read-only. You can’t save changes made to data or
object definitions in this database.
Field ‘|’ is based on an expression and can’t be edited.
The ODBC Refresh Interval setting must be from 1 through 32,766
seconds.
Recordset requires a form to be updateable.
Microsoft Access can’t display the Add-ins submenu. The Add-ins
submenu expression ‘|’ you entered exceeds the 256-character limit.
Shorten the macroname or functionname expression in the Menu Addins key of the Windows Registry setting, and then restart Microsoft
Access. For more information on customizing Microsoft Access settings in the Windows Registry, click Help.
Microsoft Access can’t display the Add-ins submenu | because a setting
you entered in the Windows Registry is missing a macro name or function name expression. Supply the missing expression in the Menu Addins key of the Windows Registry, and then restart Microsoft Access.
For more information on customizing Microsoft Access settings in the
Windows Registry, click Help.
Microsoft Access can’t display the same menu more than once in a
menu bar.
An action within the current global menu’s macro group can’t change
the global menu bar. Microsoft Access can’t display the global menu
bar because the macro called when you first set the global menu
includes another action that tries to reset the global menu. Check your
menu bar macros, and make sure that you set the global menu bar only
once.
‘|’ is an invalid name.
The value you specified for the setting argument in the SetOption
method isn’t the correct type of Variant for this option. You specified a
string when Microsoft Access expected a number. Check the Options
dialog box (Tools menu) to see what type of data is required to set this
particular option. For example, the setting for the Default Database
Folder option must be a string. To see what type of Variant you passed
to the SetOption method, use the VarType function. For more information, search the Help index for ‘Variant data type’ and ‘VarType
function’.

2084
2085
2086
2087

2088

2089
2090

2091
2092
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2093

The numeric value for the setting argument in the SetOption method
doesn’t correspond to any list box or option group settings in the
Options dialog box. Valid settings are 0 (the first item in the list)
through | (the last item in the list).
Microsoft Access can’t find the toolbar ‘|.’ You tried to run a macro that
includes a ShowToolbar action or a Visual Basic procedure that
includes a ShowToolbar method.
• The toolbar name may be misspelled.
• This action may refer to a custom toolbar that was deleted from or
renamed in the current database.
• This action may refer to a custom toolbar that exists in a different
database.
Microsoft Access can’t switch to |. The Microsoft application you tried
to open can’t be found or hasn’t been installed on your computer.
Microsoft Access can’t open the Microsoft Office application because
it can’t find the dynamic-link library Mstool32. Run Setup to reinstall
Microsoft Access. If you want to preserve your security or custom settings, back up the Microsoft Access workgroup information file. For
more information on backing up files, search the Microsoft Windows
Help index for ‘backing up files’.
The table you tried to create an import/export specification for was created in an earlier version of Microsoft Access. Convert this database to
the current version of Microsoft Access by using the Convert Database
command (Tools menu, Database Utilities submenu).
The control or subform control is too large for this location. The number you entered for the Left, Top, Height, or Width property is too
large or is a negative number. Reduce the size of the control or subform control, or enter a positive number.
The setting you entered isn’t valid for this property. To see the valid
settings for this property, search the Help index for the name of the
property.
The form name ‘|’ is misspelled or refers to a form that doesn’t exist. If
the invalid form name is in a macro, an Action Failed dialog box will
display the macro name and the macro’s arguments after you click OK.
Open the Macro window, and enter the correct form name.

2094

2095
2096

2097

2100

2101

2102
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2103

The report name ‘|’ you entered in either the property sheet or macro is
misspelled or refers to a report that doesn’t exist. If the invalid report
name is in a macro, an Action Failed dialog box will display the macro
name and the macro’s arguments after you click OK. Open the Macro
window, and enter the correct report name.
You entered the control name ‘|,’ which is already in use. You already
have a control on the form with this name, or an existing control has its
name mapped to this name for Visual Basic. Visual Basic maps spaces
in control names to underscores. For example, My Control and
My_Control are treated as duplicate names.
You can’t go to the specified record. You may be at the end of a recordset.
| errors occurred when you loaded the form or report. You loaded a
form or report that has controls or properties that Microsoft Access
doesn’t recognize and will ignore.
The value you entered doesn’t meet the validation rule defined for the
field or control. To see the validation rule, click Design view, click the
appropriate field, and then, if the property sheet isn’t open, click the
Properties button on the toolbar. Then click the Data tab. To solve this
problem, enter a value that meets the validation rule, or press ESC to
undo your changes.
You must save the field before you execute the GoToControl action,
the GoToControl method, or the SetFocus method. You tried to move
the focus to another control using the SetFocus method, GoToControl
action, or the GoToControl method. Set the macro or method to the
AfterUpdate property instead of the BeforeUpdate property so it saves
the field before changing the focus.
There is no field named ‘|’ in the current record.
Microsoft Access can’t move the focus to the control |.
• The control may be a type that can’t receive the focus, such as a
label.
• The control’s Visible property may be set to No.
• The control’s Enabled property may be set to No.
The changes you made can’t be saved. The save operation may have
failed due to the temporary locking of the records by another user.
• Click OK to try again. You may need to click OK several times (or
wait until the other user closes the table).
• Click Cancel if repeated attempts to save your changes fail.

2104

2105
2106

2107

2108

2109
2110

2111
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2112
2113

The item on the Clipboard can’t be pasted into this control.
The value you entered isn’t valid for this field. For example, you may
have entered text in a numeric field or a number that is larger than the
FieldSize setting permits.
Microsoft Access doesn’t support the format of the file ‘|,’ or file is too
large. Try converting the file to BMP or GIF format.
The macro or function set to the BeforeUpdate or ValidationRule property for this field is preventing Microsoft Access from saving the data
in the field.
• If this is a macro, open the macro in the Macro window and remove
the action that forces a save (for example, GoToControl).
• If the macro includes a SetValue action, set the macro to the
AfterUpdate property of the control instead.
• If this is a function, redefine the function in the Module window.
The value in the field or record violates the validation rule for the
record or field. For example, you may have changed a validation rule
without verifying whether the existing data matches the new validation
rule. Click Undo on the Edit menu to restore the previous value, or
enter a new value that meets the validation rule for the field.
Microsoft Access has canceled the Paste operation. The text on the
Clipboard is too long to paste into the form. For example, you may
have pasted too much text into a label or entered too much text in the
ColumnWidths property. Paste smaller sections. For labels, you must
paste fewer than 2,048 characters.

2114
2115

2116

2117

2118

2119

2120

You must save the current field before you run the Requery action.
• If you are running a macro from the Database window, save the field
first, and then run the macro.
• If the macro name is the setting of the BeforeUpdate property in a
Visual Basic function, set the AfterUpdate property to the name of the
macro instead.
The Requery action can’t be used on the control ‘|.’ Certain controls,
such as labels and rectangles, can’t receive the focus; therefore, you
can’t apply a Requery action to them.
To create a form, report or data access page using this wizard, you
must first select the table or query on which the form, report or data
access page will be based.
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2121

Microsoft Access can’t open the form ‘|.’ It contains data that
Microsoft Access doesn’t recognize. Re-create the form or, if you
maintain backup copies of your database, retrieve a copy of the form.
You can’t view a form as a continuous form if it contains a subform, an
ActiveX control, or a bound chart. Set the DefaultView property of the
form to Single Form, Datasheet, PivotTable, or PivotChart.
The control name you entered doesn’t follow Microsoft Access objectnaming rules.
The form name you entered doesn’t follow Microsoft Access objectnaming rules.
The setting for the FontSize property must be from 1 through 127.
The setting for the ColumnCount property must be from 1 through 255.
The setting for the BoundColumn property can’t be greater than the
setting for the ColumnCount property.
Microsoft Access encountered errors while importing |1. For more
detailed error information, see the file ‘|2’.
The setting for the DefaultEditing property must be Allow Edits, Read
Only, Data Entry, or Can’t Add Records. Enter 1, 2, 3, or 4 for the
DefaultEditing property.
The settings for the GridX and GridY properties must be from 1
through 64.
An expression can’t be longer than 2,048 characters.
The setting for the DecimalPlaces property must be from 0 through 15,
or 255 for Auto (default).
You can’t place a form (or report) within itself. Select or enter a different form or report to serve as the subform or subreport.
The setting for the Width property must be from 0 through 22 inches
(55.87 cm).
This property is read-only and can’t be set.
To set this property, open the form or report in Design view. For more
information on this property, search the Help index for the name of the
property.
You can’t use Find or Replace now. The fields are not searchable due
to one of the following:
• The fields are controls (such as buttons or OLE objects).
• The fields have no data.
• There are no fields to search.

2122

2123
2124
2125
2126
2127
2128
2129

2130
2131
2132
2133
2134
2135
2136

2137
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2138

You can’t search the field for the specified value. Resolve the error
given in the previous error message before you attempt to search again.
You can’t replace the current value of the field with the replacement
text. Resolve any errors before making further replacements.
Microsoft Access can’t save the change you made to the record in the
Replace operation for the reason given in the previous error message.
Click Undo Current Record on the Edit menu, or enter a new value in
the field.
Microsoft Access can’t find the text you specified in the Find What
box.
The FindRecord action requires a Find What argument. You tried to run
a macro set to one of the current field’s properties, but you left the Find
What argument blank. When you click OK, an Action Failed dialog
box will display the macro name and the macro’s arguments. In the
Macro window, enter text or an expression for the Find What argument, and try the Search operation again.
You didn’t specify search criteria with a FindRecord action. In the
Macro window, insert a FindRecord action before the FindNext action.
The setting for the ListRows property must be from 1 through 255.
The ColumnWidths property setting must be a value from 0 through
22 inches (55.87 cm) for each column in a list box or a combo box. If
there is more than one column, separate the numbers with either a
semicolon or the list separator character. List separator characters are
defined in the Regional Settings section of Windows Control Panel.
Microsoft Access can’t save the last change for the reason given in the
previous error message. For example, you may have entered a duplicate
value in a field with an index that prohibits duplicate values. Click
Undo on the Edit menu, or enter a new value in the field.
You must be in Design view to create or delete controls.
The number you used to refer to the form or report section is invalid.
Make sure that the number is less than the number of sections in the
form or report.
The constant you entered for the control type is invalid. For a list of
valid constants you can use to create a control, click Help.
This type of control can’t contain other controls.
The parent control can’t contain the type of control you selected. For
example, you used the CreateControl function to designate an option
group as the parent of a text box.

2139
2140

2141
2142

2143
2144
2145

2146

2147
2148

2149
2150
2151
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2152
2153
2154

You can set group levels for reports only, not for forms.
You can’t specify more than 10 group levels.
You can’t call this function when the Sorting and Grouping box is
open.
Microsoft Access has encountered an error in compiling the Visual
Basic code. You don’t have permission to edit code; inform someone
who does have permission about this error.
Microsoft Access has encountered an error in compiling the Visual
Basic code. Do you want to view the error in its context?
The sum of the top margin, the bottom margin, the height of the page
header, and the height of the page footer is greater than the length of
the page you are printing on.
You can use the Print method and the report graphics methods (Circle,
Line, PSet, and Scale) only in an event procedure or a macro set to the
OnPrint, the OnFormat, or the OnPage event property.
There isn’t enough memory to initialize the Print method or one of the
report graphics methods (Circle, Line, PSet, Scale). Close unneeded
programs and try again to print or preview the report. For more information on freeing memory, search the Microsoft Windows Help index
for ‘memory, troubleshooting’.
Microsoft Access couldn’t create the graphic or text. An error occurred
while initializing the Print method or one of the report graphics methods (Circle, Line, PSet, Scale). Close unneeded programs and try again
to print or preview the report. For information on freeing memory,
search the Microsoft Windows Help index for ‘memory, troubleshooting’.
The text or expression you entered doesn’t match the type of data you
are searching for. Redefine the text or expression, or search in a different field.
A macro set to one of the current field’s properties failed because of an
error in a FindRecord action argument. In the Macro window, change
the Search As Formatted argument to Yes. If you want the argument
setting to remain No, do all of the following:
• Select No for the Match Case argument.
• Select Yes for the Only Current Field argument.
• Make sure you are searching in a bound control.
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2163

The page number you used as an argument for the GoToPage action or
method doesn’t exist in this form.
You can’t disable a control while it has the focus.
You can’t hide a control that has the focus.
You can’t lock a control while it has unsaved changes.
This property is read-only and can’t be modified.
You can’t save this record at this time. Microsoft Access may have
encountered an error while trying to save a record. If you close this
object now, the data changes you made will be lost. Do you want to
close the database object anyway?
There isn’t enough memory to retrieve data for the list box. Close
unneeded programs. Then close and reopen the active form, and click
the list box again. For more information on freeing memory, search the
Microsoft Windows Help index for ‘memory, troubleshooting’.
You can’t have more than seven nested subforms in a main form.
Remove the eighth nested subform.
You can’t use a pass-through query or a non-fixed-column crosstab
query as a record source for a subform or subreport. Before you bind
the subform or subreport to a crosstab query, set the query’s
ColumnHeadings property.
The control ‘|’ the macro is attempting to search can’t be searched. Try
one of the following:
• Add a GoToControl action before the FindRecord action.
• For the FindRecord action, change the Only Current Field action
argument from Yes to No.
• Change the focus to a searchable control.
You can’t switch to a different view at this time. Code was executing
when you tried to switch views. If you are debugging code, you must
end the debugging operation before switching views.
There isn’t enough free memory to continue the Search operation.
Close unneeded programs. Then try the Search operation again. For
more information on freeing memory, search the Microsoft Windows
Help index for ‘memory, troubleshooting’.
The setting for this property is too long. You can enter up to either 255
or 2,048 characters for this property, depending on the data type.
You can’t insert a report into a form. A report can be inserted only into
a report.

2164
2165
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2167
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2170

2171
2172
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2175

2176
2177

Access 2002 and Jet 4 Errors
APPENDIX E

ErrorString

2178

You can’t add another section now. The maximum total height for all
sections in a report, including the section headers, is 200 inches
(508 cm). Remove or reduce the height of at least one section, and then
add the new section.
You can’t sort on a calculated field in a form. You can sort on a calculated field only in a query. Create a calculated field in a query, sort the
field, and then base the form on the query. Because the query must
execute before the form opens, the form will open more slowly.
You can’t sort on this field.
Microsoft Access can’t create an object of the type requested. You are
trying either to create a form from a report that has been saved as text,
or to create a report from a saved form.
The value you used for the TabIndex property isn’t valid. The correct
values are from 0 through |.
You can’t reference a property or method for a control unless the control has the focus. Try one of the following:
• Move the focus to the control before you reference the property. In
Visual Basic code, use the SetFocus method. In a macro, use the
GoToControl action.
• Reference or set the property from a macro or event procedure that
runs when the GotFocus event for the control occurs.
This property isn’t available in Design view. Switch to Form view to
access this property, or remove the reference to the property.
This property is available only in Design view.
The object you attempted to load from text has an invalid value for the
property ‘|1’ on a |2.
Your code contains a syntax error, or a Microsoft Access function you
need isn’t available. If the syntax is correct, check the Control Wizards
subkey or the Libraries key in the Microsoft Access section of the
Windows Registry to verify that the entries you need are listed and
available. If the entries are correct, you need to correct the Microsoft
Access Utility Add-in or the file acWzlib or this wizard has been disabled. To reenable this wizard, click About Microsoft Access on the
Help menu, and then click the Disabled Items button to view a list of
addins which you can enable. Rerun Microsoft Access or Microsoft
Office Setup to reinstall Microsoft Access. Before you reinstall, delete
the Windows Registry keys for the Microsoft Access Utility Add-in and
acWzlib.
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2190

This property has been replaced by a new property; use the new property instead.
You can’t set the | property in print preview or after printing has
started. Try setting this property in the OnOpen event.
The bitmap you specified is not in a device-independent bitmap (.dib)
format. You tried to set the PictureData property of a form, report, button, or image control.
The left margin, right margin, or both margins are wider than the paper
size specified in the Print Setup dialog box.
You can’t set the PictureData property in Datasheet view. To see the
valid settings for this property, search the Help index for ‘PictureData
property’.
The section name you entered doesn’t follow Microsoft Access objectnaming rules.
Microsoft Access can’t retrieve the value of this property. The property
isn’t available from the view in which you’re running the macro or
Visual Basic code, or Microsoft Access encountered an error while
retrieving the value of the property. To see the valid settings for this
property, search the Help index for the name of the property.
You can’t set a subform control’s SourceObject property to a zerolength string if you’re displaying the main form in Form view. You can
set this property to a zero-length string from Design view, Datasheet
view, or Print Preview.
The number you entered is invalid.

2191
2192

2193
2194

2195
2196

2197

2200
2201
2202

2203

2204

There was a problem retrieving printer information for the |1 on |2. The
object may have been sent to a printer that is unavailable.
You must install a printer before you print. To install a printer, point to
Settings on the Windows Start menu, click Printers, and then doubleclick Add Printer. Follow the instructions in the wizard.
The dynamic-link library Commdlg failed: error code ‘0x|’. The printer
driver for the selected printer may be incorrectly installed. For information on selecting another printer or reinstalling this printer from
Microsoft Windows, search the Windows Help index for ‘printer
setup’.
The default printer driver isn’t set up correctly. For information on setting a default printer, search the Microsoft Windows Help index for
‘default printer, setting’.
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The default printer driver isn’t set up correctly. For information on setting a default printer, search the Microsoft Windows Help index for
‘default printer, setting’.
The page number you entered is invalid. For example, it may be a negative number or an invalid range, such as 6 to 3.
Microsoft Access can’t print macros. You tried to use the PrintOut
action or method, but the active object is a macro. If you want to print
an object other than a macro, use the SelectObject action or method to
select the desired object before you run the PrintOut action.
Microsoft Access can’t print or preview the page because the page size
you selected is larger than 22.75 inches.
Microsoft Access can’t print or preview the Debug window.
Microsoft Access couldn’t print your object. Make sure that the specified printer is available. For information on setting a default printer,
search the Windows Help index for ‘default printer, setting’.
There was a problem retrieving printer information for this object. The
object may have been sent to a printer that is unavailable.
There was a problem retrieving information from the printer. New
printer has not been set.
Microsoft Access can’t open the file ‘|’.
The text is too long to be edited.
This control is read-only and can’t be modified.
The file name ‘|’ is too long. Enter a file name that’s 256 characters or
less.
Microsoft Access couldn’t open the Clipboard. The Clipboard isn’t
responding, probably because another application is using it. Close all
other applications and try the operation again.
The Clipboard isn’t responding, so Microsoft Access can’t paste the
Clipboard’s contents.
• Another application may be using the Clipboard.
• There may not be enough free memory for the paste operation. Close
all other applications, and then copy and paste again.
The data on the Clipboard is damaged, so Microsoft Access can’t paste
it. There may be an error in the Clipboard, or there may not be enough
free memory. Try the operation again.
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2229

Microsoft Access can’t start the OLE server. You tried to use a form,
report, or datasheet that contains an OLE object, but the OLE server
(the application used to create the object) may not be registered properly. Reinstall the OLE server to register it correctly.
Microsoft Access can’t paste the OLE object.
The text you entered isn’t an item in the list. Select an item from the
list, or enter text that matches one of the listed items.
The database ‘|’ needs to be repaired or isn’t a Microsoft Access database file. You may have quit Microsoft Access unexpectedly with the
database open. To repair the database, click the Repair Database command on the Tools menu (Database Utilities submenu). If the database
can’t be repaired, the .mdb file is unusable. Restore the database from a
backup copy or create a new database.
The data in the Clipboard isn’t recognizable; Microsoft Access can’t
paste the OLE object.
The file name you specified in the Picture property for a command button or toggle button can’t be read.
• The file you specified may be corrupted. Restore the file from a
backup copy or re-create the file.
• The disk where the file is located may be unreadable.
The file you specified doesn’t contain valid icon data. Specify a valid
icon file.
Microsoft Access can’t run the query; the parameter values are too
large. The total length of all the values entered for the parameters cannot exceed 1,024 characters.
An error occurred while sending data to the OLE server (the application used to create the object).
• You may have tried to send too much data. If you’re creating a chart
and the chart is based on a query, modify the query so that it selects
less data. If the chart is based on a table, consider basing it on a query
instead so that you can limit the data.
• You may be using an OLE server that doesn’t accept the Clipboard
format.
• You may not be able to start the OLE server because it’s not properly
registered. Reinstall it to register it.
• Your computer may be low on memory. Close other application windows to free up memory.

2234
2237
2239
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2245
2246
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2262
2263
2264

This value must be a number.
The number is too large.
Microsoft Access didn’t recognize the unit of measurement. Type a
valid unit, such as inches (in) or centimeters (cm).
You must specify a unit of measurement, such as inches (in) or centimeters (cm).
‘|’ may not be a valid setting for the RowSourceType property, or there
was a compile error in the function. For information on valid settings
for the RowSourceType property, click Help.
There is not enough disk space to create a temporary buffer file for
printing. Free up some disk space to make room for the temporary
buffer file.
Some library databases couldn’t be loaded because too many were
specified. To change library database references, click References on
the Tools menu.
The setting for the Update Retry Interval must be from 0 through 1,000
milliseconds.
The setting for Update Retries must be from 0 through 10.
The database ‘|’ is already open as a library database.
The string returned by the builder was too long. The result will be
runcated.
The custom builder you’re using caused an error by changing the focus
to a different window while you were using it. Enter a value without
using the custom builder.
There was a font initialization error.
Microsoft Access can’t save your changes to this bound OLE object.
Either you don’t have permission to write to the record in which the
object is stored, or the record is locked by another user. Copy the
object to the Clipboard (select the object and click Copy on the Edit
menu), and click Undo Current Record on the Edit menu. Then open
the application you used to create the object, paste the object from the
Clipboard, and save it.
The value you entered isn’t appropriate for the input mask ‘|’ specified
for this field.
You have added more output formats to the Windows Registry than
Microsoft Access can initialize. Some output formats will not be available. Remove those formats that you never or least often use.
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2281

The formats that enable you to output data as a Microsoft Excel, richtext format, MS-DOS text, or HTML file are missing or incorrectly
registered in the Windows Registry. Run Setup to reinstall Microsoft
Access or, if you’re familiar with the settings in the Registry, try to correct them yourself. For more information about the Registry, click
Help.
The format in which you are attempting to output the current object is
not available. Either you are attempting to output the current object to a
format that is not valid for its object type, or the formats that enable
you to output data as a Microsoft Excel, rich-text format, MS-DOS
text, or HTML file are missing from the Windows Registry. Run Setup
to reinstall Microsoft Access or, if you’re familiar with the settings in
the Registry, try to correct them yourself. For more information on the
Registry, click Help.
The format specification for ‘|’ is invalid. You can’t save output data to
a file in this format until you correct the setting for the format in the
Windows Registry. Run Setup to reinstall Microsoft Access or, if
you’re familiar with the settings in the Registry, try to correct them
yourself. For more information on the Registry, click Help.
Microsoft Access can’t write to the file.
• The network may not be working. Wait until the network is working,
and then try again.
• You may be out of memory. Close one or more Microsoft Access
windows, close other applications, and then try again.
Microsoft Access can’t create the output file.
• You may be out of disk space on the destination drive.
• The network may not be working. Wait until the network is working,
and then try again.
• You may be out of memory. Close one or more Microsoft Access
windows, close other applications, and then try again.
Microsoft Access can’t close the file.
• The network may not be working. Wait until the network is working,
and then try again.
• You may be out of memory. Close one or more Microsoft Access
windows, close other applications, and then try again.
Microsoft Access can’t open the mail session. Check your mail application to make sure that it’s working properly.
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2283

2284

2285

2286
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Microsoft Access can’t load the ‘|’ format. The setting for this format
in the Windows Registry is incorrect. You can’t save the output data to
a file in this format until you correct the setting in the Registry. Run
Setup to reinstall Microsoft Access or, if you’re familiar with the settings in the Registry, try to correct them yourself. For more information on the Registry, click Help.
Microsoft Access can’t output the module in the requested format.
There were too many message recipients; the message was not sent.
There are too many message attachments; the message was not sent.
The message text is too long, so it was not sent.
Microsoft Access can’t send this e-mail message. Before attempting to
send an e-mail message from Microsoft Access, resolve the problem
identified in the previous message, or configure your computer to send
and receive e-mail messages.
Microsoft Access can’t attach the object; the message was not sent.
• The network may not be working. Wait until the network is working,
and then try again.
• You may be out of memory. Close one or more Microsoft Access
windows, close other applications, and then try again.
Unknown message recipient(s); the message was not sent.
The password is invalid; the message wasn’t sent.
Microsoft Access can’t open the mail session. You may be out of memory. Close one or more Microsoft Access windows, close other applications, and then try again. You may also want to check your mail
application to ensure that it’s working properly.
Microsoft Access can’t start the wizard, builder, or add-in.
• The library database containing the wizard, builder, or add-in may not
be installed. Point to Add-ins on the Tools menu, and then click Addin Manager to see if the library database is installed.
• The wizard, builder, or add-in code may not be compiled and
Microsoft Access can’t compile it. There may be a syntax error in the
code.
• The key for the add-in in the Windows Registry file may be incorrect.
Microsoft Access can’t open the Zoom box. The Microsoft Access
Utility add-in is missing or was modified. Rerun Microsoft Access or
Microsoft Office Setup to reinstall Microsoft Access and the Microsoft
Access Utility add-in.
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2300

Microsoft Access can’t output because there are too many controls
selected that have different styles, such as color and font. Select fewer
controls, and then try again.
There are not enough system resources to output the data. Close one or
more Microsoft Access windows and close other applications. Then try
to output the data again.
Microsoft Access can’t save the output data to the file you’ve selected.
• The file may be open. If so, close it, and then save the output data to
the file again.
• If you are using a template, check to make sure the template exists.
• If the file isn’t open, check to make sure that you have enough free
disk space.
• Make sure that the file exists on the path specified.
Microsoft Access can’t output data now.
• The network may not be working. Wait until the network is working,
and then try again.
• You may be out of disk space. Free up disk space and try again.
Microsoft Access can’t save output data to the specified file. Make sure
that you have enough free disk space on your destination drive.
There are too many columns to output, based on the limitation specified in the output format or by Microsoft Access.
There are too many rows to output, based on the limitation specified by
the output format or by Microsoft Access.
You haven’t selected any data, or the object you’ve selected is blank.
The file ‘|’ already exists. Do you want to replace the existing file?
There is an invalid add-in entry for ‘|.’ There is an error in the Windows
Registry for this add-in. Correct the setting and restart Microsoft
Access. For information on the Registry, click Help.
There isn’t enough memory to run the NotInList event procedure.
The shortcut ‘|’ must be re-created. The file may be missing, damaged,
or in an older format that can’t be read.
Microsoft Access can’t find the shortcut databases ‘|1’ or ‘|2.’ Re-create
the shortcut with the correct locations of the databases.
Microsoft Access can’t find the shortcut database ‘|.’ Re-create the
shortcut with the correct location of the database.
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The input string is too long.
This table or query can’t be opened because it has no visible fields.
This can result if the table or query has only system fields, and the
Show System Objects option is off. To turn on the Show System
Objects option, click Options on the Tools menu, click the View tab,
and select the System Objects check box.
The database ‘|’ can’t be repaired or isn’t a Microsoft Access database
file.
Microsoft Access can’t import the object ‘|’ while it is open.
Microsoft Access can’t display the field for which you entered Where
in the Total row. Clear the Show check box for that field. If you want
this field to appear in the query’s results, add it to the design grid
twice. For the field that will appear in the query’s results, don’t specify
Where in the Total row, and make sure the Show check box is checked.
You can’t set criteria before you add a field or expression to the Field
row. Either add a field from the field list to the column and enter an
expression, or delete the criteria.
You can’t sort on the asterisk (•). Because the asterisk represents all
fields in the underlying table or query, you can’t sort on it. Add the
asterisk to the query design grid, along with the specific fields you
want to sort on. Clear the Show check box for the sorting fields, and
then specify a sort order.
You can’t specify criteria for the asterisk (•). Because the asterisk represents all the fields in the underlying table or query, you can’t specify
criteria for it. Add the asterisk to the query design grid, along with the
field(s) you want to set criteria for, and then enter criteria for the specific fields. In the query design grid, clear the Show check box for the
criteria field(s), before you run the query.
You can’t calculate totals on the asterisk (•). Because the asterisk represents all the fields in the table, you can’t calculate totals on it.
Remove the asterisk from the query design grid. Add the fields you
want to use to the design grid, and then select the total you want to calculate for specific fields.
The field name you entered exceeds the LinkMasterFields property’s
64-character limit. When you use the Relationships command (Tools
menu) to define a relationship between the tables underlying a form
and subform, Microsoft Access links the form and subform automatically and sets the LinkChildFields and LinkMasterFields properties.
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2326

You can’t specify Group By, Expression, or Where in the Total row for
this column. Specify an aggregate function, such as Sum or Count, for
the field or expression you designate as the Value in the crosstab query.
For more information on aggregate functions, click Help.
You must enter Group By in the Total row for a field that has Column
Heading in the Crosstab row. The values derived from the field or
expression that you designate as the Column Heading are used to group
data in the crosstab query.
You can’t run an update query on the asterisk (•). Because the asterisk
represents all the fields in the table, you can’t update it. Remove the
asterisk from the query design grid. Add the fields you want to update
to the design grid.
To create a crosstab query, you must specify one or more Row
Heading(s) options, one Column Heading option, and one Value option.
Microsoft Access can’t represent the join expression | in Design view.
• One or more fields may have been deleted or renamed.
• The name of one or more fields or tables specified in the join expression may be misspelled.
• The join may use an operator that isn’t supported in Design view,
such as > or <.
You must enter Group By in the Total row for at least one of the Row
Heading options you enter in the Crosstab row.
Microsoft Access can’t match the fields you added using the asterisk
(•) in the append query. Because the asterisk represents all the fields in
the underlying table or query, you can’t append an asterisk to one field
or expression, and you can’t append a single field or expression to an
asterisk. Append an asterisk to an asterisk (for example, a table to a
table), or append specific fields.
You must enter the name of the table you are creating or appending
records to. You tried to define a make-table or append query without
specifying a destination table.
Microsoft Access can’t print ‘|’ because it is an action query. Because
action queries don’t produce a recordset, you can’t print a Datasheet
view of them.
Note that an exclamation point (!) joined to a query icon in the
Database window marks an action query. To print a Datasheet view of
the records that will be selected by the query, display the query in
Design view, click the Datasheet button, and then click the Print
button.
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You must use the same number of fields when you set the
LinkChildFields and LinkMasterFields properties. You entered a different number of fields for one property than you did for the other. If you
use the Relationships command (Tools menu) to define a relationship
between the tables underlying the form and subform, Microsoft Access
will link the form and subform automatically and then set the
LinkChildFields and LinkMasterFields properties.
You can’t specify criteria on the same field for which you entered
Value in the Crosstab row. You tried to display a crosstab query after
entering Value in the Crosstab row and criteria in the Criteria row. If
you want this field to supply the cross-tabulated values in the crosstab
query, delete the entry in the Criteria row. If you want this to be a criteria field, leave the Crosstab row blank.
Microsoft Access truncated the expression you entered. The expression
‘|’ exceeds the 1,024-character limit for the query design grid.
Microsoft Access can’t create a temporary link. You reached the limit
for the number of links in your database. Microsoft Access needs to
create a temporary link in order to import your ODBC table. Remove
all unneeded links or tables.
The expression you entered exceeds the 1,024-character limit for the
query design grid.
A RunSQL action requires an argument consisting of an SQL statement. For example, an action query that appends records starts with
INSERT INTO. A data-definition query that creates a table starts with
CREATE TABLE.
The value you entered exceeds the Alias property’s 64-character limit.
For the TopValues property in the query property sheet, you must enter
an integer greater than zero.
For the TopValues property in the query property sheet, you must enter
a percentage from 1 through 100.
For the TopValues property in the query property sheet, you must enter
a number greater than zero.
Microsoft Access can’t find the file name you entered for the
DestinationDB property in an action query’s property sheet. You may
have misspelled the database file name, or the file may have been
deleted or renamed.
You can’t leave the Alias property blank.
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For the TopValues property in the query property sheet, you must enter
a number smaller than 2,147,483,647.
Microsoft Access can’t save the query.
• The query is a pass-through query and can’t be represented as a simple SQL string. Save the query as a named query from the Query
Builder. When you close the Query Builder, Microsoft Access will fill
the RecordSource or RowSource property with the saved query name.
• Make sure the query doesn’t have an SQL syntax error.
Microsoft Access can’t represent an implicit VALUES clause in the
query design grid. Edit this in SQL view.
You can’t modify this query because it has been deleted or renamed by
another user.
Bad query parameter ‘|’.
A field name is missing. You have defined a data type or a description
for a field without specifying the field name. Enter a name for the field,
or delete the row.
Microsoft Access can’t save this table. There are no fields in this table.
Define at least one field by entering a field name and selecting a data
type.
You already have a field named ‘|.’
Microsoft Access allows only one AutoNumber field per table. Use the
Number data type for similar fields.
Microsoft Access can’t open the table in Datasheet view.

2350

2351
2352
2353
2360

2361

2362
2363
2364
2366

2370

2371
2372

Microsoft Access was unable to save the field ordering. All other
changes were saved successfully. Close this database and choose the
Repair Database command on the Tools menu (Database Utilities submenu).
Removing or changing the index for this field would require removal
of the primary key. If you want to delete the primary key, select that
field and click the Primary Key button.
Microsoft Access can’t create a primary key. Your changes weren’t
saved.
The field name is not valid. Make sure that the name doesn’t contain a
period (.), exclamation point (!), bracket ([]), leading space, or nonprintable character such as a carriage return. If you have pasted the
name from another application, try pressing ESC and typing the name
again.
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2374
2375

The setting for the FieldSize property must be from 0 through 255.
You can’t create an index or primary key on more than 10 fields.
You can’t paste beyond the end of a table. You have attempted to paste
fields beyond the 255th row in a table in Design view.
Microsoft Access can’t create a primary key. You have selected too
many fields for a multiple-field primary key.
Once you enter data in a table, you can’t change the data type of any
field to AutoNumber, even if you haven’t yet added data to that field.
Add a new field to the table, and define its data type as AutoNumber.
Microsoft Access then enters data in the AutoNumber field automatically, numbering the records consecutively starting with 1.
This table is read-only. Use a different name in the Save As dialog box
to save your changes.
You can’t create a primary key on a field of this data type. You can’t
define a primary key on fields with an OLE Object data type.
Microsoft Access can’t create a primary key because no fields have
been selected. You have selected a row with no fields defined. Place the
insertion point somewhere in the row of the field you want to define as
the primary key.
Microsoft Access can’t create a primary key because the field doesn’t
have a name. Name the field, and then define it as a primary key field.
You can’t switch to Datasheet view and you can’t return to Design
view. Another user has opened this table or a query, form, or report that
is bound to this table.
Microsoft Access can’t change the data type. There isn’t enough disk
space or memory.
You can’t change one field from an AutoNumber data type and add
another AutoNumber field at the same time. Do the following:
1. Delete the AutoNumber field you added, and click Save on the File
menu.
2. Add the new AutoNumber field, and save the table again.
Errors were encountered during the save operation. |
Microsoft Access was unable to create the table.
You can’t delete the table ‘|’; it is participating in one or more relationships. If you want to delete this table, first delete its relationships in the
Relationships window.
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You can’t change the primary key. This table is the primary table in
one or more relationships. If you want to change or remove the primary
key, first delete the relationship in the Relationships window.
You can’t delete the field ‘|.’ It is part of one or more relationships. If
you want to delete this field, first delete its relationships in the
Relationships window.
You can’t change the data type or field size of this field; it is part of
one or more relationships. If you want to change the data type of this
field, first delete its relationships in the Relationships window.
Field ‘|1’ doesn’t exist in destination table ‘|2.’ Microsoft Access was
unable to complete the append operation. The destination table must
contain the same fields as the table you are pasting from.
You can’t set the Unique property of a primary key to No. A primary
key, by definition, contains only unique values. If you want to allow
nonunique values in this field, remove the primary key definition by
setting the Primary property to No.
You can’t set the IgnoreNulls property of a primary key to Yes. A primary key, by definition, can’t allow null values. If you want null values
in this field, remove the primary key definition by setting the Primary
property to No.
The index name is invalid. The index name may be too long (over 64
characters) or contain invalid characters.
Indexes must have names.
Microsoft Access can’t create an index or primary key. One or more
field names are missing. Enter or select at least one field in the Field
Name column for each index you name.
You already have an index named ‘|.’
The primary key has been changed. This table is the primary table in
one or more relationships. Changes to the primary key won’t be saved.
The setting for the FieldSize property must be from 1 through 8000.
The row you inserted in the grid exceeds the limit of 255 rows (fields)
for a table or 1,000 rows (actions) for a macro.
The expression you entered has an invalid number.
The expression you entered has an invalid date value.
The expression you entered has an invalid string. A string can be up to
2048 characters long, including opening and closing quotation marks.
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The expression you entered has an invalid . (dot) or ! operator or
invalid parentheses. You may have entered an invalid identifier or typed
parentheses following the Null constant.
The expression you entered has a field, control, or property name that
Microsoft Access can’t find.
The expression you entered has a function name that Microsoft Access
can’t find.
The function you entered can’t be used in this expression.
• You may have used a DoEvents, LBound, UBound, Spc, or Tab function in an expression.
• You may have used an aggregate function, such as Count, in a design
grid or in a calculated control or field.
You entered an expression that has no value. The expression may refer
to an object that has no value, such as a form, a report, or a label control.
You entered an invalid argument in a domain aggregate function.
• A field in the string expression may not be in the domain.
• A field specified in the criteria expression may not be in the domain.
The In operator you entered requires parentheses.
You did not enter the keyword And in the Between…And operator. The
correct syntax is as follows:
expression [Not] Between value1 And value2
The expression you entered contains invalid syntax. You may have
entered a comma without a preceding value or identifier.
The expression you entered contains invalid syntax, or you need to
enclose your text data in quotes. You may have entered an invalid
comma or omitted quotation marks. For example, if the Default Value
property of a text field is “Huey, Louie, and Dewey,” it must be
enclosed in quotes if you mean it as a literal text string. This avoids the
confusion with the expression “Huey Louie” And “Dewey”.
The expression you entered contains invalid syntax. You may have
entered an operator, such as the + operator, in an expression without a
corresponding operand.
The expression you entered contains invalid syntax. You may have
entered an operand without an operator.
The expression you entered has too many closing parentheses.
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2436

The expression you entered is missing a closing parenthesis, bracket
(]), or vertical bar (|).
The expression you entered has invalid vertical bars (|).
The expression you entered contains invalid syntax. You omitted an
operand or operator, you entered an invalid character or comma, or you
entered text without surrounding it in quotation marks.
The expression you entered has a function containing the wrong number of arguments.
You must enclose IIf function arguments in parentheses.
The expression you entered has invalid parentheses. You may have used
the parenthesis syntax for an identifier in a query. Use the standard
identifier syntax:
Forms![Form]![Control].
You can use the Is operator only in an expression with Null or Not
Null.
The expression you entered is too complex.
There isn’t enough memory available to perform this calculation. Close
unneeded programs, and try again. For more information on freeing
memory, search the Microsoft Windows Help index for ‘memory, troubleshooting’.
There is an invalid use of the . (dot) or ! operator or invalid parentheses. You may have entered an invalid identifier or typed parentheses
following the Null constant.
You can’t assign a value to this object.
• The object may be a control on a read-only form.
• The object may be on a form that is open in Design view.
• The value may be too large for this field.
There is an invalid method in an expression. For example, you may
have tried to use the Print method with an object other than Report or
Debug.
Microsoft Access can’t find the form ‘|’ referred to in a macro expression or Visual Basic code.
• The form you referenced may be closed or may not exist in this database.
• Microsoft Access may have encountered a compile error in a Visual
Basic module for the form.
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The report name ‘|’ you entered is misspelled or refers to a report that
isn’t open or doesn’t exist.
The expression you entered has an invalid reference to the Parent property. For example, you may be using the Parent property with a control
on a main form or report rather than with a control on a subform or
subreport.
The control name ‘|’ you entered in your expression is misspelled or
refers to a control on a form or report that isn’t open or doesn’t exist.
The object name ‘|’ you entered following the ! operator in the expression is invalid. For example, you may have tried to enter an identifier
with two control names separated by the ! operator.
You entered an expression that has an invalid reference to the property
|. The property may not exist or may not apply to the object you specified.
The number you used to refer to the form is invalid. Use the Count
property to count the open forms and make sure that the form number
is not greater than the number of open forms minus one.
The number you used to refer to the report is invalid. Use the Count
property to count the open reports and make sure that the report number is not greater than the number of open reports.
The control number you specified is greater than the number of controls. Use the Count property to count the controls on the form or
report and then check that the control number you cite is within the
range of existing controls.
You can’t refer to the Parent property of a form or report when either is
open in Design view.
You can’t refer to the RecordsetClone property of a form open in
Design view.
Use a section number, not a string, to refer to a form or report section.
The section number you entered is invalid.
Use a number, not a string, to refer to a group level.
There is no sorting or grouping field or expression defined for the
group level number you used. A valid group level number can be from
0 (for the first field or expression you sort or group on) through 9 (for
the tenth). Count the group levels in the report starting with zero.
Microsoft Access can’t find the field ‘|’ referred to in your expression.
You may have misspelled the field name, or the field may have been
renamed or deleted.
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The expression you entered has an invalid reference to the Dynaset
property. For example, you may have used the Dynaset property with a
form that isn’t based on a table or query.
The expression you entered refers to an object that is closed or doesn’t
exist. For example, you may have assigned a form to a Form object
variable, closed the form, and then referred to the object variable.
The value you entered for the interval, number, or date argument in the
function is invalid. Check the argument to make sure that you entered it
correctly. For more information on valid argument values, search the
Help index for ‘DatePart function,’ ‘DateAdd function,’ or ‘DateDiff
function’.
The expression |2 you entered in the form control’s ValidationRule
property contains the error |1. Microsoft Access can’t parse the
ValidationRule expression you entered. For example, if you enter the
expression =MyFunction() in the ValidationRule property, and the
function MyFunction doesn’t exist, Microsoft Access displays the
following message:
Unknown function name in validation rule: ‘MyFunction’.
To help you create expressions as arguments in Visual Basic, use the
Expression Builder. For more information, search the Help index for
‘Expression Builder’.
There is a(n) ‘|’ in the form control’s ValidationRule property. To help
you create expressions as arguments in Visual Basic, use the
Expression Builder. For more information, search the Help index for
‘Expression Builder’.
The expression you entered as a query parameter produced this error: ‘|’
The LinkMasterFields property setting has produced this error: ‘|’
The expression |2 you entered as the event property setting produced
the following error: |1.
• The expression may not result in the name of a macro, the name of a
user-defined function, or [Event Procedure].
• There may have been an error evaluating the function, event, or
macro.
The expression you entered requires the control to be in the active
window. Try one of the following:
• Open or select a form or report containing the control.
• Create a new control in the active window, and try the operation
again.
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You entered an expression that requires a form to be the active window.
You entered an expression that requires a report to be the active
window.
You entered an invalid objecttype value ‘|’ in an If TypeOf object Is
objecttype condition of an If…Then…Else statement. The objecttype
can be any one of the following: BoundObjectFrame, CheckBox,
ComboBox, CommandButton, Label, Line, ListBox,
UnboundObjectFrame, OptionButton, OptionGroup, PageBreak,
Rectangle, Subform, Subreport, TextBox, ToggleButton, ImageControl,
or OLEControl.
Microsoft Access doesn’t allow you to use this method in the current
view. Most methods, including the SetFocus and Requery methods,
can’t be used in form or report Design view.
The event procedure ‘|’ can’t be a Function procedure; it must be a Sub
procedure. If you want to run a Function procedure when an event
occurs, try one of the following:
• Set the event property to the name of a macro containing a RunCode
action that runs the Function procedure.
• Set the event property to =FunctionName().
You referred to a property by a numeric argument that isn’t one of the
property numbers in the collection. Check the property numbers in the
collection.
You can’t set a value while a document is in Print Preview.
Microsoft Access can’t find the name ‘|’ you entered in the expression.
You may have specified a control that wasn’t on the current object
without specifying the correct form or report context. To refer to a control on another form or report, precede the control name with the name
of a collection, usually either Forms or Reports, and the name of the
form or report to which the control belongs. For example,
Forms![Products]![Units In Stock].
You can’t move to a previous control when only one control has had
the focus. Use the PreviousControl property only after you’ve moved
the focus to a second control.
There is no active datasheet.
Microsoft Access can’t find the macro ‘|.’ The macro (or its macro group)
doesn’t exist, or the macro is new but hasn’t been saved. Note that when
you enter the macrogroupname.macroname syntax in an argument, you
must specify the name the macro’s macro group was last saved under.
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2486

You can’t carry out this action at the present time. You tried to run a
macro or used the DoCmd object in Visual Basic to carry out an action.
However, Microsoft Access is performing another activity that prevents
this action from being carried out now. For example, no actions on a
form can be carried out while Microsoft Access is repainting a control
or calculating an expression. Carry out the action later.
The Object Type argument for the action or method is blank or invalid.
• For a Close, GoToRecord, or RepaintObject action, enter values for
both arguments, or leave both blank to perform the action on the
active object.
• For a DeleteObject, Rename, or CopyObject action, enter values for
both arguments, or leave both blank to perform the action on the
object currently selected in the Database window.
• For a SendObject or OutputTo action, enter values for both arguments, or leave the Object Name argument blank if you want the
action performed on the active object of the specified object type.
• If you’re using a method with the DoCmd object, use an intrinsic
constant that equates to a valid object type or the corresponding
numeric value for the argument name.
You can’t use the ApplyFilter action on this window.
• You tried to use the ApplyFilter action or method, but you didn’t
apply the filter to a table, query, form, or report.
• You may have applied the filter to a form, but the form wasn’t open
in Form or Datasheet view.
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• You may have applied the filter to a report but didn’t use the
ApplyFilter action in a macro specified by the OnOpen property setting. Use the SelectObject action or method to select the table, query,
form, or report before applying the filter.
The object ‘|’ isn’t open.
• The macro you are running (directly or indirectly) contains a
GoToRecord, RepaintObject, or SelectObject action, but the Object
Name argument names an object that is closed.
• The objectname argument for the GoToRecord, RepaintObject, or
SelectObject method names an object that is closed. Use one of the
Open actions or methods to open the object so that you can carry out
the desired action.
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The action or method is invalid because the form or report isn’t bound
to a table or query. You tried to use the ApplyFilter action or method.
However, the form or report you applied the filter to is not based on a
table or query, so the form or report doesn’t have any records to apply
a filter to. Use the SelectObject action or method to select the desired
form or report before you run the ApplyFilter action. To base a form or
report on a table or query, open the form or report in Design view, and
enter the table or query name in the RecordSource property.
Microsoft Access can’t find the macro ‘|2’ in the macro group ‘|1.’ You
used the macrogroupname.macroname syntax to specify a macro. You
then tried to run the macro (directly or indirectly), or you used the
RunMacro method to run the macro. However, the macro you specified
isn’t in this macro group. Create the macro in the macro group, specify
the correct macro group, or specify the correct macro name.
This action requires an Object Name argument.
The action or method requires a Form Name argument. You tried to use
the OpenForm action or method, but you left the Form Name argument
blank. In the Form Name argument, enter the name of a form in the
current database.
The action or method requires a Table Name argument. You tried to use
the OpenTable, TransferSpreadsheet, or TransferText action or method,
but you left the Table Name argument blank. In the Table Name argument, enter the name of a table that is in the current database.
The action or method requires a Query Name argument. You tried to
use the OpenQuery action or method, but you left the Query Name
argument blank. In the Query Name argument, enter a query name.
The action or method requires a Report Name argument. You tried to
use the OpenReport action or method, but you left the Report Name
argument blank. In the Report Name argument, enter the name of a
report.
An expression you entered is the wrong data type for one of the arguments. You tried to run a macro or use a method to carry out an action,
but an expression evaluated to the wrong data type. For example, for
the Close method you specified a string for the Object Type argument,
but this argument can be set only to certain intrinsic constants or their
numeric equivalents.
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2499

You can’t use the GoToRecord action or method on an object in Design
view. Try one of the following:
• Switch to Form or Datasheet view for a form.
• Switch to Datasheet view for a query or table.
• If you are running a macro or Visual Basic procedure containing an
action that opens the object, set the View argument to the correct
view before you carry out the GoToRecord action.
You must enter a number greater than zero for a Repeat Count argument. You tried to use the RunMacro action or method, but you entered
a value less than zero (or an expression that evaluates to less than zero)
in the Repeat Count argument. To run the macro once, leave this argument blank.
The | action was canceled. You used a method of the DoCmd object to
carry out an action in Visual Basic, but then clicked Cancel in a dialog
box. For example, you used the Close method to close a changed form,
then clicked Cancel in the dialog box that asks if you want to save the
changes you made to the form.
The action or method requires a Macro Name argument.
• You tried to use the RunMacro action or method, but you left the
Macro Name argument blank.
• Microsoft Access tried to create a custom menu bar for a form or
report, but the Menu Macro Name argument of the AddMenu action
is blank. In the Menu Macro Name argument, enter the name of a
macro or macro group that is in the current database.
You can’t use this action with the DoCmd object. For a list of the
actions that the DoCmd object doesn’t support and some alternatives to
using these actions, click Help. Any actions that aren’t in this list can
be used with the DoCmd object.
The action or method requires at least | argument(s). You tried to run
a macro containing an action or used a method or action with the
DoCmd object, but you didn’t set the required number of arguments.
For example, if you use the MoveSize action, you must set at least one
of the four arguments.
An expression in argument | has an invalid value. You tried to run a
macro or used the DoCmd object in Visual Basic. The argument number above is the position of the argument as it appears in the Macro
window, the Action Failed dialog box, or the Object Browser (if you’re
using the DoCmd object). Try one of the following:
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• Select a setting from the drop-down list box in each argument.
• Use an intrinsic constant equating to a valid object type.
• Substitute the correct corresponding expression.
A value you entered for the Transfer Type argument is invalid. An
expression in the Transfer Type argument doesn’t evaluate to a valid
numeric value. Valid values for the Transfer Type argument are as
follows:
• 0, 1, and 2 for the TransferDatabase action.
• 0, 1, and 2 for the TransferSpreadsheet action.
• 0 through 6 for the TransferText action.
The | type isn’t an installed database type or doesn’t support the operation you chose. You used the TransferDatabase method, but an expression in the databasetype argument doesn’t evaluate to a valid database
type for importing, exporting, or linking. For information on valid
database types, click Help.
A value you entered for the spreadsheettype argument is invalid. You
used the TransferSpreadsheet method, and an expression in the spreadsheettype argument doesn’t evaluate to a valid numeric value. Valid
values are 0, 2, 3, 4, 5, 6, 7, and 8. Note that 1 is an invalid value; you
can’t import or export to a Lotus .wks format file.
The setting for the Range argument can’t be longer than 255
characters.
The expression you entered in the Specification Name argument
exceeds the 64-character limit. Select one of the existing specification
names from the argument list box when you use the TransferText
action in a macro, or enter a name in Visual Basic that follows
Microsoft Access object-naming rules.
The action or method requires a Specification Name argument. You
tried to use the TransferText action or method and you specified a
Transfer Type argument but left the Specification Name argument
blank. In the Specification Name argument, enter an existing specification name from the argument list box.
Microsoft Access can’t parse the expression: ‘|’. Click OK to return to
the action argument or conditional expression where this expression
appears, and then correct the syntax.
The Macro Name argument can’t be longer than 64 characters according to Microsoft Access object-naming rules.
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The action or method requires a Control Name argument. You tried to
use the GoToControl action or method, but you left the control name
blank. In the Control Name argument, enter a control or field name
from the active form or datasheet.
Microsoft Access can’t open the macro ‘|’ because it was saved using a
different version of Microsoft Access. Re-create the macro in the current version of Microsoft Access.
Microsoft Access can’t find the module ‘|.’ You tried to use the
OpenModule action or method, but Microsoft Access can’t find the
module you specified in the Module Name argument. Enter a valid
module name from the current database.
Microsoft Access can’t find the procedure ‘|.’
• You may have used the Run method in Visual Basic but entered an
invalid procedure name, or you used the Run method without first
opening a database.
• You tried to use the OpenModule action or method, but you used an
invalid procedure name.
The database must be open for the SelectObject method to run. You
tried to run a function in a library database, and the function contains
the SelectObject method.
The action or method requires a Module or Procedure Name argument.
You tried to use the OpenModule action or method, but you didn’t
enter a name in either the Module Name or the Procedure Name
argument in the Macro window. Enter a valid name in one of these
arguments.
You have specified a Transfer Type that doesn’t support the HTML
Table Name argument. Leave the HTML Table Name argument blank
unless you are using the Import HTML or Link HTML Transfer Types.
The action or method requires a File Name argument. You tried to use
the TransferSpreadsheet or TransferText action or method. In the File
Name argument, enter a file name.
The value you entered for the show argument is invalid. You used the
ShowToolbar method. Valid values for this argument are acToolbarYes,
acToolbarWhereApprop, and acToolbarNo, or the corresponding
numeric values 0, 1, and 2.
Microsoft Access can’t invoke the application using the RunApp
action. The path to the application is invalid, or a component of the
application is missing. Check the path in Windows Explorer or File
Manager.
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A macro can call itself a maximum of 20 times. Your macro contains a
RunMacro action that calls the same macro more than 20 times. Use a
condition to stop the macro after it has been run 20 times, or call
another macro with the RunMacro action.
The SendKeys action requires the Microsoft Access Utility Add-in to
be loaded. Rerun Microsoft Access or Microsoft Office Setup to reinstall Microsoft Access and the Microsoft Access Utility Add-in.
Lotus .wks file formats aren’t supported in the current version of
Microsoft Access. Convert your .wks file to a more recent format, such
as .wk1.
The RunCommand macro action argument is missing, or you entered
an invalid command ID for the RunCommand method.
The Toolbar argument can’t be longer than 64 characters.
The SelectObject method can’t be used on a report that is currently
printing.
Your HTML file does not contain any tabular data that Microsoft
Access can import.
Microsoft Access can’t find the macro or sub procedure ‘|.’ The specified macro, macro group, or sub procedure doesn’t exist. Note that
when you enter the macrogroupname.macroname syntax in an argument, you must specify the name the macro’s macro group was last
saved under. Also, ensure that the referenced macro has been saved, or
that the referenced sub procedure expects 0 arguments.
The ApplyFilter action requires that either the Filter Name or Where
Condition argument is set. You tried to run a macro containing an
ApplyFilter action, but you didn’t set the required arguments.
The action or method requires a data access page Name argument. You
tried to use the OpenDataAccessPage action or method, but you left the
data access page Name argument blank. In the data access page Name
argument, enter the name of a data access page in the current database.
The ApplyFilter action contains a Filter Name that cannot be applied.
The filter name is not a valid argument in the ApplyFilter action in
Client Server.
Macros are disabled in this database.
The file ‘|’ you tried to replace is a Microsoft Access system file that is
in use and can’t be replaced or deleted.
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The contents of the Clipboard have been deleted and can’t be pasted.
Some applications do not put large objects on the Clipboard. Instead,
they put a pointer to the object on the Clipboard. The pointer may vanish before the paste happens.
Specify the database name in the command line so that Microsoft
Access can find the macro.
You can’t paste a database object onto itself.
Microsoft Access can’t find the | you referenced in the Object Name
argument. The macro you tried to run includes a SelectObject action
with an invalid name for the Object Name argument. In the Database
window, verify the name of the object you want the macro to select.
Then open the macro in the Macro window and enter the correct name
for the Object Name argument.
The CopyObject action requires you to specify a different destination
database or a new name to copy from the current database. The macro
you are running includes a CopyObject action. Open the macro in the
Macro window, and select the CopyObject action. Enter a destination
database or a new name in the appropriate argument box.
Select a database object in the Database window before you run the
macro containing the | action.
The database ‘|’ you tried to delete and replace is read-only and can’t
be deleted or replaced. Enter a different name for the new database.
Microsoft Access can’t run the Security Wizard because this database
is open in exclusive mode. Do you want Microsoft Access to open the
database in shared mode and run the Security Wizard?
Microsoft Access can’t delete |1 after compacting it. The compacted
database has been named |2. If you compact a database using the same
name, Microsoft Access creates a new compacted database and then
deletes the original database. In this case, however, the original database wasn’t deleted because it is read-only. If you can, remove the
read-only status, delete the original database, and then rename the new
database using the original name. If you can’t remove the read-only
status, inform your workgroup administrator.
Microsoft Access can’t delete |1 after encrypting it. The encrypted
database has been named |2. If you encrypt a database using the same
name, Microsoft Access creates a new encrypted database, and then
deletes the original database. In this case, however, the original database can’t be deleted because it is read-only. If you can, remove the
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read-only status, delete the original database, and then rename the new
database using the original name. If you can’t remove the read-only
status, inform your workgroup administrator.
Microsoft Access can’t delete |1 after decrypting it. The decrypted
database has been named |2. If you decrypt a database using the same
name, Microsoft Access creates a new decrypted database, and then
deletes the original database. In this case, however, the original database can’t be deleted because it is read-only. If you can, remove the
read-only status, delete the original database, and then rename the new
database using the original name. If you can’t remove the read-only
status, inform your workgroup administrator.
You can’t encrypt a database that you didn’t create or don’t own. See
the owner of the database or your workgroup administrator.
You can’t decrypt a database that you didn’t create or don’t own. See
the owner of the database or your workgroup administrator.
Can’t find the database you specified, or you didn’t specify a database
at all. Specify a valid database name in the command line, and include
a path if necessary.
Microsoft Access can’t run the Security Wizard because the database
has had a password set on it. You will have to unset the database password by choosing Tools|Security|Unset Database Password.
The database you tried to convert was either created in or was already
converted to the requested version of Microsoft Access.
Microsoft Access was unable to refresh the linked table ‘|1’ in database
‘|2’ during conversion. Try and refresh the links manually by using the
Linked Table Manager (Tools menu, Database Utilities submenu).
Microsoft Access is unable to load the Database Properties.
Microsoft Access can’t display the Database Properties dialog box.
Microsoft Access is unable to save the Database Properties.
Microsoft Access can’t load a dynamic-link library. Run Setup to reinstall Microsoft Access. If you want to preserve your security or custom
settings, back up the Microsoft Access workgroup information file. For
information on backing up files, search the Microsoft Windows Help
index for ‘backing up files’.
You can’t hide the document ‘|’ while it is open. Close the database
object first, and then hide it.
You can’t unhide the database object ‘|’ while it is open. Close the
database object first, and then unhide it.
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2566

Microsoft Access is unable to set the application’s icon to the file ‘|’.
Make sure the file is a valid icon (.ico) file. If you’re using Microsoft
Windows, you can also use .bmp files.
Microsoft Access can’t open or convert this previous version database.
The database was created in an earlier version of Microsoft Access.
You don’t have appropriate security permissions to open or convert
databases created in earlier versions.
Microsoft Access can’t undo this operation. An object with the same
name already exists. Another user might have created an object named
‘|’ after you had performed this operation on an object with the same
name.
Microsoft Access can’t delete |1 after enabling it. The enabled database
has been named |2. If you enable a database using the same name,
Microsoft Access creates a new enabled database and then deletes the
original database. In this case, however, the original database wasn’t
deleted because it is read-only. If you can, remove the read-only status,
delete the original database, and then rename the new database using
the original name. If you can’t remove the read-only status, inform
your workgroup administrator.
You can’t modify objects created using an earlier version of Microsoft
Access. To convert this database to the current version of Microsoft
Access, close the database, point to Database Utilities on the Tools
menu, and then click Convert Database.
This database is in an unexpected state; Microsoft Access can’t open it.
This database has been converted from a prior version of Microsoft
Access by using the DAO CompactDatabase method instead of the
Convert Database command on the Tools menu (Database Utilities submenu). This has left the database in a partially converted state. If you
have a copy of the database in its original format, use the Convert
Database command on the Tools menu (Database Utilities submenu) to
convert it. If the original database is no longer available, create a new
database and import your tables and queries to preserve your data. Your
other database objects can’t be recovered.
This database is a replica created in a different version of Access. You
can only convert this replica by synchronizing with its Design Master.
Convert the Design Master of this replica set then synchronize the
replica with the Design Master.

2567

2568

2569

2571

2572

2573
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You can’t create another Microsoft Access database with the same
name and location as an existing database. You carried out the Make
MDE File command, but tried to give the new database the same
extension as the old one. Accept the default .mde extension for your
new MDE database.
You can’t create a Microsoft Access MDE database from a database
replica.
This database is a Microsoft Access 7.0/8.0/9.0 Design Master/Replica.
If you click OK, the database you selected will be renamed to |1 and
then converted to |2. Everyone using a replica of this database will
have to upgrade to Microsoft Access 2000 after the next synchronization.
The database | is already open. Close the database before carrying out
the Make MDE File command.
Microsoft Access was unable to create an MDE database.
Local forms, reports, macros, and modules in this replica will not be
converted. To retain these objects, please be sure to import them into
the Design Master from the original replica.
The record source ‘|’ specified on this form or report does not exist.
You misspelled the name, or it was deleted or renamed in the current
database, or it exists in a different database. In the Form or Report’s
Design view, display the property sheet by clicking the Properties button, and then set the RecordSource property to an existing table or
query.
You must define a sort field or expression for the group header or
footer in the report you tried to preview or print.
You can’t set the GroupInterval property to zero when the GroupOn
property is set to Interval. Click Sorting and Grouping on the View
menu and try one of the following:
• Change the GroupInterval property setting to a number higher than
zero.
• Change the GroupOn property setting to Each Value.
The ApplyFilter action or method can be carried out only from an
Open macro or Open event procedure.
• You may have tried to run a macro or procedure containing the
ApplyFilter action or method from a report property other than the
OnOpen property.
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• You may have tried to run a macro or event procedure on a report that
is already open. To use the ApplyFilter action in a report, set the
OnOpen property to the name of the macro, close the report, and then
reopen it.
You can’t use aggregate functions in a page header or footer. The page
header or footer of the report you tried to preview contains a calculated
control with an aggregate function in its expression. If you want to
show the result of an aggregate function in a page header or footer, create a hidden calculated control in an appropriate section of the report.
Then create an unbound text box in the page header or footer. If you
are running a macro, use the SetValue action to set the unbound text
box value to the value in the hidden control.
This action can’t be carried out while processing a form or report
event. A macro specified as the OnOpen, OnClose, OnFormat,
OnRetreat, OnPage, or OnPrint property setting contains an invalid
action for the property. When you click OK, an Action Failed dialog
box will display the name of the macro that failed and its arguments.
Microsoft Access changed the MoveLayout and NextRecord properties
to True from False. The macro or Visual Basic function run by the
OnFormat property of one of the sections of the report set both the
MoveLayout and NextRecord properties to False. Having both properties set to False can make the report print continuously. Revise the
macro or function so that it sets these properties to the values you
want.
Microsoft Access can’t complete the Output operation. The Visual
Basic code you entered contains a syntax error or the Output procedures are not available. Make sure there isn’t a syntax error in your
code. If the syntax is correct, run Setup to reinstall Microsoft Access. If
you want to preserve your security or custom settings, back up the
Microsoft Access workgroup information file. For information on backing up files, search the Microsoft Windows Help index for ‘backing up
files’.
You must select a form to save as a report.
The expression ‘|’ is invalid. Aggregate functions are only allowed on
output fields of the Record Source.
The Var and VarP aggregate functions are not supported in an Access
project.
You can’t change printer properties in the OnOpen event of a report.
You cannot bind a hierarchical report to a DAO Recordset.
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This feature is not available in an MDB.
You cannot Filter By Form when form record source is a recordset
object.
Microsoft Access cannot set this property when DefaultSize property is
set to True.
Printer object is not available on subforms and subreports.
Unable to bind the report to the specified recordset because the shape
does not match the sorting and grouping specified on the report.
Recordset property not available for natively bound reports in MDB
files.
Verify the new password by retyping it in the Verify box and clicking
OK.
You don’t have permission to read ‘|.’ To read this object, you must
have Read Design permission for it. For more information on permissions and who can set them, click Help.
You don’t have permission to modify ‘|.’ To modify this object, you
must have Modify Design permission for it. If the object is a table, you
must also have Delete Data and Update Data permissions for it. For
more information on permissions and who can set them, click Help.
You don’t have permission to run ‘|.’ To run this object, you must have
Open/Run permission for it. For more information on permissions and
who can set them, click Help.
You can’t view this object’s permissions. To view or change permissions for this object, you must have Administer permission for it. For
more information on permissions and who can set them, click Help.
You can’t remove this user account from group ‘|.’
• You may have tried to remove a user account from the default Users
group. Microsoft Access automatically adds all users to the default
Users group. To remove a user account from the Users group, you
must first delete the account.
• You may have tried to remove all users from the Admins group.
There must be at least one user in the Admins group.
The object type is invalid.
You don’t have permission to cut ‘|.’ To cut this object, you must have
Modify Design permission for it. If the object is a table, you must also
have Delete Data permission for it. For more information on permissions and who can set them, click Help.
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2608

You don’t have permission to copy ‘|.’ To copy this object, you must
have Read Design permission for it. If the object is a table, you must
also have Read Data permission for it. For more information on permissions and who can set them, click Help.
You don’t have permission to delete ‘|.’ To delete this object, you must
have Modify Design permission for it. If the object is a table, you must
also have Delete Data permission for it. For more information on permissions and who can set them, click Help.
You must enter a personal identifier (PID) consisting of at least 4 and
no more than 20 characters and digits. Microsoft Access uses the combination of the user or group name and the PID to identify the user or
group. Note that Microsoft Access hides the PID after you create it, so
make sure to write down the exact user or group account name and the
PID entries. If you ever have to re-create the account, you must supply
the same name and PID entries.
Microsoft Access can’t find the workgroup file ‘|.’ Would you like to
use the default workgroup file?
The account name is invalid. For information about naming conventions, click Help.
You don’t have permission to rename ‘|.’ To rename a database object,
you must have Modify Design permission for the object. For more
information on permissions and who can set them, click Help.
You don’t have permission to insert this form into another form. To
insert a form into another form as a subform, you must have Read
Design permission for the form being inserted. For more information
on permissions and who can set them, click Help.
You don’t have permission to change the owner of ‘|.’ To change the
owner of a database object, you must have Administer permission for
it. For more information on permissions and who can set them, click
Help.
You can’t change permissions for ‘|.’ To change permissions for this
object, you must have Administer permission for it. For more information on permissions and who can set them, click Help.
You don’t have permission to import, export, or link to ‘|.’ To import,
export, or link to this object, you must have Read Design and Read
Data permissions for it. For more information on permissions and who
can set them, click Help.
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You need to have the database open for exclusive use to set or unset
the database password. To open the database exclusively, close the
database, and then reopen it using the Open command on the File
menu. In the Open dialog box, click the arrow to the right of the Open
button, and then choose Open Exclusive.
You can’t change permissions for ‘|’ in a replica. Permissions may only
be changed in the Design Master for the replica set.
The password you entered in the Old Password box is incorrect. Please
enter the correct password for this account.
That password isn’t valid. You may have used a semicolon.
You can’t save ‘|’ because it is read-only. To save, switch to Design
View and choose Save As from the File menu.
Saving the database to the previous version of Access will create a new
database that contains none of the security information that you have
set. Are you sure you want to proceed?
An error has occurred while changing workgroup database.
Workgroup Administrator couldn’t create the workgroup information
file. Make sure that you have specified a valid path and file name, that
you have adequate permissions to create the file, and that you have
enough disk space on the destination drive. (|)
Reserved error (|); there is no message for this error.
There’s not enough disk space.
One of your parameters is invalid.
Could not open workgroup file. This is a directory.
The specified path is invalid.
The specified path is too long.
Change Workgroup cannot proceed without your Name, PIN, and a
path to the new Workgroup Information File.
Microsoft Access cannot change the password for the logon account ‘|’
because the current connection is using Microsoft Windows NT integrated security.
The new password doesn’t match the verify password value.
Microsoft Access is unable to change the password because the old
password doesn’t match the password of the currently logged in user.
Workgroup file already exists.
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2637

Unable to start SQL Server service. To restart the SQL Server service,
double click on the SQL Server System Manager icon in the system
tray and click Start/Continue. Once the service is started, point to
Connection on the File menu in Access and click OK.
Unable to start SQL Server service. To restart the SQL Server service,
double click on the SQL Server System Manager icon in the system
tray and click Start/Continue. If the service fails to start, go to the
Services console and verify that the MSSQLServer service Log On
information is correct. Once the service is started, point to Connection
on the File menu in Access and click OK.
Microsoft Access can’t create this relationship and enforce referential
integrity. Data in the table ‘|’ violates referential integrity rules. For
example, there may be records relating to an employee in the Related
table, but no record for the employee in the primary table. Edit the data
so that records in the primary table exist for all related records. If you
want to create the relationship without following the rules of referential
integrity, clear the Enforce Referential Integrity check box.
Microsoft Access created a one-to-one relationship instead of a one-tomany relationship because there is a unique index on the field(s) specified for the related table. If you want to define a one-to-many
relationship between these tables, try one of the following:
• Delete the one-to-one relationship, and then change the setting of the
Indexed property for the foreign key field from No Duplicates to
Duplicates OK.

2638

2646

2648

2649

2650

• Choose different matching fields.
Microsoft Access can’t enforce referential integrity for this relationship. Make sure the fields you drag are primary key fields or uniquely
indexed and that the unique index or primary key is correctly set. If
you want to create the relationship without following the rules of referential integrity, clear the Enforce Referential Integrity check box.
Microsoft Access can’t create this relationship and enforce referential
integrity.
• The fields you chose may have different data types.
• The fields may have the Number data type but not the same FieldSize
property setting. Try one of the following:
• Select fields with the same data type.
• Open the tables in Design view, and change the data types and
field sizes so that the fields match.
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If you want to create the relationship without following the rules of
referential integrity, clear the Enforce Referential Integrity check box.
You can’t create a relationship between fields with the Memo, OLE
Object, Yes/No, or Hyperlink data type. You tried to enforce referential
integrity for a relationship, but one or more of the fields you chose
have the Memo, OLE Object, Yes/No, or Hyperlink data type. Select
fields in the grid that don’t have these data types, or open the tables in
Design view and change data types.
You can’t delete a relationship inherited from a linked database.
The form or report includes more OLE objects than Microsoft Access
can display at one time. Delete some of the bound or unbound object
frames.
There is no object in this control.
The OLE object is empty. You can’t edit a bound object frame if the
field in the underlying table doesn’t contain an OLE object. Embed or
link an OLE object into the bound object frame using the Object command on the Insert menu.
The object doesn’t have an OLE object data type. The bound object
frame containing the object you tried to edit isn’t bound to a field with
the OLE object data type. If you want to display an OLE object, set the
ControlSource property for the bound object frame to a field with the
OLE object data type. Or use a different control, such as a text box, to
display the data.
Microsoft Access is unable to save the | object. Your computer ran out
of disk space while Microsoft Access was saving the OLE object. For
information on freeing disk space, search the Microsoft Windows Help
index for ‘disk space, freeing’.
There was a problem reading the | object.
A system resource necessary for displaying the | object isn’t available.
Your computer may be low on memory. Close unneeded programs, and
try the operation again. For more information on freeing memory, search
the Microsoft Windows Help index for ‘memory, troubleshooting’.
Microsoft Access can’t communicate with the OLE server. The OLE
server may not be registered. To register the OLE server, reinstall it.
The Clipboard isn’t available. The Clipboard may be in use by another
application, or your computer may be low on memory. If your computer is low on memory, close unneeded programs, and then try the
operation again. For more information on freeing memory, search the
Microsoft Windows Help index for ‘memory, troubleshooting’.
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2695

Microsoft Access is unable to display the converted | object. Delete the
object in the bound object frame, and then re-create it.
Microsoft Access can’t read the OLE object. Delete the object in the
bound object frame, and then re-create it.
There was a problem loading the | object. The object you tried to create
or edit is not a valid OLE object. Re-create the object, and then embed
or link it again.
The | object you tried to create or edit is too large to save.
• Your database may not contain enough space for the object.
• Your computer may be out of disk space. For information on freeing
disk space, search the Microsoft Windows Help index for ‘disk space,
freeing’.
The connection with the OLE server was lost, or the OLE server
encountered an error while you were using it. Restart the OLE server,
and then try the operation again.
Microsoft Access can’t find an OLE server or a dynamic-link library
(DLL) required for the OLE operation. The OLE server or DLL may
not be registered. To register the OLE server or DLL, reinstall it.
The OLE server for the OLE object you tried to create is already open.
Switch to the OLE server window and close it. Then try to create or
edit the OLE object again.
The | object isn’t registered. The object may be calling an application
that isn’t installed. To register the application, reinstall it.
Microsoft Access can’t read the | object because communication was
interrupted. If the OLE server application is located on a network
server, make sure your computer is connected to it.
The | object you tried to edit doesn’t have any displayable information.
Microsoft Access can’t open the file containing the OLE object.
• You may have specified an invalid file name or an invalid unit of data
(such as a range of cells from a worksheet) within the file for the
OLE object.
• The file you specified may not be available because it’s locked by
another user or you don’t have permission to use it. Try one of the
following:
• Make sure the file is available and that you used the correct file
name.
• Check the OLE server’s documentation for information about the
syntax to use when specifying an OLE object’s data.
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The file name argument in the GetObject function of the Visual Basic
procedure you ran is invalid.
• You may not have entered, or may have misspelled, the file name.
• The unit of data (such as a range of cells from a worksheet) may not
be valid. Try one of the following:
• Make sure the file is installed on your computer and that you used
the correct file name.
• Check the OLE server’s documentation for information about the
syntax to use when specifying an OLE object’s data.
A problem occurred when Microsoft Access tried to access the | object.
• You may have specified an invalid file name or an invalid unit of data
(such as a range of cells from a worksheet) within the file for the
OLE object.
• The file you specified may not be available because it’s locked by
another user or you don’t have permission to use it. Try one of the
following:
• Make sure that the file is installed on your computer and that you
used the correct file name.
• Check the OLE server’s documentation for information about the
syntax to use when specifying an OLE object’s data.
The | object doesn’t support verbs that can be performed on an OLE
object, such as play or edit. Check the OLE server’s documentation for
information on the verbs the OLE object supports, or use the
ObjectVerbs property or the ObjectVerbsCount property to find the
verbs supported by an OLE object.
The index for the Action or the Verb property for the | object is invalid.
The setting you entered may be a negative number or may be too large.
The | object has no displayable information. You tried to perform an
operation on a bound or unbound object frame containing an OLE
object, but the OLE object is empty. Use the Object command on the
Insert menu to create an OLE object or to embed or link an OLE object
from a file that isn’t empty.
A problem occurred while accessing the | object.
• The OLE server may not be available because it’s on a network
server and you lost the connection. Try re-establishing the
connection.
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• The OLE object may be stored in a linked file, but the file isn’t available. Activate the OLE server outside of Microsoft Access, and then
open the file containing the OLE object to verify that it still exists
and can be accessed.
The | object doesn’t support the attempted operation. The OLE object
was changed to a picture, or the link to the object was broken. If you
want to perform the operation, delete the OLE object, and then embed
or link it again.
One or more dynamic-link libraries required for using OLE objects is
an incorrect version. Run Setup to reinstall Microsoft Access. If you
want to preserve your security or custom settings, back up the
Microsoft Access workgroup information file. For information on backing up files, search the Microsoft Windows Help index for ‘backing up
files’.
The OLE server isn’t registered. To register the OLE server, reinstall it.
Microsoft Access can’t perform the OLE operation because it was
unable to read the Windows Registry where the OLE server is registered. Reinstall the OLE server, and then try the operation again. If
problems continue, reinstall Microsoft Windows and the other applications on your computer.
If you reinstall Microsoft Access, you may want to back up your
Microsoft Access workgroup information file first to preserve any custom settings. For information on backing up files, search the Microsoft
Windows Help index for ‘backing up files’.
For information on the Windows Registry, search the Microsoft
Windows Help index for ‘registry’.
Microsoft Access can’t perform the OLE operation because it was
unable to write to the Windows Registry where the OLE server is registered. Reinstall the OLE server, and then try the operation again. If
problems continue, reinstall Microsoft Windows and the other applications on your computer.
If you reinstall Microsoft Access, you may want to back up your
Microsoft Access workgroup information file first to preserve any custom settings. For information on backing up files, search the Microsoft
Windows Help index for ‘backing up files’.
For information on the Windows Registry, search the Microsoft
Windows Help index for ‘registry’.
The OLE object you tried to edit is busy. Try again later.
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There was a problem communicating with the OLE server. Try
again later. If you still can’t access the object, try one or more of
the following:
• Free up system memory. For information on freeing memory, search
the Microsoft Windows Help index for ‘memory, troubleshooting’.
• Reinstall the OLE server to make sure it’s registered.
• Check the OLE server’s documentation for information about the
syntax to use when specifying an OLE object’s data.
An error occurred while accessing the OLE server. The OLE server
may not be registered. To register the OLE server, reinstall it.
Microsoft Access can’t read the | object. Communication between
Microsoft Access and the OLE server was interrupted. Make sure your
computer is connected to the network server on which the OLE server
is located.
The OLE object you tried to edit can’t be accessed. You don’t have
permission to change the object, or another user opened and locked the
object.
You can’t save the | object now. The OLE server is running an operation, or another user opened and locked the object. Try to save the
object again later.
This disk is write-protected. You can’t save the | object to it.
Microsoft Access can’t find the file containing the linked OLE object
you tried to update using the OLE/DDE Links command. You may
have misspelled the file name, or the file may have been deleted or
renamed. If the file has been moved to a different location, use the
OLE/DDE Links command to change the source. Or delete the object,
and create a new linked object.
There isn’t enough memory to complete the operation. Close unneeded
programs and try the operation again. For more information on freeing
memory, search the Microsoft Windows Help index for ‘memory, troubleshooting’.
An error occurred during the operation with an OLE object. The object
is in use.
Your computer ran out of disk space while Microsoft Access was saving the changes you made to the | object. For information on freeing
disk space, search the Microsoft Windows Help index for ‘disk space,
freeing’.
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2742

Microsoft Access was unable to create more files. Your computer may
be low on memory or disk space. Close unneeded programs and try the
operation again. For information on freeing memory or disk space,
search the Microsoft Windows Help index for ‘memory, troubleshooting’ or ‘disk space, freeing’.
The | object is stored in a format that is incompatible with the version
of OLE on your computer.
Microsoft Access can’t find the OLE server. The setting for the
SourceDoc property may be invalid, or the file may have been deleted,
renamed, or moved.
Share.exe or Vshare.386 is missing from your computer; OLE support
needs these files to work correctly. Rerun Microsoft Access or
Microsoft Office Setup to reinstall Microsoft Access, the Share program, and Vshare.386. If you want to preserve your security or custom
settings, back up the Microsoft Access workgroup information file.
Then restore the file to its original location. For information on backing
up files, search the Microsoft Windows Help index for ‘backing up
files’.
You can’t switch to Design view because your form contains too many
OLE objects. Close other applications, close the form, and then open
the form again in Design view. Then delete some of the OLE objects or
move them to a different form.
The OLE server can’t display the | object. There is a problem with the
file containing the OLE object, or there isn’t enough memory available.
Open the OLE server outside of Microsoft Access, and then open the
OLE object file. If you can do this, then your computer may be low on
memory. Close other programs, and then try the operation again. For
more information on freeing memory, search the Microsoft Windows
Help index for ‘memory, troubleshooting’.
The Automation object operation isn’t available for the | object. Check
the component’s documentation for information on which operations
are available for an Automation object.
There isn’t enough memory to complete the Automation object operation on the | object. Close unneeded programs and try the operation
again. For more information on freeing memory, search the Microsoft
Windows Help index for ‘memory, troubleshooting’.
The operation on the | object failed. The OLE server may not be registered. To register the OLE server, reinstall it.
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The Exit or Update operation failed. You pressed the ESC key (or
another key used in the OLE server to stop an operation) while
Microsoft Access was saving the changes you made to an OLE object
in a form or report. Try to exit or update again.
A problem occurred while Microsoft Access was communicating with
the OLE server or ActiveX Control. Close the OLE server and restart it
outside of Microsoft Access. Then try the original operation again in
Microsoft Access.
A problem occurred while Microsoft Access was communicating with
the OLE server. Try one or more of the following:
• Make sure you’re connected to the network server where the OLE
server application is located.
• Close the OLE server and restart it outside of Microsoft Access. Then
try the original operation again from within Microsoft Access.
• Reinstall the OLE server to ensure that it’s registered.
There was a problem referencing a property or method of the object.
You tried to run a Visual Basic procedure that references an object
property or method. Try one or more of the following:
• Make sure the component is properly registered.
• Make sure your computer is connected to the network server where
the component is located.
• Close the component and restart it outside of Microsoft Access. Then
try again to run the procedure in Microsoft Access.
A problem occurred when Microsoft Access tried to access the OLE
object. Close the Microsoft Access form or report that displays the
OLE object, and close the OLE server. Then reopen the form or report
to see if it can display the OLE object.
There was a problem accessing a property or method of the OLE
object. Try one or more of the following:
• Verify that the OLE server is registered correctly by reinstalling it.
• Make sure your computer is connected to the server on which the
OLE server application resides.
• Close the OLE server and restart it outside of Microsoft Access. Then
try the original operation again from within Microsoft Access.
There was a problem initializing the dynamic-link library Msole20
when you tried to perform the OLE operation.
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• You may have too many Microsoft applications open. Close Windows
applications other than Microsoft Access, and try the OLE operation
again.
• Your computer may have an older version of the dynamic-link library
Msole20, in which case you will need to run Setup to reinstall
Microsoft Access.
If you need to reinstall Microsoft Access, you may want to preserve
your security or custom settings by backing up the Microsoft Access
workgroup information file. For information on backing up files,
search the Microsoft Windows Help index for ‘backing up files’.
The method you tried to invoke on an object failed.
• You may have specified too many or too few arguments for a property or method of an object. Check the component’s documentation
for information on the properties and methods it makes available for
Automation operations.
• There may not be enough memory to run the procedure. Close
unneeded programs and try to run the procedure again. For more
information on freeing memory, search the Microsoft Windows Help
index for ‘memory, troubleshooting’.
An error occurred while referencing the object. You tried to run a
Visual Basic procedure that improperly references a property or
method of an object.
There was a problem referencing a property or method of an object.
Check the component’s documentation for information on the properties and methods it makes available for Automation operations.
| returned an error while referencing a property of an object. Check the
component’s documentation for information on the properties and
methods it makes available for Automation operations.
|1 returned the error: |2. Check the component’s documentation for
information on the properties and methods it makes available for
Automation operations.
The object’s property or method can’t be set. You tried to run a Visual
Basic procedure to set a property or apply a method for an object.
However, the property or method doesn’t support named arguments.
Check the component’s documentation for information on the properties and methods it makes available to Automation operations.
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Visual Basic can’t convert the data type of one of the arguments you
entered. You tried to run a Visual Basic procedure that executes a
method or sets a property of an object. Check the component’s documentation for information on the properties and methods it makes
available for Automation operations.
The object doesn’t contain the Automation object ‘|.’ You tried to run a
Visual Basic procedure to set a property or method for an object.
However, the component doesn’t make the property or method available for Automation operations. Check the component’s documentation
for information on the properties and methods it makes available for
Automation operations.
The object doesn’t support American English; it was developed using a
different language. Use a version of the object developed in Visual
Basic that supports the language you are using.
The number you used to reference an element in the array is outside
the bounds of the array. For example, the array is from 0 through 10,
and you entered a -1 or an 11. Check the component’s documentation
for information on the properties and methods it makes available for
Automation operations.
A property of the Automation object requires or returns a data type that
isn’t supported by Visual Basic. You tried to run a Visual Basic procedure that references an Automation object’s property. However, the
value of the property isn’t supported by Visual Basic. Check the component’s documentation for information on the properties and methods
it makes available for Automation operations.
The object you referenced in the Visual Basic procedure as an OLE
object isn’t an OLE object.
The bound or unbound object frame you tried to edit doesn’t contain
an OLE object. Use the Object command on the Insert menu to add an
OLE object to the bound or unbound object frame.
The component doesn’t support Automation. You tried to run a Visual
Basic procedure that references an Automation object. Check the component’s documentation for information on whether it supports
Automation.
You specified too many arguments in the Visual Basic procedure, or
there isn’t enough memory to run the procedure. Specify fewer arguments, or close unneeded programs, and then try to run the procedure
again. For more information on freeing memory, search the Microsoft
Windows Help index for ‘memory, troubleshooting’.
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2777

The class argument in the CreateObject function of the Visual Basic
procedure you’re trying to run is invalid. Try one of the following:
• Make sure the file is installed on your computer and that you used the
correct file name.
• Check the OLE server’s documentation for information about the syntax to use when specifying an OLE object’s data.
Microsoft Access tried to create an OLE link, but there was no source
document for this object.
You must specify a property or method for the object. You tried to run
a Visual Basic procedure that references and sets a property or method
for the object. Enter a property or method for the object.
You entered an invalid setting for the Action property. Use one of the
Microsoft Access intrinsic constants for the Action property. For a list
of valid settings you can use with the Action property, click Help.
The path you entered for the SourceDoc property setting for a linked
OLE object is too long. Move the file to a location with a shorter path.
The OLE server wasn’t able to open the object.
• The OLE server may not be installed.
• You may have specified an invalid setting for the SourceDoc or
SourceItem property in a property sheet, a macro, or a Visual Basic
procedure. To see the valid settings for either of these properties,
search the Help index for the property topic.
The OLE server doesn’t support linking. You tried to run a Visual Basic
procedure using the Action property. However, you provided insufficient information to establish a link.
The | object isn’t a linked object. The property you tried to set in Visual
Basic applies only to linked objects.
You can’t embed an OLE object into a bound or unbound object frame
if the OLETypeAllowed property for the bound or unbound object
frame is set to Linked. Insert a linked object, or set the
OLETypeAllowed property to Embedded or Either, and then embed the
object.
Microsoft Access can’t link the OLE object or the bound or unbound
object frame. The OLETypeAllowed property for the bound or
unbound object frame is set to Embedded. Embed the object, or set the
OLETypeAllowed property to Linked or Either, and then link the
object.
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2793

You can’t save a locked OLE object.
Microsoft Access can’t perform the operation specified in the Action
property of the Visual Basic procedure you’re trying to run. The object
frame may be locked or disabled. Set the Locked property to No and
the Enabled property to Yes.
The ActiveX control you tried to insert isn’t registered. For information
on registering an ActiveX control, click Help.
This OLE object was created in an earlier version of OLE so it can’t be
displayed as an icon. For an effect similar to displaying an object as an
icon, add an image control to your form, and add the icon for the application to the image control. Then set the image control’s OnDblClick
property to a Visual Basic procedure that opens the OLE object.
You can’t use the Action property to delete a bound OLE object from
its underlying table or query. You tried to run a Visual Basic procedure
that deletes the object in a bound object frame by setting the Action
property to acOLEDelete. Delete the object in a different way, such as
with the DAO Delete method in Visual Basic.
The OLE object can’t be activated upon receiving the focus. If you
selected an OLE object or a chart, and the AutoActivate property for
that control is set to GetFocus, the OLE object or chart should be activated automatically when it receives the focus. However, the ActiveX
component doesn’t support this operation. Check the component’s documentation for information on the properties and methods it makes
available to Automation operations.
The object is locked, so any changes you make will be discarded when
the form is closed. Click Save As on the File menu and save the object
under a different name.
The OLE object isn’t loaded because the unbound ActiveX control hasn’t been initialized.
You can’t insert an ActiveX control in a bound or unbound object
frame. ActiveX controls are automatically contained in ActiveX control
frames.
You don’t have the license required to use this ActiveX control. You
tried to open a form containing an OLE object or an ActiveX control or
you tried to create an ActiveX control. To obtain the appropriate
license, contact the company that provides the licensed OLE object or
ActiveX control.
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2804

You can’t create an ActiveX control in an unbound object frame.
ActiveX controls are automatically contained in ActiveX control
frames.
There was an error loading an ActiveX control on one of your forms or
reports. Make sure all the controls that you are using are properly registered. For information on registering an ActiveX control, click Help.
Microsoft Access doesn’t support this ActiveX control.
You can’t paste this object as the type you specified. Choose another
object type.
Microsoft Access can’t find the Active Accessibility dynamic-link
library (DLL) OleAcc. Rerun the Microsoft Access Setup program.
Microsoft Access is unable to create the data access page.
| The path specified was invalid, or may be too long. Please check the
path and ensure it is correct.
| The file could not be opened. It may currently be in use.
| Unable to save the file.
| Unable to save the file to an alternate location.
| Unable to close the file.
Microsoft Access is unable to save (or send) the data access page.
Microsoft Access is unable to retrieve the file: |. Either the file is not
available, or you do not have enough disk space to copy the file.
Microsoft Access is unable to open the data access page.
Microsoft Access is unable to change the BASE HREF for your document.
File in use
Microsoft Access encountered an unexpected error while attempting to
recover from a failed save (or send). Your data access page may not be
in a usable state. Please attempt to save to a different location.
The Microsoft Access data access page name ‘|’ is misspelled or refers
to a Page that doesn’t exist. If the invalid Page name is in a macro, an
Action Failed dialog box will display the macro name and the macro’s
arguments after you click OK. Open the Macro window, and enter the
correct Page name.
| You do not have adequate file permissions.
| The file does not exist, or you do not have read access to the file.
| File read error.
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2828
2832

| File write error. The disk may be full.
| Check file permissions and delete them from their location in your
computer’s file system.
| An unexpected error has occurred.
| An attempt to create this file has failed. Please select another location
and retry the operation.
| There was not enough memory. Please close other applications and
try the operation again.
Microsoft Access is unable to preview the selected theme.
| An attempt to create a temporary file has failed. Please confirm that
you have adequate disk space on your system drive and try the operation again.
| Unable to read the list of supporting files from the data access page.
Microsoft Access encountered an error after saving (or sending) your
data access page.
Microsoft Access is unable to open the data access page from the mail
envelope.
| The save destination is full. Please clear space at the destination or
save to another location.
| Unable to create a folder for the supporting files. You may not have
adequate permissions at the save destination.
| The maximum path length was exceeded. Please specify a shorter filename, or use a folder that is closer to the root.
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| There are too many supporting files in your document. Please remove
a few supporting files from your document, and try again.
| You do not have write permission at the save destination.
| You are saving to a server that does not support long filenames and do
not have permission to create a folder. You must have permission to
create a folder at the save destination to complete this operation.
Microsoft Access was unable to parse the document properties for this
data access page. They may be corrupted.
Microsoft Access could not delete one or more files related to the page.
Access could not load the e-mail envelope. This could be caused
by a network connection problem or a problem with your Office
installation.

65

66

Appendixes for Web Site
PART VI

ErrorCode

ErrorString

2860

You cannot insert a bound field to a caption or record navigation s
ection.
Microsoft Access is unable to preview the selected web page.
The file you attempted to load was not recognized as HTML. You may
have selected the wrong file, or tried to open a database file off of a
web server.
| Unable to create or load a file due to network or access permission
problems.
| This file (or a supporting file) is already in use, or has the read-only
attribute set.
| The disk is write-protected.
| Unexpected data corruption failure.
| Unexpected data I/O failure.
| You cannot save this data access page over itself because it is readonly. Please select a different file for the save.
| The file does not exist. You do not have adequate permission to modify the data access page link to point to a valid file. Please contact the
database administrator.
Microsoft Access encountered an error synchronizing the HTML from
the Microsoft Script Editor. Please check the HTML for syntax errors
and try again.
Microsoft Access is unable to create a data access page using the codepage selected in Web Options. The codepage may not be installed on
your system. Please install the codepage, or select a different one in
Web Options.
| The filename specified is a long filename, but you have the ‘use long
filenames’ web option turned off. Please specify a file name that uses a
maximum of eight characters for the name and three characters for the
file extension.
Cannot move or paste the grouping field ‘|’ into a section at a higher
group level.
| Unable to complete the save. The drive or network connection you
attempted to save to may no longer be available.
The data definition of this data access page has been corrupted and
can’t be repaired. You must recreate the page. Save has been disabled.
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In a Microsoft Access database (.mdb), you can’t group on a control
bound to a field that has a Memo or OLE Object data type. In a
Microsoft Access project (.adp), you can’t group on a control bound to
a field that has an Image or Text data type.
You cannot add a bound field to a caption or record navigation section.
Caption and record navigation sections cannot contain bound fields.
Can’t edit pages that contain framesets.
This web page contains XML namespaces that may conflict with
Access namespaces. You should edit the HTML source to ensure that
all namespaces have a unique prefix.
| The folder that this Web page would use to organize supporting files
is already reserved for use in the current location. Please choose a different name or location for this Web page.
A supporting file path for this data access page has been altered outside of Access. Please save this page to a different location and ensure
that all supporting files are maintained.
Cannot find the database or some database objects that this page refers
to. Update the connection information of the page, or fix the references
to the missing database objects.
This page uses a database which is not supported. You will not be able
to make data changes until you connect to a supported database
Components necessary for data access pages are not installed.
| The path specified is not a valid absolute (non-relative) path or URL.
Please enter a valid path.
Microsoft Access detects some HTML elements between the banner
and the section of your data access page. Saving this page in Access
will corrupt it. Close the page without saving it, and then edit the page
in another HTML editor to remove these elements.
This section cannot be deleted.
You cannot edit this page because it contains frames. The data access
page designer cannot edit pages with frames.
You can’t move the group filter control to another section. Delete the
group filter control from the current section and create it in a different
section.
A link to this data access page could not be created because the database cannot be exclusively locked. To create the link later, open the
page by selecting ‘Edit web page that already exists’, and then save.
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2894

The link to the data access page specified could not be updated because
the database cannot be exclusively locked. To update the link, open this
page again when you are the only person using the database.
This page was designed with a later version of the Microsoft Office
Web Components than those currently installed on your machine. If
you have not been prompted to install those components on this page,
please contact the page author for the installation location.
The operation is only valid on a data access page opened in Design
View. Please switch the page to Design View and try the operation
again.
You have opened a page that was last designed using Access 2000. The
page must be saved using Office 2002 Office Web Components before
you can edit this document. Would you like to convert this page?
Microsoft Access has created a backup copy of your original page.
This page can be used if you want to revert to the Office 2000 Web
Components.
The backup page name is: ‘|’
Microsoft Access could not create a backup copy of your original page.
This page cannot be opened.
Microsoft Access could not upgrade the Office Web Components on
your page. This page cannot be opened.
Error loading ActiveX control ‘|1’ on form or report ‘|2’.
Access is unable to save the | object because it does not support persistence, or your computer may have run out of disk space.
Do you want to set this folder as the default location for data access
pages?
You must match each field on the left with a field on the right.
You must choose a linking field for every parameter.
‘|’ contains no fields that can participate in a relationship.
Do you want to revert to the saved ‘|’?
The Control ID ‘|’ is already in use. Specify a different ID for the
control.
This relationship is not valid because the fields in the first table do not
match the fields in the second table. To repair the relationship, select at
least one field from each table.
This connection file refers to a provider not supported by data access
pages. Please select a different connection file.
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You cannot change the data access page path while it is open. Please
close the page and try again.
If you create a data access page in this version of Microsoft Access,
you can’t open it in Design view in Access 2000. However, you can
open the page in Page view in Access 2000, if you have installed the
Microsoft Office 2002 Web Components.
Cannot save to a URL address with a bookmark. Please specify a valid
path.
Microsoft Access could not link to a connection file. A connection
string will be embedded in the page.
Microsoft Access is unable to connect to the data source specified in
the connection string of this page. The server may not exist on the network, or there may be an error in the connection string information for
this page.
You cannot edit HTML pages created using PowerPoint in Microsoft
Access.
Invalid HTML color value.
Unable to open or read this connection file. Either the file has been
damaged or the file format is not valid.
You can’t place this control in the section you specified.
Microsoft Access is unable to load the database schema. Save has been
disabled. Either repair or reinstall Microsoft Office 2002.
Microsoft Access cannot open this page because it was created using a
newer version of Access. Try opening the page using a newer version
of Microsoft Access.
Reserved error (|); there is no message for this error.
Invalid argument.
Could not start session.
Could not start transaction; too many transactions already nested.
••••••••••
‘|’ is not a valid database name.
Database ‘|’ is exclusively locked.
Cannot open library database ‘|’.
The table ‘|’ is already opened exclusively by another user, or it is
already open through the user interface and cannot be manipulated programmatically.
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3009

You tried to lock table ‘|’ while opening it, but the table cannot be
locked because it is currently in use. Wait a moment, and then try the
operation again.
Table ‘|’ already exists.
The Microsoft Jet database engine could not find the object ‘|’. Make
sure the object exists and that you spell its name and the path name
correctly.
Object ‘|’ already exists.
Could not rename installable ISAM file.
Cannot open any more tables.
Index not found.
Field will not fit in record.
The size of a field is too long.
Could not find field.
Operation invalid without a current index.
Update or CancelUpdate without AddNew or Edit.
No current record.
The changes you requested to the table were not successful because
they would create duplicate values in the index, primary key, or relationship. Change the data in the field or fields that contain duplicate
data, remove the index, or redefine the index to permit duplicate entries
and try again.
AddNew or Edit already used.
Could not find file ‘|’.
Cannot open any more files.
Not enough space on disk.
Cannot update. Database or object is read-only.
Cannot start your application. The workgroup information file is missing or opened exclusively by another user.
Not a valid account name or password.
‘|’ is not a valid account name.
Not a valid password.
Cannot perform this operation.
You do not have the necessary permissions to use the ‘|’ object. Have
your system administrator or the person who created this object establish the appropriate permissions for you.
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You tried to commit or rollback a transaction without first beginning a
transaction.
System resource exceeded.
Database has reached maximum size.
Cannot open any more tables or queries.
System resource exceeded.
Could not create index; too many indexes already defined.
Disk I/O error during read.
Cannot open a database created with a previous version of your
application.
Out of MS-DOS file handles.
Disk or network error.
‘|’ is not a valid path. Make sure that the path name is spelled correctly
and that you are connected to the server on which the file resides.
Could not use ‘|’; file already in use.
Could not save; currently locked by another user.
Record is too large.
Cannot open any more databases.
Cannot open database ‘|’. It may not be a database that your application recognizes, or the file may be corrupt.
Could not lock file.
The Microsoft Jet database engine cannot open the file ‘|’. It is already
opened exclusively by another user, or you need permission to view its
data.
File sharing lock count exceeded. Increase MaxLocksPerFile registry
entry.
Too many client tasks.
Too many Memo, OLE, or Hyperlink Object fields.
Not a valid file name.
Could not repair this database.
Operation not supported on linked tables.
Index or primary key cannot contain a Null value.
Operation canceled by user.
Wrong data type for parameter ‘|’.
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3061
3062
3063
3064
3065
3066
3067
3068
3069
3070

Too few parameters. Expected |.
Duplicate output alias ‘|’.
Duplicate output destination ‘|’.
Cannot open action query ‘|’.
Cannot execute a select query.
Query must have at least one destination field.
Query input must contain at least one table or query.
Not a valid alias name.
The action query ‘|’ cannot be used as a row source.
The Microsoft Jet database engine does not recognize ‘|’ as a valid field
name or expression.
This expression is typed incorrectly, or it is too complex to be evaluated. For example, a numeric expression may contain too many complicated elements. Try simplifying the expression by assigning parts of
the expression to variables.
|
Operation must use an updateable query.
Cannot repeat table name ‘|’ in FROM clause.
|1 in query expression ‘|2’.
| in criteria expression.
| in expression.
The Microsoft Jet database engine cannot find the input table or query
‘|’. Make sure it exists and that its name is spelled correctly.
The specified field ‘|’ could refer to more than one table listed in the
FROM clause of your SQL statement.
Joined table ‘|’ not listed in FROM clause.
Cannot join more than one table with the same name (|).
JOIN operation ‘|’ refers to a field that is not in one of the joined
tables.
Cannot use internal report query.
Cannot insert data with action query.
Undefined function ‘|’ in expression.
Could not delete from specified tables.
Too many expressions in GROUP BY clause.
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3090
3091
3092
3093
3094
3095
3096
3097
3098
3099
3100
3101

Too many expressions in ORDER BY clause.
Too many expressions in DISTINCT output.
Resultant table not allowed to have more than one AutoNumber field.
HAVING clause (|) without grouping or aggregation.
Cannot use HAVING clause in TRANSFORM statement.
ORDER BY clause (|) conflicts with DISTINCT.
ORDER BY clause (|) conflicts with GROUP BY clause.
Cannot have aggregate function in expression (|).
Cannot have aggregate function in WHERE clause (|).
Cannot have aggregate function in ORDER BY clause (|).
Cannot have aggregate function in GROUP BY clause (|).
Cannot have aggregate function in JOIN operation (|).
Cannot set field ‘|’ in join key to Null.
The Microsoft Jet database engine cannot find a record in the table ‘|2’
with key matching field(s) ‘|1’.
Circular reference caused by ‘|’.
Circular reference caused by alias ‘|’ in query definition’s SELECT list.
Cannot specify fixed column heading ‘|’ in a crosstab query more than
once.
Missing destination field name in SELECT INTO statement (|).
Missing destination field name in UPDATE statement (|).
Record(s) cannot be added; no insert permission on ‘|’.
Record(s) cannot be edited; no update permission on ‘|’.
Record(s) cannot be deleted; no delete permission on ‘|’.
Could not read definitions; no read definitions permission for table or
query ‘|’.
Could not create; no modify design permission for table or query ‘|’.
Record(s) cannot be read; no read permission on ‘|’.
Cannot update ‘|’; field not updateable.
Cannot include Memo, OLE, or Hyperlink Object when you select
unique values (|).
Cannot have Memo, OLE, or Hyperlink Object fields in aggregate
argument (|).
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3116

Cannot have Memo, OLE, or Hyperlink Object fields in criteria (|) for
aggregate function.
Cannot sort on Memo, OLE, or Hyperlink Object (|).
Cannot join on Memo, OLE, or Hyperlink Object (|).
Cannot group on Memo, OLE, or Hyperlink Object (|).
Cannot group on fields selected with ‘•’ (|).
Cannot group on fields selected with ‘•’.
You tried to execute a query that does not include the specified expression ‘|’ as part of an aggregate function.
Cannot use ‘•’ in crosstab query.
Cannot input from internal report query (|).
‘|’ is not a valid name. Make sure that it does not include invalid characters or punctuation and that it is not too long.
Invalid bracketing of name ‘|’.
The INSERT INTO statement contains the following unknown field
name: ‘|’. Make sure you have typed the name correctly, and try the
operation again.
Specify the table containing the records you want to delete.
Invalid SQL statement; expected ‘DELETE’, ‘INSERT’, ‘PROCEDURE’, ‘SELECT’, or ‘UPDATE’.
Syntax error in DELETE statement.
Syntax error in FROM clause.

3117
3118
3119
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3121
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3124
3125
3126
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3128
3129
3130
3131
3132
3133
3134
3135
3136
3137
3138
3139
3140
3141

Syntax error in GROUP BY clause.
Syntax error in HAVING clause.
Syntax error in INSERT INTO statement.
Syntax error in JOIN operation.
The LEVEL clause includes a reserved word or argument that is misspelled or missing, or the punctuation is incorrect.
Missing semicolon (;) at end of SQL statement.
Syntax error in ORDER BY clause.
Syntax error in PARAMETER clause.
Syntax error in PROCEDURE clause.
The SELECT statement includes a reserved word or an argument name
that is misspelled or missing, or the punctuation is incorrect.
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3142
3143
3144
3145
3146
3151
3154
3155
3156
3157
3158
3159
3160
3161
3162

Characters found after end of SQL statement.
Syntax error in TRANSFORM statement.
Syntax error in UPDATE statement.
Syntax error in WHERE clause.
ODBC—call failed.
ODBC—connection to ‘|’ failed.
ODBC—could not find DLL ‘|’.
ODBC—insert on a linked table ‘|’ failed.
ODBC—delete on a linked table ‘|’ failed.
ODBC—update on a linked table ‘|’ failed.
Could not save record; currently locked by another user.
Not a valid bookmark.
Table is not open.
Could not decrypt file.
You tried to assign the Null value to a variable that is not a Variant data
type.
The field is too small to accept the amount of data you attempted to
add. Try inserting or pasting less data.
Field cannot be updated.
Could not open .inf file.
Cannot locate the requested Xbase memo file.
Record is deleted.
Invalid .inf file.
The Microsoft Jet database engine could not execute the SQL statement because it contains a field that has an invalid data type.
Could not find installable ISAM.
Could not find network path or user name.
Could not open Paradox.net.
Could not open table ‘MSysAccounts’ in the workgroup information
file.
Could not open table ‘MSysGroups’ in the workgroup information file.
Date is out of range or is in an invalid format.
Could not open file ‘|’.

3163
3164
3165
3166
3167
3168
3169
3170
3171
3172
3173
3174
3175
3176
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3177
3179
3180
3181
3182
3183
3184
3185
3186
3187
3188
3189
3190
3191
3192
3193
3194
3195
3196

Not a valid table name.
Encountered unexpected end of file.
Could not write to file ‘|’.
Invalid range.
Invalid file format.
Not enough space on temporary disk.
Could not execute query; could not find linked table.
SELECT INTO on a remote database tried to produce too many fields.
Could not save; currently locked by user ‘|2’ on machine ‘|1’.
Could not read; currently locked by user ‘|2’ on machine ‘|1’.
Could not update; currently locked by another session on this machine.
Table ‘|1’ is exclusively locked by user ‘|3’ on machine ‘|2’.
Too many fields defined.
Cannot define field more than once.
Could not find output table ‘|’.
(unknown)
(unknown)
(expression)
The database ‘|’ is already in use by another person or process. When
the database is available, try the operation again.
The Microsoft Jet database engine stopped the process because you
and another user are attempting to change the same data at the same
time.
Could not start session. Too many sessions already active.
Could not find reference.
The record cannot be deleted or changed because table ‘|’ includes
related records.
You cannot add or change a record because a related record is required
in table ‘|’.
Could not save; currently locked by another user.
Subqueries cannot be used in the expression (|).
Database already exists.
Too many crosstab column headers (|).

3197

3198
3199
3200
3201
3202
3203
3204
3205
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3206
3207
3208
3209
3210
3211

Cannot create a relationship between a field and itself.
Operation not supported on a Paradox table with no primary key.
Invalid Deleted setting in the Xbase key of the Windows Registry.
••••••••••
The connection string is too long.
The database engine could not lock table ‘|’ because it is already in use
by another person or process.
Could not lock table ‘|1’; currently in use by user ‘|3’ on machine ‘|2’.
Invalid Date setting in the Xbase key of the Windows Registry.
Invalid Mark setting in the Xbase key of the Windows Registry.
Too many Btrieve tasks.
Parameter ‘|’ specified where a table name is required.
Parameter ‘|’ specified where a database name is required.
Could not update; currently locked.
Invalid operation.
Incorrect collating sequence.
Invalid settings in the Btrieve key of the Windows Registry.
Query cannot contain a Database parameter.
‘|’ is invalid because it is too long, or contains invalid characters.
Cannot read Btrieve data dictionary.
Encountered a record locking deadlock while performing a Btrieve
operation.
Errors encountered while using the Btrieve DLL.
Invalid Century setting in the Xbase key of the Windows Registry.
Selected collating sequence not supported by the operating system.
Btrieve—cannot change field.
Out-of-date Paradox lock file.
ODBC—field would be too long; data truncated.
ODBC—could not create table.
ODBC—remote query timeout expired.
ODBC—data type not supported on server.
ODBC—data out of range.
Too many active users.

3212
3213
3214
3215
3216
3217
3218
3219
3220
3221
3222
3223
3224
3225
3226
3227
3228
3229
3230
3231
3232
3234
3235
3238
3239
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3240
3241
3242
3243
3244
3245
3246
3247
3248
3249
3250
3251
3252

Btrieve—missing Btrieve engine.
Btrieve—out of resources.
Invalid reference in SELECT statement.
None of the import field names match fields in the appended table.
Cannot import password-protected spreadsheet.
Could not parse field names from the first row of the import table.
Operation not supported in transactions.
ODBC—linked table definition has changed.
Invalid NetworkAccess setting in the Windows Registry.
Invalid PageTimeout setting in the Windows Registry.
Could not build key.
Operation is not supported for this type of object.
Cannot open a form whose underlying query contains a user-defined
function that attempts to set or get the form’s RecordsetClone property.
ODBC—Cannot lock all records.
Index file not found.
Syntax error in WITH OWNERACCESS OPTION declaration.
The SQL statement could not be executed because it contains ambiguous outer joins. To force one of the joins to be performed first, create a
separate query that performs the first join and then include that query
in your SQL statement.
Invalid field data type.
Could not update; currently locked by user ‘|2’ on machine ‘|1’.
Table ‘|’ is exclusively locked by user ‘|2’ on machine ‘|1’.
Could not lock table
Invalid Database object.
No field defined—cannot append TableDef or Index.
Item not found in this collection.
Cannot append a Field that is already a part of a Fields collection.
Property can be set only when the Field is part of a Recordset object’s
Fields collection.
Cannot set this property once the object is part of a collection.
Cannot append an Index that is already a part of an Indexes collection.

3254
3256
3257
3258

3259
3260
3261
3262
3263
3264
3265
3266
3267
3268
3269
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3270
3271
3272
3273
3274
3275
3276
3277
3278
3279
3280

Property not found.
Invalid property value.
Object is not a collection.
Method not applicable for this object.
External table is not in the expected format.
Unexpected error from external database driver (|).
Invalid database object reference.
Cannot have more than 10 fields in an index.
The Microsoft Jet database engine has not been initialized.
The Microsoft Jet database engine has already been initialized.
Cannot delete a field that is part of an index or is needed by the
system.
Cannot delete this index or table. It is either the current index or is
used in a relationship.
Operation not supported on a table that contains data.
Primary key already exists.
Index already exists.
Invalid index definition.
Format of memo file does not match specified external database
format.
Cannot create index on the given field.
Paradox index is not primary.
Syntax error in CONSTRAINT clause.
Syntax error in CREATE TABLE statement.
Syntax error in CREATE INDEX statement.
Syntax error in field definition.
Syntax error in ALTER TABLE statement.
Syntax error in DROP INDEX statement.
Syntax error in DROP TABLE or DROP INDEX.
Join expression not supported.
Could not import table or query. No records found, or all records
contain errors.
There are several tables with that name. Please specify owner in the
format ‘owner.table’.

3281
3282
3283
3284
3285
3286
3287
3288
3289
3290
3291
3292
3293
3294
3295
3296
3297
3298
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3299

ODBC Specification Conformance Error (|). Report this error to the
developer of your application.
Cannot create a relationship.
Cannot perform this operation; features in this version are not available
in databases with older formats.
Cannot change a rule while the rules for this table are in use.
Cannot delete this field. It is part of one or more relationships.
You must enter a personal identifier (PID) consisting of at least 4 and
no more than 20 characters and digits.
Invalid connection string in pass-through query.
You have written a subquery that can return more than one field without using the EXISTS reserved word in the main query’s FROM
clause. Revise the SELECT statement of the subquery to request only
one field.
The number of columns in the two selected tables or queries of a union
query do not match.
Invalid TOP argument in select query.
Property value is too large.
This property is not supported for external data sources or for databases created with a previous version of Microsoft Jet.
Property specified already exists.
Validation rules and default values cannot be placed on system or
linked tables.
Cannot place this validation expression on this field.
The field ‘|’ cannot contain a Null value because the Required property
for this field is set to True. Enter a value in this field.
Field ‘|’ cannot be a zero-length string.
|
One or more values are prohibited by the validation rule ‘|2’ set for
‘|1’. Enter a value that the expression for this field can accept.
Values specified in a TOP clause are not allowed in delete queries or
reports.
Syntax error in union query.
| in table-level validation expression.
No database specified in connection string or IN clause.

3300
3301
3302
3303
3304
3305
3306

3307
3308
3309
3310
3311
3312
3313
3314
3315
3316
3317
3318
3319
3320
3321
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3322
3323
3324
3325

Crosstab query contains one or more invalid fixed column headings.
The query cannot be used as a row source.
The query is a DDL query and cannot be used as a row source.
Pass-through query with ReturnsRecords property set to True did not
return any records.
This Recordset is not updateable.
Field ‘|’ is based on an expression and cannot be edited.
Table ‘|2’ is read-only.
Record in table ‘|’ was deleted by another user.
Record in table ‘|’ is locked by another user.
To make changes to this field, first save the record.
Cannot enter value into blank field on ‘one’ side of outer join.
Records in table ‘|’ would have no record on the ‘one’ side.
Can be present only in version 1.0 format.
DeleteOnly called with non-zero cbData.
Btrieve: Invalid IndexDDF option in initialization setting.
Invalid DataCodePage option in initialization setting.
Btrieve: Xtrieve options are not correct in initialization setting.
Btrieve: Invalid IndexDeleteRenumber option in initialization setting.
Query ‘|’ is corrupt.
The current field must match the join key ‘|’ in the table that serves as
the ‘one’ side of one-to-many relationship. Enter a record in the ‘one’
side table with the desired key value, and then make the entry with the
desired join key in the ‘many-only’ table.
Invalid Memo, OLE, or Hyperlink Object in subquery ‘|’.
Unrecognized database format ‘|’.
The database engine does not recognize either the field ‘|1’ in a validation expression, or the default value in the table ‘|2’.
Unknown or invalid field reference ‘|’.
Number of query values and destination fields are not the same.
Cannot add record(s); primary key for table ‘|’ not in recordset.
Cannot add record(s); join key of table ‘|’ not in recordset.
Numeric field overflow.

3326
3327
3328
3329
3330
3331
3332
3333
3334
3335
3336
3337
3338
3339
3340
3341

3342
3343
3344
3345
3346
3347
3348
3349
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3350
3351

Object is invalid for operation.
The ORDER BY expression (|) includes fields that are not selected by
the query. Only those fields requested in the first query can be included
in an ORDER BY expression.
No destination field name in INSERT INTO statement (|).
Btrieve: Cannot find file Field.ddf.
At most one record can be returned by this subquery.
Syntax error in default value.
You attempted to open a database that is already opened exclusively by
user ‘|2’ on machine ‘|1’. Try again when the database is available.
This query is not a properly formed data-definition query.
Cannot open the Microsoft Jet engine workgroup information file.
Pass-through query must contain at least one character.
Query is too complex.
Unions not allowed in a subquery.
Single-row update/delete affected more than one row of a linked table.
Unique index contains duplicate values.
Record(s) cannot be added; no corresponding record on the ‘one’ side.
Cannot use Memo, OLE, or Hyperlink Object field ‘|’ in the SELECT
clause of a union query.
Property value not valid for REMOTE objects.
Cannot append a relation with no fields defined.
Cannot append. An object with that name already exists in the collection.
Relationship must be on the same number of fields with the same data
types.
••••••••••
Cannot modify the design of table ‘|’. It is in a read-only database.
Cannot find table or constraint.
No such index ‘|2’ on table ‘|1’.
Cannot create relationship. Referenced table ‘|’ does not have a primary
key.
The specified fields are not uniquely indexed in table ‘|’.
Table ‘|1’ already has an index named ‘|2’.

3352
3353
3354
3355
3356
3357
3358
3359
3360
3361
3362
3363
3364
3365
3366
3367
3368
3369
3370
3371
3372
3373
3374
3375
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3376
3377
3378
3379

Table ‘|’ does not exist.
No such relationship ‘|2’ on table ‘|1’.
There is already a relationship named ‘|’ in the current database.
Cannot create relationships to enforce referential integrity. Existing
data in table ‘|2’ violates referential integrity rules in table ‘|1’.
Field ‘|2’ already exists in table ‘|1’.
There is no field named ‘|2’ in table ‘|1’.
Size of field ‘|’ is too long.
Cannot delete field ‘|’. It is part of one or more relationships.
Cannot delete a built-in property.
User-defined properties do not support a Null value.
Property ‘|’ must be set before using this method.
Cannot find TEMP directory.
Unknown function ‘|2’ in validation expression or default value on ‘|1’.
Query support unavailable.
Account name already exists.
An error has occurred. Properties were not saved.
••••••••••
Cannot perform join, group, sort, or indexed restriction. A value being
searched or sorted on is too long.
Cannot save property; property is a schema property.
••••••••••
Cannot perform cascading operation. Since related records exist in
table ‘|’, referential integrity rules would be violated.
Cannot perform cascading operation. There must be a related record in
table ‘|’.
Cannot perform cascading operation. It would result in a null key in
table ‘|’.
Cannot perform cascading operation. It would result in a duplicate key
in table ‘|’.
Cannot perform cascading operation. It would result in two updates to
field ‘|2’ in table ‘|1’.
Cannot perform cascading operation. It would cause field ‘|’ to become
Null, which is not allowed.

3380
3381
3382
3383
3384
3385
3386
3387
3388
3389
3390
3391
3392
3393
3394
3395
3396
3397
3398
3399
3400
3401
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3402

Cannot perform cascading operation. It would cause field ‘|’ to become
a zero-length string, which is not allowed.
Cannot perform cascading operation: ‘|’.
Cannot perform cascading operation. The value entered is prohibited
by the validation rule ‘|2’ set for ‘|1’.
Error ‘|’ in validation rule.
The expression you are trying to use for the DefaultValue property is
invalid because ‘|’. Use a valid expression to set this property.
The server’s MSysConf table exists, but is in an incorrect format.
Contact your system administrator.
Too many FastFind Sessions were invoked.
Invalid field definition ‘|’ in definition of index or relationship.
Invalid entry. Cannot perform cascading operation in table ‘|1’ because
the value entered is too large for field ‘|2’.
Cannot perform cascading update on the table because it is currently in
use by another user.
Cannot perform cascading operation on table ‘|1’ because it is currently
in use by user ‘|3’ on machine ‘|2’.
Cannot perform cascading operation on table ‘|1’ because it is currently
in use.
Zero-length string is valid only in a Text or Memo field.
|
An action query cannot be used as a row source.
Cannot open ‘|’. Another user has the table open using a different network control file or locking style.
Cannot open this Paradox 4.x or 5.x table because ParadoxNetStyle is
set to 3.x in the Windows Registry.
Object invalid or no longer set.
Data type conversion error.
Cannot modify table structure. Another user has the table open.
You cannot use ODBC to import from, export to, or link an external
Microsoft Jet or ISAM database table to your database.
Cannot create database because the locale is invalid.
This method or property is not currently available on this Recordset.

3403
3404
3405
3406
3407
3408
3409
3411
3412
3413
3414
3415
3416
3417
3418
3419
3420
3421
3422
3423
3424
3425
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3426
3427
3428

This action was cancelled by an associated object.
Error in DAO automation.
A problem occurred in your database. Correct the problem by repairing
and compacting the database.
Incompatible version of an installable ISAM.
While loading the Microsoft Excel installable ISAM, OLE was unable
to initialize.
This is not a Microsoft Excel 5.0 file.
Error opening a Microsoft Excel 5.0 file.
Invalid setting in Excel key of the Engines section of the Windows
Registry.
Cannot expand named range.
Cannot delete spreadsheet cells.
Failure creating file.
Spreadsheet is full.
The data being exported does not match the format described in the
Schema.ini file.
You attempted to link or import a Microsoft Word mail merge file.
Although you can export such files, you cannot link or import them.
An attempt was made to import or link an empty text file. To import or
link a text file, the file must contain data.
Text file specification field separator matches decimal separator or text
delimiter.
In the text file specification ‘|1’, the |2 option is invalid.
The fixed width specification ‘|1’ contains no column widths.
In the fixed width specification ‘|1’, column ‘|2’ does not specify a
width.
Incorrect version of the DLL file ‘|’ was found.
Jet VBA file (VBAJET.dll for 16-bit versions, or VBAJET32.dll for 32bit versions) is missing. Try reinstalling the application that returned
the error.
The Jet VBA file (VBAJET.dll for 16-bit versions, or VBAJET32.dll
for 32-bit versions) failed to initialize when called. Try reinstalling the
application that returned the error.

3429
3430
3431
3432
3433
3434
3435
3436
3437
3438
3439
3440
3441
3442
3443
3444
3445
3446
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3448

A call to an OLE system function was not successful. Try reinstalling
the application that returned the error.
No country code found in connection string for a linked table.
Syntax error in query. Incomplete query clause.
Illegal reference in query.
You cannot make changes to the design of the database at this replica.
You cannot establish or maintain an enforced relationship between a
replicated table and a local table.
Cannot make the database replicable.
Cannot make the |2 object in |1 container replicable.
You cannot set the KeepLocal property for an object that is already
replicated.
The KeepLocal property cannot be set on a database; it can be set only
on the objects in a database.
After a database has been replicated, you cannot remove the replication
features from the database.
The operation you attempted conflicts with an existing operation
involving this member of the replica set.
The replication property you are attempting to set or delete is read-only
and cannot be changed.
Failure to load a DLL.
Cannot find the .dll ‘|2’.
Data type mismatch in criteria expression.
The disk drive you are attempting to access is unreadable.
Access was denied while accessing dropbox folder ‘|2’.
The disk for dropbox folder ‘|2’ is full.
Disk failure accessing dropbox folder ‘|2’.
Failure to write to the Synchronizer log file.
Disk full for path ‘|1’.
Disk failure while accessing log file ‘|1’.
Cannot open the log file ‘|1’ for writing.
Sharing violation while attempting to open log file ‘|1’ in Deny Write
mode.
Invalid dropbox path ‘|2’.

3449
3450
3451
3452
3453
3455
3456
3457
3458
3459
3460
3461
3462
3463
3464
3465
3468
3469
3470
3471
3472
3473
3474
3475
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3478
3479

Dropbox address ‘|2’ is syntactically invalid.
The replica is not a partial replica.
Cannot designate a partial replica as the Design Master for the replica
set.
The relationship ‘|’ in the partial filter expression is invalid.
The table name ‘|’ in the partial filter expression is invalid.
The filter expression for the partial replica is invalid.
The password supplied for the dropbox folder ‘|2’ is invalid.
The password used by the Synchronizer to write to a destination dropbox folder is invalid.
The object cannot be replicated because the database is not replicated.
You cannot add a second Replication ID AutoNumber field to a table.
The database you are attempting to replicate cannot be converted.
The value specified is not a ReplicaID for any member in the replica
set.
The object specified cannot be replicated because it is missing a necessary resource.
Cannot create a new replica because the ‘|2’ object in ‘|1’ container
could not be replicated.
The database must be opened in exclusive mode before it can be
replicated.
The synchronization failed because a design change could not be
applied to one of the replicas.
Cannot set the specified Registry parameter for the Synchronizer.
Unable to retrieve the specified Registry parameter for the
Synchronizer.
There are no scheduled synchronization’s between the two
Synchronizers.
Replication Manager cannot find the ExchangeID in the
MSysExchangeLog table.
Unable to set a schedule for the Synchronizer.
Cannot retrieve the full path information for a member of the replica
set.
You cannot specify two different Synchronizers to manage the same
replica.

3480
3481
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3483
3484
3485
3486
3487
3488
3489
3490
3491
3492
3493
3494
3495
3496
3497
3499
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3502
3503
3504

The Design Master or replica is not being managed by a Synchronizer.
The Synchronizer’s Registry has no value set for the key you queried.
The Synchronizer ID does not match an existing ID in the
MSysTranspAddress table.
You attempted to delete or get information about a partial filter that
does not exist in MSysFilters.
The Synchronizer is unable to open the Synchronizer log.
Failure writing to the Synchronizer log.
There is no active transport for the Synchronizer.
Could not find a valid transport for this Synchronizer.
The member of the replica set you are attempting to synchronize is currently being used in another synchronization.
Failed to read the dropbox folder.
Failed to write to the dropbox folder.
Synchronizer could not find any scheduled or on-demand synchronization’s to process.
The Microsoft Jet database engine could not read the system clock on
your computer.
Destination synchronizer is not configured to support indirect synchronronization, and the destination replica is unavailable for direct
synchronization.
Synchronizer could not find any messages to process.
Could not find Synchronizer in the MSysTranspAddress table.
Failed to send a message.
The replica name or ID does not match a currently managed member
of the replica set.
Two members of the replica set cannot be synchronized because there
is no common point to start the synchronization.
Synchronizer cannot find the record of a specific synchronization in the
MSysExchangeLog table.
Synchronizer cannot find a specific version number in the
MSysSchChange table.
The history of design changes in the replica does not match the history
in the Design Master.
Synchronizer could not access the message database.

3505
3506
3507
3508
3509
3510
3512
3513
3514
3515
3516

3517
3518
3519
3520
3521
3522
3523
3524
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3526
3527

The name selected for the system object is already in use.
The Synchronizer or Replication Manager could not find the system
object.
There is no new data in shared memory for the Synchronizer or
Replication Manager to read.
The Synchronizer or Replication Manager found unread data in the
shared memory. The existing data will be overwritten.
The Synchronizer is already serving a client.
The wait period for an event has timed out.
Synchronizer could not be initialized.
The system object used by a process still exists after the process has
stopped.
Synchronizer looked for a system event but did not find one to report
to the client.
Client has asked the Synchronizer to terminate operation.
Synchronizer received an invalid message for a member of the replica
set that it manages.
The Synchronizer’s client is no longer present and cannot be notified.
Cannot initialize Synchronizer because there are too many applications
running.
A system error has occurred or your swap file has reached its limit.
Your swap file has reached its limit or is corrupted.
Synchronizer could not be shut down properly and is still active.
Process stopped when attempting to terminate Synchronizer client.
Synchronizer has not been set up.
Synchronizer is already running.
The two replicas you are attempting to synchronize are from different
replica sets.
The type of synchronization you are attempting is not valid.
Synchronizer could not find a replica from the correct set to complete
the synchronization.
GUIDs do not match or the requested GUID could not be found.
The file name you provided is too long.
There is no index on the GUID column.

3528
3529
3530
3531
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3533
3534
3535
3536
3537
3538
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3540
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3551
3552
3553
3555
3556
3557
3558
3559
3560

Unable to delete the specified Registry parameter for the Synchronizer.
The size of the Registry parameter exceeds the maximum allowed.
The GUID could not be created.
All valid nicknames for replicas are already in use.
Invalid path for destination dropbox folder.
Invalid address for destination dropbox folder.
Disk I/O error at destination dropbox folder.
Failure to write because destination disk is full.
The two members of the replica set you are attempting to synchronize
have the same ReplicaID.
The two members of the replica set you are attempting to synchronize
are both Design Masters.
Access denied at destination dropbox folder.
Fatal error accessing a local dropbox folder.
Synchronizer cannot find the source file for messages.
There is a sharing violation in the source dropbox folder because the
message database is open in another application.
Network I/O error.
Message in dropbox folder belongs to the wrong Synchronizer.
Synchronizer could not delete a file.
This member of the replica set has been logically removed from the set
and is no longer available.
The filters defining a partial replica have been changed. The partial
replica must be repopulated.
The attempt to set a column in a partial replica violated a rule governing partial replicas.
A disk I/O error occurred while reading or writing to the TEMP
directory.
The directory you queried for a list of replicas is not a managed
directory.
The ReplicaID for this member of the replica set was reassigned during
a move or copy procedure.
The disk drive you are attempting to write to is full.
The database you are attempting to open is already in use by another
application.

3561
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3564
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3577
3578

Cannot update replication system column.
Failure to replicate database; cannot determine whether the database is
open in exclusive mode.
Could not create replication system tables needed to make the database
replicable.
Could not add rows needed to make the database replicable.
Cannot open replication system table ‘|’ because the table is already in
use.
Cannot make a new replica because the |2 object in |1 container could
not be made replicable.
Cannot make the |2 object in |1 container replicable.
Insufficient memory to complete operation.
Cannot replicate the table; the number of columns exceeds the maximum allowed.
Syntax error in partial filter expression on table |1.
Invalid expression in the ReplicaFilter property.
Error when evaluating the partial filter expression.
The partial filter expression contains an unknown function.
Violates the rules for partial replicas.
Log file path ‘|1’ is invalid.
You cannot replicate a password-protected database or set password
protection on a replicated database.
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You cannot change the data master attribute for the replica set.
You cannot change the data master attribute for the replica set. It
allows data changes only at the Design Master.
The system tables in your replica are no longer reliable and the replica
should not be used.
Aggregation expressions cannot use GUIDs.
Synchronizing with a non-replicated database is not allowed. The ‘|’
database is not a Design Master or replica.
The replication property you are attempting to delete is read-only and
cannot be removed.
Record length is too long for an indexed Paradox table.
No unique index found for the referenced field of the primary table.
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3610

Same table ‘|’ referenced as both the source and destination in maketable query.
Cannot execute data definition statements on linked data sources.
Multi-level GROUP BY clause is not allowed in a subquery.
Cannot create a relationship on linked ODBC tables.
GUID not allowed in Find method criteria expression.
Type mismatch in expression.
Updating data in a linked table is not supported by this ISAM.
Deleting data in a linked table is not supported by this ISAM.
Exceptions table could not be created on import/export.
Records could not be added to exceptions table.
The connection for viewing your linked Microsoft Excel worksheet
was lost.
Cannot change password on a shared open database.
You must use the dbSeeChanges option with OpenRecordset when
accessing a SQL Server table that has an IDENTITY column.
Cannot access the FoxPro 3.0 bound DBF file ‘|’.
Could not read the record; currently locked by another user.
The text file specification ‘|’ does not exist. You cannot import, export,
or link using the specification.
The operation failed. There are too many indexes on table ‘|’. Delete
some of the indexes on the table and try the operation again.
Cannot find the executable file for the Synchronizer (mstran40.exe).
Partner replica is not managed by a Synchronizer.
Synchronizer ‘|1’ is also using the same File System dropbox ‘|2’.
Synchronizer ‘|1’ is also using the same File System dropbox ‘|2’.
Invalid Table Name In Filter
Internet Transport not enabled on the remote Synchronizer.
Cannot load DLL: ‘|’
Cannot create a replica using a partial replica.
Cannot create partial replica of a system database.
Cannot populate the replica or change the replica’s filter because the
replica has conflicts or data errors.
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3637
3638
3639
3640
3641
3642
3643
3645
3646
3647
3648
3649

Cannot use the crosstab of a non-fixed column as a subquery.
A Source Controlled database cannot be made replicable.
Cannot create a replica of a System database.
The fetch buffer was too small for the amount of data you requested.
There are fewer records remaining in the recordset than you requested.
A cancel was performed on the operation.
One of the records in the recordset was deleted by another process.
One of the binding parameters is incorrect.
The specified row length is shorter than the sum of the column lengths.
A column requested is not being returned to the recordset.
Cannot synchronize a partial replica with another partial replica.
The language-specific code page was not specified or could not be
found.
Either the Internet is very slow or there is some problem in the replication manager setup on the internet server machine.
Invalid internet address.
Internet login failure.
Internet not set up.
Internal internet failure.
The wininet.dll cannot be loaded or initialized.
Error in evaluating a partial expression
Error in evaluating the boolean filter expression for table ‘|1’.
Binary column ‘|’ cannot be used in a boolean filter.
Relationship ‘|1’ is unenforced. Relationship in a partial filter expression must be enforced.
Requested exchange failed because ‘|1’.
Requested exchange failed because ‘|1’
This operation requires a different cursor library.
An asynchronous OpenConnection call is not yet complete; you cannot
yet reference the returned connection object until it is complete.
You cannot modify the replication system object ‘|’.
You cannot modify the replication system object ‘|’.
A different operation is preventing this operation from being executed.
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3668
3669
3670
3671
3672
3673

Cannot perform this operation because there is no active connection.
Execution cancelled.
Cursor is not valid.
Cannot find table to update.
Failed to load RDOCURS.DLL.
This table contains cells that are outside the range of cells defined in
this spreadsheet.
Internet dll (wininet.dll) could not be found or loaded.
Failure to read from an internet handle. Try the operation again.
Failure to write to an internet handle. Try the operation again.
Failure to execute the HTTP request to start internet synchronizer on
the internet server. Use Replication Manager to configure internet synchronizer on the internet server.
Failure to connect to the FTP service on the internet server. Make sure
that FTP service is running properly on the server and supports anonymous connections.
Failure to do open file using FTP service. Make sure that FTP dropbox
has read permissions.
Failure in getting a file from the server using FTP. Make sure that FTP
dropbox has read permissions.
Failure in putting a file to the server using FTP. Make sure that FTP
dropbox has write permissions.
Failure to delete a file on the server using FTP. Make sure that FTP
dropbox has read and write permissions.
Internet synchronizer exited unexpectedly on the server. Look at the
partner replica exchange history on the internet server to figure out the
problem.
There is no suitable replica with which to exchange.
Invalid HTTP address.
Invalid replica path or name.
Invalid SQL syntax—expected token: Option.
Invalid SQL syntax—expected token: For.
Invalid SQL syntax—expected token: Privileges.
Invalid SQL syntax—expected a table right/privilege.
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3691
3692

Invalid SQL syntax—expected an object name.
Invalid SQL syntax—related tokens did not match. Jet expected
GRANT…TO, REVOKE…FROM, ADD…TO, or DROP…FROM.
Invalid SQL syntax—expected user or group name.
Invalid SQL syntax—expected token: Grant.
Invalid SQL syntax—GRANT/REVOKE syntax error.
Invalid SQL syntax—expected token: User (or) Group.
Invalid SQL syntax—expected token: Password.
Invalid SQL syntax—expected password.
Invalid SQL syntax—expected token: User.
Invalid precision for decimal data type.
Invalid scale for decimal data type.
The width of a Unicode text column must be an even number of bytes.
Operation not supported on replicable databases that have not been
converted to the current version.
You attempted to open a database that is already opened by user ‘|2’ on
machine ‘|1’. Try again when the database is available.
Cannot make the |2 table replicable—too many columns.
Cannot make the |2 table replicable—too many indexes.
The cascading options for the new reference conflict with existing reference ‘|’.
Syntax error in Transaction statement. Expected TRANSACTION,
WORK, or nothing.
The search key was not found in any record.
MAPI folder or address book not found.
Recovered replicable data. This row was recovered from a corrupted
replicable database. Verify that the record contents are correct and then
reinsert the record, or delete this conflict record.
Other. This record was rejected due to an undefined replication conflict
problem.
Update/update conflict. Another replica also updated this record. This
record lost the conflict. Either resubmit your update or delete this conflict record.
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3714

Locked table. This record could not be applied during synchronization
since the table was locked by another user. Resubmit this conflict
record.
Unique key violation. This record has the same key value as another
record, whereas only unique values are permitted. Either change the
key value in this conflict record or the winning record and then resubmit this record, or delete this conflict record.
TLV violation. This record contains a field value that does not meet the
table level validation constraint. Either update the field value that is
violating the validation rule and then resubmit this conflict record, or
delete this conflict record.
Delete/RI conflict. The primary key record has been deleted by another
replica, therefore this referencing record has been rejected. Either create a new primary key record that satisfies the referential integrity constraint and then resubmit your update, or delete this conflict record.
Update/RI conflict. The primary key record has been updated by
another replica, therefore this referencing record has been rejected.
Either create a new primary key record that satisfies the referential
integrity constraint, modify the foreign key value in this conflict record
to match a valid primary key value and then resubmit your update, or
delete this conflict record.
Foreign key violation resulting from an invalid primary key record that
was involved in a replication conflict. Either create a new primary key
record that satisfies the referential integrity constraint, modify the foreign key value in this conflict record to match a valid primary key
value and then resubmit this conflict record, or delete this conflict
record.
Cannot change field ‘|’. It is part of one or more relationships.
Invalid SQL syntax—expected constraint name.
Invalid SQL syntax—expected token: DEFAULT.
Invalid SQL syntax—expected token: COMPRESSION to follow
WITH.
Invalid SQL syntax—expected token: UPDATE or DELETE.
Invalid SQL syntax—expected token: CASCADE, SET NULL, or NO
ACTION.
Invalid SQL syntax—expected token: NULL.
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3727

Invalid SQL syntax—only one update rule and/or one delete rule
allowed.
Invalid SQL syntax—expected token: AS.
Invalid SQL syntax—expected token: SELECT.
VIEW cannot contain a parameter.
The number of aliases specified shall be the same as the number of
output columns.
Expected query name after EXECUTE.
The database has been placed in a state by an unknown user that prevents it from being opened or locked.
The database has been placed in a state by user ‘|2’ on machine ‘|1’
that prevents it from being opened or locked.
Too many columns in inverted index.
Update/delete conflict. This updated record was deleted at another
replica. Either reinsert this conflict record or delete it.
Cannot create this type of replica from the given source replica.
Local or Anonymous replicas must synch only to their designated hub
replica.
The proxy replica has been removed.
Cannot add a new column to conflict table ‘|’. Delete obsolete columns
and compact the database.
Invalid partner synchronizer. Local or anonymous replica must synchronize with designated hub replica.
An internet function timed out.
Replica has not been synchronized within the replica set retention
period.
Counter columns in replicable tables cannot be modified.
The combined length of Internet Server Name, HTTP Share name, and
FTP alias name should not be greater than 252 characters.
Syntax error in parameters clause. Make sure the parameter exists and
that you typed its value correctly.
Parameter has no default value.
Parameter | has no default value.
The object is not a stored procedure.
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3750
3751
3752
3753
3754
3755
3756
3757
3758
3759
3760
3761

Object | is not a stored procedure.
Requested row locking, but DB is in page lock mode.
Requested page locking, but DB is in row lock mode.
Cannot create replica of a Jet SQL replica.
Cannot delete from a Prevent Deletes Replica.
CHECK constraint ‘|’ does not exist.
CHECK constraint ‘|’ already exists.
The Jet sorting DLLs could not be loaded properly.
Scaling of decimal value resulted in data truncation.
Scaling of decimal value resulted in data truncation.
Scaling of decimal value resulted in data overflow.
The decimal field’s precision is too small to accept the numeric you
attempted to add.
Invalid SQL syntax - expected token: ACTION.
Concurrent schema changes caused the create replica operation to fail.
Try again.
Failed to re-create one or more indexes.
Syntax error in CHECK constraint clause.
Only simple SELECT queries are allowed in VIEWS.
Table ‘|’ could not be made replicable because it could not be opened
exclusively.
FastFind cannot search on non-column references.
Conflict tables cannot be renamed.
Counter definition not in valid range.
Local or Anonymous replicas cannot be made the design master.
Without Administer permission, replica priority must be in the range
0–|.
Cannot delete one or more objects: |.
Pin value is not valid.
Unable to load Jet SQL Server Reconciler—MSRPJT40.dll.
Unable to exchange between two Jet SQL Server Replicas.
Illegal Operation performed on a Jet SQL Server Replica.
The Jet database is wrong or missing for this SQL/Jet replica set.
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3779

Unable to change Column Level Tracking Property on objects that are
already Replicable.
Invalid SQL syntax—expected a view name.
Invalid SQL syntax—expected a procedure name.
Invalid SQL syntax—currently only one column-level CHECK constraint is allowed.
Invalid SQL syntax—cannot use multiple columns in a column-level
CHECK constraint.
Database is already replicable.
Invalid SQL syntax—expected token: Database.
Invalid SQL syntax—expected a database privilege, such as CREATEDB or CONNECT.
This operation is not allowed in subqueries.
Cannot create an index on this MAPI folder/addressbook.
Illegal column-level constraint.
This object requires a newer version of the Microsoft Jet database
engine.
This index requires Microsoft Jet database engine |.
The index ‘|2’ requires Microsoft Jet database engine |1.
The column ‘|2’ requires Microsoft Jet database engine |1.
This table requires Microsoft Jet database engine |.
The table ‘|2’ requires Microsoft Jet database engine |1.
The version of MSRECR40.DLL that was loaded was too old. Run
setup again to get the correct version of this file.
The SQL/Jet exchange failed, look in the SQLServer Agent history for
details.
CHECK constraints are not allowed on replicable databases.
Could not find field ‘|’.
‘|’ is not an index in this table.
The object (|) cannot be used in a CHECK constraint clause.
Error evaluating | CHECK constraint. |
DDL cannot be completed on this table because it is referenced by
constraint | on table |.
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3804

There are no MAPI clients installed on this machine. Install a MAPI
client (like Outlook) on this machine.
CHECK constraints on table | will not be transferred to this table.
CHECK constraints can only be created via SQL DDL statements.
Cannot set multiple NULL, NOT NULL attributes.
Query | contains an ambiguous column name that is conflicting with
the correlation (alias) name |. Either fully qualify the column name or
change the correlation (alias) name.
Errors were encountered during the save operation.
A form or report cannot be the subdatasheet of a table or query. Only a
table or query can be inserted into another table or query.
Microsoft Access cannot expand this subdatasheet because all of the
records are locked. The RecordLocks property of the form or report or
the Default Record Locking option on the Advanced tab of the Options
dialog box (Tools menu) is set to All Records. Reset the value to No
Locks or Edited Record as appropriate.
The setting for the Precision property must be from 1 through 28.
The setting for the Scale property must be from 0 through 28.
The table or query name ‘|’ you entered in either the property sheet or
macro is misspelled or refers to a table or query that doesn’t exist. If
the invalid name is in a macro, an Action Failed dialog box will display
the macro name and the macro’s arguments after you click OK. Open
the Macro window, and enter the correct name.
Filter by selection of a partial value is only supported for fields containing character data.
Cannot open a form bound to a stored procedure in server filter by
form mode.
Microsoft Access encountered an error closing your connection. Please
close all of your application windows before trying again.
Invalid connection string. You may need to specify a valid connection
string and try it again.
Invalid use of Move method. The Move method is not applicable to
subforms or subreports.
Do you want to save the data changes on form ‘|’?
Microsoft Access can’t set this property to No right now. You cannot
set the Allow Form View, Allow Datasheet View, Allow PivotTable
View, and Allow PivotChart View properties to No at the same time.
Set one of the other properties to Yes before changing this one to No.
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6013
6014

Unable to remove item. ‘|’ not found in list.
The RowSourceType property must be set to ‘Value List’ to use this
method.
Can’t add this item. The index is too large.
Microsoft Access is unable to switch to PivotTable or PivotChart view
right now. You must set the Record Source property of the form before
attempting to PivotTable or PivotChart view.
Microsoft Access doesn’t support the requested property for this type
of database object. The DateCreated and DateModified properties are
not supported for Tables, Queries, Stored Procedures, Database
Diagrams, and Functions in a Client Server database.
The form or report template is open in Design view. Before creating a
new form or report, close the corresponding template.
You must save new or dirty objects in the database before you can save
them to this external format.
This format does not support objects named ‘Schema’. Rename the
object and try again.
You cannot create a form with AutoForm or a report with AutoReport
by using a scalar function; you can use a table, view, stored procedure,
inline function, or table function.
This option cannot be changed in an Access Project file.
The Maximum Record Count setting cannot be a negative number.
The Maximum Record Count setting cannot contain text—please enter
a number.
The Requery action cannot be used on a control bound to a Recordset.
The RowSourceType property must be set to ‘Table/Query’ to use this
method.
You can’t save or undo the record at this time. The form’s
BatchUpdates property is set to Yes, but the form is not bound to a
record source. Either set the form’s BatchUpdates property to No, or
bind the form to a record source by setting a value in the RecordSource
property.
The OLE object failed to persist itself. You will not be able to undo
this operation.
Microsoft Access is unable to complete the operation. Try the operation again. If the error persists, restart Microsoft Access.
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7701

Microsoft Access can’t synchronize with Synchronizer ‘|1.’ A possible
reason for the failure to synchronize with ‘|1’ is that both the
Synchronizer and Microsoft Access were trying to write to the current
database at the same time. Try synchronizing with ‘|1’ again. Do you
want to continue synchronizing with the remaining Synchronizers?
The user-supplied function named ‘|’, the program to assist you in
resolving conflicts, could not be found. Contact the author of this customized database application.
There are no synchronization conflicts to resolve.
You can’t modify the design of ‘|’ at a replica. Design changes to replicated objects can be made only at the Design Master. Do you want to
open it as read-only?
This member of the replica set has conflicts from synchronizing
changes with other members. Do you want to resolve these conflicts
now?
This member of the replica set has errors from synchronizing changes
with another member. Do you want to see the errors now?
This member of the replica set has both errors and conflicts from synchronizing changes with another member. Do you want to see the
errors and resolve the conflicts now?
‘|1’ was the last designated Design Master for the replica set. Has ‘|2’
been moved, renamed, deleted, or corrupted? You should never have
more than one Design Master for each replica set. Having more than
one Design Master in a replica set prevents the members of the set
from synchronizing correctly. Use Windows Explorer to determine
whether the file has been moved or deleted. Open the file to determine
whether it has been corrupted.
To make this replica the Design Master for the replica set, point to
Replication on the Tools menu, click Synchronize Now, enter the path
to ‘|’ (the current Design Master), and select the Make…The Design
Master check box.
To make this replica the Design Master for the replica set, first synchronize this replica with all other replicas in the set. This ensures that
this replica includes all design changes made at the previous Design
Master. If you have already synchronized this replica, do you want to
make it the Design Master?
This member of the replica set is now the Design Master. Microsoft
Access will now close and reopen the database in order for the changes
to take effect.
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7712

This member of the replica set has exceeded the maximum number of
days allowed between synchronizations and can’t be synchronized with
any other member of the replica set. Delete this replica set member and
create a new replica.
This member of the replica set will expire in | days because it hasn’t
been synchronized with another member of the replica set. If the member is allowed to expire, it can no longer be synchronized with any
other member of the replica set. Synchronize with another member as
soon as possible. To synchronize, point to Replication on the Tools
menu, and click Synchronize Now.
Microsoft Access cannot close the database at this time. Make sure
there is no Visual Basic code executing in the current database. You
may need to run Setup again to properly install Briefcase Replication.
Microsoft Access cannot complete this operation because it can’t find
or initialize the dynamic-link library Msrclr40. Rerun Microsoft Access
or Microsoft Office Setup again to reinstall Microsoft Briefcase
Replication. During Setup, click Add/Remove, and select Microsoft
Briefcase Replication. If you want to preserve your security or custom
settings, back up the Microsoft Access workgroup information file. For
information on backing up files, search the Microsoft Windows Help
index for ‘backing up files’.
The database must be closed prior to synchronization. Do you want
Microsoft Access to close the database and synchronize with ‘|’?
All open objects must be closed before synchronizing. Do you want
Microsoft Access to close the objects?
Microsoft Access can’t synchronize this member of the replica set
because one or more objects are open. Because synchronizing may
involve updating the data in or design of the database, all objects must
be closed before you synchronize. Close all objects and try again.
You can’t save design changes to ‘|’ at a replica. Design changes to
replicated objects can be made only at the Design Master.
You can’t save design changes to ‘|1’ at a replica. Design changes to
replicated objects can be made only at the Design Master. Do you want
to save it as a new, local object?
You can’t delete or rename ‘|’ at a replica. These operations can’t be
performed on a replica; they can be performed only at the Design
Master.
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7722

All open objects must be closed before creating a replica. Do you want
Microsoft Access to close the objects?
Microsoft Access couldn’t close one or more objects. Close all objects
manually and try again.
Microsoft Access has converted ‘|1’ to the Design Master for the
replica set. Only the Design Master can accept changes to the database
structure; however, data changes can be made at the Design Master or
any replica.
Microsoft Access has converted ‘|1’ to the Design Master for the
replica set and has created a replica at ‘|2’. Only the Design Master can
accept changes to the database structure; however, data changes can be
made at the Design Master or any replica.
Microsoft Access has created a replica at ‘|2’.
Microsoft Access can’t create a replica because this database is already
open in exclusive mode. Do you want Microsoft Access to close the
database?
Microsoft Access can’t overwrite ‘|’: the replica can’t be created at this
location. The file you are trying to overwrite may be open. Close any
other applications that might be using this file.
Microsoft Access can’t make a new replica at ‘|’ because the source has
the same path and file name. Choose a different path or file name for
the new replica.
The synchronization was completed successfully.
Microsoft Access can’t synchronize this member of the replica set
because it is open in exclusive mode. To open the database in shared
mode, close the database, click Open Database on the File menu, and
clear the Exclusive check box. Then select the database.
‘|’ is saved as a local table. Changes made to it won’t be sent to the
replicas in the set. To make this table available to other members of the
replica set, close the table, select it in the Database window, click
Properties on the View menu, and then select the Replicated check box.
The synchronization request has been received, and the Synchronizer
will complete the process as resources become available. Make sure
that the Synchronizer for this member of the replica set is running. It
may be several minutes before the synchronization will occur.
Microsoft Access has saved the design of table ‘|,’ but it will not be
made replicable until the Table window is closed.
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7735

Changes to this object can be made only at the Design Master. Any
changes you make will be discarded when the form is closed. To save
your changes, click Save As on the File menu and save the object
under a different name.
Microsoft Access has deleted ‘|’ and removed it from the replica set.
This change isn’t reflected until the database is closed and reopened.
Do you want Microsoft Access to close and reopen the database now?
Microsoft Access has converted ‘|1’ to the Design Master for the
replica set and has created a replica at ‘|2’. The new replica will not
appear in the list of potential synchronization partners until this database is closed and reopened. Do you want Microsoft Access to close
and reopen the database now?
Microsoft Access has successfully created a replica at ‘|2’. However,
the new replica will not appear in the list of potential synchronization
partners until this database is closed and reopened. Do you want
Microsoft Access to close and reopen the database now?
Microsoft Access has deleted ‘|’ and removed it from the replica set.
This change isn’t reflected until the database is closed and reopened.
Please close and reopen the database when you are finished synchronizing replicas.
Microsoft Access cannot synchronize with a database from a previous
version. Convert the database you are trying to synchronize with,
before synchronizing.
Microsoft Access can’t make a new replica at ‘|’ because the value
entered for priority is out of range. Priority for new replicas should be
in the range of 0-100.
Microsoft Access can’t make a password-protected database replicable
Backup, restore, and drop database operations are only available for
Microsoft SQL Server version 7.0 or later running on your local computer.
Microsoft Access can’t make a new replica at ‘|’ because the value
entered for priority is out of range. Priority for anonymous replicas
should be 0.
You can’t copy local objects in a replica. Design changes to replicated
objects can be made only at the Design Master.
The Database administrative components failed to load or initialize.
Verify that the components are installed and registered locally.
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7747

Database Replicas cannot be converted to prior versions of Microsoft
Access.
This stage of the conversion process is finished. To complete the conversion process, synchronize this replica to the (converted) Design
Master.
Open the Design Master and sync to this replica before opening.
In Datasheet view, you can’t set a control property if the control is part
of an option group.
In Design view, you can’t retrieve the value of the ObjectPalette property for an OLE object contained in a bound object frame. Microsoft
Access doesn’t display the OLE object in the object frame in Design
view. Remove the reference to the ObjectPalette property, or switch to
Form view before you run the macro or Visual Basic code that references the ObjectPalette property.
Microsoft Access can’t apply the filter because all the records are
locked. The RecordLocks property of the form or report or the Default
Record Locking option on the Advanced tab of the Options dialog box
(Tools menu) is set to All Records. Reset the value to No Locks or
Edited Record as appropriate.
|
You can’t move columns between two frozen columns in a datasheet.
To unfreeze all columns, click Unfreeze All Columns on the Format
menu.
Microsoft Access can’t start the Chart Wizard. The wizard may not be
installed, or this wizard has been disabled. To install the Chart Wizard,
rerun the Microsoft Access or Microsoft Office Setup program, click
Add/Remove, and then select the Wizards check box. To reenable this
wizard, click About Microsoft Access on the Help menu, and then click
the Disabled Items button to view a list of addins which you can
enable.
The form can’t display the What’s This button if the Minimize button
or the Maximize button is displayed. Set the WhatsThisButton property
to No, or set the MinMaxButtons property to None.
The form can’t display the Minimize button or the Maximize button if
the What’s This button is displayed.
This ActiveX control isn’t enabled in Form view. You can’t set the
Enabled or TabStop properties to True.

7748
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This ActiveX control isn’t visible in Form view. You can’t set the
Visible or TabStop properties to True.
This property is locked and can’t be changed.
An error occurred when you changed the control.
The pattern string is invalid.
This feature isn’t installed, or has been disabled. To install this feature,
rerun the Microsoft Access or Microsoft Office Setup program or, if
you’re using a third-party add-in, reinstall the add-in. To reenable this
wizard, click About Microsoft Access on the Help menu, and then click
the Disabled Items button to view a list of addins which you can
enable.
This feature isn’t installed, or has been disabled. To install this feature,
rerun the Microsoft Access or Microsoft Office Setup program, click
Add/Remove, and then select the Wizards check box. To reenable this
wizard, click About Microsoft Access on the Help menu, and then click
the Disabled Items button to view a list of addins which you can
enable.
This feature isn’t installed, or has been disabled. To install this feature,
rerun the Microsoft Access or Microsoft Office Setup program, click
Add/Remove, and then click the Additional Wizards check box. To
reenable this wizard, click About Microsoft Access on the Help menu,
and then click the Disabled Items button to view a list of addins which
you can enable.
This control can’t be changed to the type you requested.
An error occurred while Microsoft Access was creating a section.
In order to change data through this form, the focus must be in a bound
field that can be modified.
The filter operation was canceled. The filter would be too long.
Microsoft Access didn’t apply the filter. Microsoft Access may not be
able to apply the filter if you entered an invalid data type in one of the
fields. Do you want to close the filter anyway? If you click Yes,
Microsoft Access will build the filter, but won’t apply it to the recordset. Then it will close the Filter By Form window.
You can’t set the ColumnOrder property when you are in Form view or
Print Preview.
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7773

Microsoft Access can’t set the LimitToList property to No right now.
The first visible column, which is determined by the ColumnWidths
property, isn’t equal to the bound column. Adjust the ColumnWidths
property first, and then set the LimitToList property.
You can’t set the MenuBar property while an OLE object is in-place
active.
There are too many controls on the form to allow Filter By Form.
You’ve used the ListIndex property incorrectly.
You can’t save an object when you are in the Filter By Form window.
Switch to Form view, and then save the object.
You can’t set a form’s MenuBar property from its menu bar macro.
Right-click the Form selector button (located to the left of the horizontal ruler) on the form in Design view. Click Properties, click the Other
tab, and then set the MenuBar property.
You’re trying to insert into a section that can’t grow enough for the
control you’re trying to add. The maximum total height for all sections
in a report, including the section headers, is 200 inches (508 cm).
Remove, or reduce the height of, at least one section. Then try to add
the control again.
You can’t create a new instance of this form or report while it is in
Design view.
This form or report is already being designed as a subform or subreport. To open this form in Design view, select the subform or subreport
and click Subform in New Window on the View menu.
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7782
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7785

7788
7789
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7791

Microsoft Access didn’t build the filter. There is an error in the current
field. Do you want to close the filter anyway? If you click Yes,
Microsoft Access will undo the changes to the filter, and then close the
Filter By Form window.
Compile error.
Type mismatch.
Microsoft Access can’t create the |1. Either there was an error getting
information from the table or query you selected, or a new |2 could not
be created.
There was an error creating your |1. Some fields may have been
skipped because there was an error getting information about them or
because they didn’t fit on the |2.
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7792
7793
7794
7795

You can’t open a subform when it is also open in Design view.
You must save the form ‘|’ before you can embed it.
Microsoft Access couldn’t find the toolbar ‘|’.
The custom toolbar ‘|’ is the wrong type (menu, shortcut menu, or toolbar) for the property it’s being used in.
The process failed because there is no printer installed. Because
Microsoft Access saves the printer settings with each form or report, a
printer is needed to convert, enable, copy and paste, import, or export
your forms or reports. To install a printer, point to Settings on the
Windows Start menu, click Printers, and then double-click Add Printer.
Follow the instructions in the wizard.
You must save new objects in the database before you can save them to
this external format.
You can only save select, crosstab, and union queries to this format.
This form or report is based on a query that exceeds the limit for data
in a single record. Exclude any unnecessary fields from the query, or
change some of the field types to Memo in the original tables.
You can’t create a Microsoft Access MDE database from a database in
an old format. Close the database and convert it to the current version
of Microsoft Access. Then create the MDE database.
This database is in an unrecognized format. The database may have
been created with a later version of Microsoft Access than the one you
are using. Upgrade your version of Microsoft Access to the current
one, then open this database.
That command isn’t available in an MDE/ADE database.
Microsoft Access can’t rename |1 to |2. The convert operation failed.
This is already an MDE database.
This database does not have a Visual Basic project, so it can’t be made
into an MDE file. Open the database in Microsoft Access to create the
Visual Basic project.
You can’t make the open database into an MDE file while running a
macro or Visual Basic code. Instead of using a macro or code, on the
Tools menu, point to Database Utilities, and then click Make MDE
File.
Microsoft Access can’t replace an existing file as a result of converting
the Microsoft Access database. You must select a new file name.
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7809

You can’t rename a | object in the client/server version of Microsoft
Access.
You can’t compact the open database while running a macro or Visual
Basic code. Instead of using a macro or code, on the Tools menu, point
to Database Utilities, and then click Compact/Repair Database.
Microsoft Access requires Microsoft SQL Server 6.5 or later for
Access projects. You need to upgrade the selected SQL database to
Microsoft SQL Server 6.5 or later.
Microsoft Access projects can only be connected to Microsoft SQL
Server
Restoring a database requires that no one is currently using the database. Do you want to close all objects, select a backup file, and restore
the database from backup?
Dropping a database requires that no one is currently using the database. Do you want to close all open objects and drop the database?
Microsoft Access was unable to create an ADE database.
Microsoft Access requires this Microsoft SQL Server 6.5 installation to
be upgraded to service pack 5 in order to successfully connect to this
server.
The database file ‘|’ is already open. You cannot encrypt to an open file.
Microsoft Access was unable to create the Database window. Please
upgrade to a newer version of Microsoft Internet Explorer.
You have chosen a database template file that is not supported in the
current version of Microsoft Access. To create a database using the
Database Wizard, click the Databases tab in the New dialog box and
then double-click a database icon.
Microsoft Access no longer supports Pages as startup documents.
The TEMP environment variable isn’t defined. Microsoft Access can’t
find the temporary file directory.
Microsoft Access can’t initialize the transfer object. Make sure you
have Microsoft SQL Server or the Microsoft SQL Server Desktop
Engine installed on the local machine.
The source or destination database name is missing. The transfer
operation can’t continue.
The source or destination server name is missing. The transfer
operation can’t continue.
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Microsoft Access can’t find the server ‘|’.
The database object type isn’t supported by the Microsoft Access
transfer operation.
The current database ‘|1’ has |2 active connections. Microsoft Access
must disconnect all applications before you can copy the database file.
What do you want to do to all the active connections?
The object ‘|’ is not a valid Microsoft SQL Server database object.
Microsoft Access can’t transfer this object.
The SQL script used to create database objects is corrupted. Microsoft
Access can’t create the new objects.
The SQL script used to create database object ‘|’ is corrupted.
Microsoft Access can’t create the new object.
Microsoft Access can’t create the file ‘|’.
The current database ‘|’ is replicated and can’t be copied until you disable replication. Use Microsoft SQL Server Enterprise Manager to
remove publications and subscriptions before copying the database file.
The current database ‘|’ has more than one data file and can’t be
copied.
The Transfer Database Wizard didn’t provide enough information to
perform the transfer operation.
Microsoft Access can’t copy the database file because one or more
objects are open. Do you want to close all the objects?
Microsoft Access can’t copy the database file because one or more
objects are open. Close all objects and try again.
Invalid argument in script.
There were errors during the database transfer operation. Open the
transfer log file for details.
Errors occurred during the database transfer operation.
The database transfer operation failed. The destination database ‘|’ was
created and is in an unknown state. What would you like to do with the
destination database?
The destination file ‘|’ already exists. Set the Overwrite flag to TRUE if
you want to replace the existing file.
This operation requires Microsoft SQL Server version 7.0 or later on
your local computer. You can install Microsoft SQL Server 2000
Desktop Engine from the MSDE2000 folder on the Microsoft Office
2002 CD-ROM.
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7843

You can only copy the database file when the current database is on
your local computer. If you want to make a copy of a database on a
remote server point to Database Utilities on the Tools menu, and then
click Transfer Database.
Microsoft Access can’t copy the database file because there are active
connections to the current database.
|
Microsoft Access can’t compact and repair the current database.
‘|’ already exists. Microsoft Access must create a backup of your file
before performing the repair operation. Enter a name for the backup
file.
The transfer operation has been cancelled. The destination database ‘|’
was created and is in an unknown state. What would you like to do
with the destination database?
The repair operation has been cancelled because Microsoft Access
couldn’t create a backup of the file. You might not have adequate permissions or enough disk space to create the backup file. To repair the
file manually, point to Database Utilities on the Tools menu, and then
click Compact and Repair Database.
Microsoft Access can’t find the wizard, or the wizard has not been
installed, or there is a syntax error in the Declarations section of a
Visual Basic module.
The wizard you need may be missing from the Libraries key of the
Microsoft Access section of the Windows Registry, or the wizard has
been disabled. To make sure that the wizard is in the Windows
Registry, run Setup to reinstall Microsoft Access, and then compile all
Visual Basic modules in the database. To reenable this wizard, click
About Microsoft Access on the Help menu, and then click the Disabled
Items button to view a list of addins which you can enable.
The toolbar name ‘|’ you entered already exists. Enter a unique name
for this toolbar.
The toolbar name ‘|’ you entered doesn’t follow Microsoft Access
object-naming rules. For more information about naming objects, click
Help.
The default column width must be at least 0.1 inch.
You can’t export database objects (except tables) from the current
version of Microsoft Access to earlier versions of Microsoft Access.
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You must have a database open to create custom toolbars, and the database can’t be read-only.
‘|’ cannot be imported, exported, or copied to Access project files.
The Tab Width setting in the Options dialog box (Tools menu) for the
Module or Debug window must be from 1 through 32.
Microsoft Access can’t start because there is no license for it on this
machine.
The profile ‘|’ that you specified on the command line doesn’t exist in
the Windows Registry.
‘|’ cannot be imported, exported, or copied to Access database files.
Microsoft Access can’t find the wizard. This wizard has not been
installed, or there is an incorrect setting in the Windows Registry, or
this wizard has been disabled. To reenable this wizard, click About
Microsoft Access on the Help menu, and then click the Disabled Items
button to view a list of addins which you can enable. Rerun Microsoft
Access or Microsoft Office Setup to reinstall the wizards. If the missing wizard is not a Microsoft Access wizard, reinstall it using the Addin Manager.
Links can only be created between Microsoft Access database files.
Microsoft Access doesn’t allow empty strings.
There is already an existing database with the name you entered. Give
the new database a unique name.
Microsoft Access can’t open the database because it is missing, or
opened exclusively by another user.
You already have the database open.
You can’t use a SetMenuItem macro action on a default menu.
SetMenuItem is for custom menus only.
The SetMenuItem action does not have enough information to be carried out. An argument is invalid, or there are not enough arguments.
Microsoft Access can’t find the database ‘|.’ Check the database name
(and path, if specified) to make sure you entered it correctly.
The table name you entered doesn’t follow Microsoft Access objectnaming rules. For more information about naming objects, click Help.
This recordset is not updateable.
‘|’ cannot be imported, exported, or copied to another database or project file.
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7874

Microsoft Access can’t find the object ‘|.’
• You misspelled the object name. Check for missing underscores ( _ )
or other punctuation, and make sure you didn’t enter leading spaces.
• You tried to open a linked table, but the file containing the table isn’t
on the path you specified. Use the Linked Table Manager to update
the link and point to the correct path.
The table ‘|’ already exists. You created or renamed a table, and then
tried to save it. Before Microsoft Access could save the table, another
user created or renamed one using the same name.
There isn’t enough temporary disk space to complete the operation.
Free disk space, and then try the operation again. For more information
on freeing temporary disk space, search the Microsoft Windows Help
index for ‘disk space, freeing’. For information on compacting a database to free disk space, click Help.
Microsoft Access can’t sort on the Memo, OLE Object, or Hyperlink
‘|’. The ORDER BY clause of an SQL statement can’t include any
Memo, OLE Object, or Hyperlink fields.
The data has been changed. Another user edited this record and saved
the changes before you attempted to save your changes. Re-edit the
record.
An invalid IDA has been passed to Microsoft Access error handling.
Please report this error and the steps that caused it.
The value you entered is the wrong data type for this field. Enter an
integer.
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7876

7877
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7879
7880
7881

7882
7883
7884

The Macro Conversion Wizard can’t be started. This wizard may not be
installed, or this wizard has been disabled. To reenable this wizard,
click About Microsoft Access on the Help menu, and then click the
Disabled Items button to view a list of addins which you can enable.
Rerun Microsoft Access or Microsoft Office Setup to reinstall this wizard. If you want to preserve your security or custom settings, back up
the Microsoft Access workgroup information file. For more information on backing up files, search the Microsoft Windows Help index for
‘backing up files’.
You can’t convert, enable, or encrypt an Access Project file.
You can’t set the MenuBar property unless a database is open.
You can’t export an object to itself. Select a different database to
export to, or give the object a new name.
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7885
7886

The source database has no import/export specifications to copy.
Microsoft Access can’t find the dynamic-link library (DLL) Mso.
Rerun the Microsoft Access or Microsoft Office Setup program.
A unique record identifier can’t consist of more than 10 fields.
You must set the default font size to a number from |1 through |2. For
more information on the FontSize property, click Help.
The file ‘|’ does not exist.
The file ‘|’ doesn’t contain any data. You can’t import from, or link to,
an empty spreadsheet.
This database is read-only. The conditional compilation argument
option can’t be saved.
An error occurred while saving module options. You may be running
Visual Basic in break mode. Reset the running code before changing
the module options.
You can’t import objects into a database created in an earlier version of
Microsoft Access. Convert the database to the current version of
Microsoft Access using the Convert Database command (Tools menu,
Database Utilities submenu).
Microsoft Access was unable to create a window. The system is out of
resources or memory. Close unneeded programs and try again. For
more information on freeing memory, search the Microsoft Windows
Help index for ‘memory, troubleshooting’.
Error ‘|’ in the validation rule.
Error ‘|’ in the default value.
Execution of this application has stopped due to a run-time error. The
application can’t continue and will be shut down.
Microsoft Access can’t be started. Microsoft Access was unable to initialize the Windows Registry. Rerun Microsoft Access or Microsoft
Office Setup to reinstall Microsoft Access.
Microsoft Access can’t convert the database because it can’t create an
error table.
Microsoft Access can’t convert the database because it can’t write to
the error table.
Errors occurred converting |1 validation rules and default values. See
error table ‘|2’ for a list of errors.
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7903

Microsoft Access can’t insert this field. There are too many fields in
the table. The limit is 255.
An error occurred in the Field Builder. You’ve replaced or modified the
default Field Builder, and Microsoft Access is unable to run the new
version. Reinstall Microsoft Access to correct the error.
Microsoft Access can’t change these field data types. Some data in this
table violates the record validation rule. Before any data types can be
changed, remove the record validation rule or correct the data.
Microsoft Access couldn’t launch the Lookup Wizard, or this wizard
has been disabled. Rerun the Microsoft Access or Microsoft Office
Setup program, click Add/Remove, and select the Wizards check box.
To reenable this wizard, click About Microsoft Access on the Help
menu, and then click the Disabled Items button to view a list of addins
which you can enable.
You don’t have permission to modify the design of this table. For more
information on permissions and who can set them, click Help.
You can’t modify this table now because someone else is using it.
Microsoft Access can’t add another column to this table. You can have
up to 255 columns in your table.
Microsoft Access can’t delete this column. Tables must have at least
one column.
Microsoft Access can’t delete this index. This table participates in one
or more relationships. Delete its relationships in the Relationships window first.
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7905
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7913

7914
7915

7916

Once you save the change to the data type of this column, you will not
be able to change back to the previous data type. Are you sure you
want change the data type?
You can’t change a random-valued AutoNumber field to an incremental
AutoNumber field. The values of random-valued AutoNumber fields
aren’t continuous.
You can’t convert ReplicationID values to other data types.
You can’t delete the field ‘|’; it is a replication system field. Use a
make-table query to create a new table that contains all the fields in the
table except system fields. For information on make-table queries, click
Help.
Microsoft Access is unable to start the Lookup Wizard. The Lookup
Wizard doesn’t apply to fields of this data type.
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7917

‘|’ cannot be created due to the project being disconnected. Use the
Connection… command under the File menu to connect the project to
a database.
The Object Name argument for the ‘Save’ macro action is not supported within an Access Project for Table or Query objects. You cannot
save these objects with a new name in an Access Project.
The default data type you selected is not supported in all versions of
Microsoft SQL Server. If the server doesn’t support the data type you
have chosen, the varchar data type will be used in its place.
You can’t refer to the RecordsetClone property of a form when the
form is open in Design view.
You entered an expression that has an invalid reference to the
RecordsetClone property. For example, you may have used the
RecordsetClone property with a form or report that isn’t based on a
table or query.
You made an illegal function call. Check the syntax of the function you
are trying to use.
The value you entered doesn’t match the type required.
• The variable, property, or object may not be of the correct type.
• You may have used an If TypeOf construct with something other than
a control.
The expression you entered requires the control to be in the active
window. Try one of the following:
• Open or select a form or report containing the control.
• Create a new control in the active window, and try the operation
again.
There is no current code context object.
The syntax of the subquery in this expression is incorrect. Check the
subquery’s syntax and enclose the subquery in parentheses.
You used a Like operator with an incorrect pattern. Make sure the
comparison value is enclosed in quotation marks.
The Replication ID you entered is invalid. Make sure the Replication
ID you enter contains only digits or letters for hexadecimal numbers,
that the Replication ID is the correct length, and that it is in a canonical SQL form.
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7959

The expression contains an ambiguous name. You may have two or
more functions with the same name in different modules. Rename the
functions so that each one has a unique name.
There was an error compiling this function. The Visual Basic module
contains a syntax error. Check the code, and then recompile it.
Microsoft Access can’t find the module ‘|’ referred to in a macro
expression or Visual Basic code. The module you referenced may be
closed or may not exist in this database, or the name may be misspelled.
The index number you used to refer to the module is invalid. Use the
Count property to count the open modules and make sure that the module number is not greater than the number of open modules minus 1.
Microsoft Access can’t run the macro or callback function ‘|’. Make
sure the macro or function exists and takes the correct parameters.
You entered an expression that has an invalid reference to the
Recordset property. You can only use a dynaset or snapshot recordset to
set this property.
The object you entered is not a valid Recordset property. For example,
you may have used a forward-only recordset, or tried to set it to null.
The format condition number you specified is greater than the number
of format conditions. Use the Count property to count the format conditions for the control and then check that the format condition number
you cite is within the range of existing format conditions.
A required minimum or maximum value is missing.
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The format condition Type you specified is invalid. Valid values for the
Type property are 0 to 2 for the first condition, and 0 to 1 for all other
format conditions.
The format condition Operator you specified is invalid. Valid values for
the Operator property are 0 to 7.
Microsoft Access can’t open the file ‘|.’ It may not be a database, or it
may be a database you are unable to open.
Microsoft Access can’t follow the hyperlink to ‘|’. Please verify the
destination.
Microsoft Access encountered an error while trying to show the
Hyperlink dialog.
The hyperlink address or subaddress text you entered was too long for
Microsoft Access to store. The text was truncated to fit in the available
space, so the link may not work as expected.
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Microsoft Access failed to insert a hyperlink at the current location.
You chose an invalid control type for use with hyperlinks. You can only
use hyperlinks with labels, images, command buttons, or bound text
boxes.
There is no stored hyperlink in this control.
Microsoft Access is unable to paste the data on the clipboard as a
hyperlink.
Microsoft Access is unable to add the current hyperlink to the favorites
folder.
You can’t use the hyperlink property builder with more than one control selected.
The HyperlinkAddress or HyperlinkSubAddress property is read-only
for this hyperlink.
The values for ‘File or web page name’ and/or ‘Text to Display’ are too
long. The values will be truncated. To keep your original values, click
Cancel in the Edit Hyperlink dialog.
Microsoft Access can’t follow the hyperlink because it couldn’t create
the hyperlink object.
You entered an invalid project name. You may have deleted the default
project name and forgotten to specify a new one.
The Microsoft Access Source Code Control Add-in is not available;
this object will be opened read-only.
The Microsoft Access Source Code Control Add-in could not be
started.
The object | is currently checked in and is therefore read-only. To modify the object, close it first, then check it out and reopen it.
There was a problem communicating with the Source Code Control
Add-in.
The menus on your form or report that are based on Microsoft Access
macros will not be visible while the Customize dialog box is open. To
have the full power of menu or toolbar customization, convert your
macro-based menus to menus or toolbars. With the macro selected in
the Database window, point to Macro on the Tools menu, and create a
menu, a toolbar, or a shortcut menu from that macro.
Microsoft Access couldn’t create the Data and Misc. Objects because
the linked table ‘|’ could not be found. To create the Data and Misc.
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8000
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8002

8003

8004

ErrorString
Objects, use the Linked Table Manager (Tools menu, Add-ins submenu) to update the link to the source table or file, or delete the link
from your current database.
You can’t save the standard module ‘|’ over a class module with the
same name. Save the standard module to a different name, or delete the
class module first.
You can’t save the class module ‘|’ over a standard module with the
same name. Save the class module to a different name, or delete the
standard module first.
Microsoft Access can’t delete this relationship because you don’t have
the Data and Misc. Objects checked out. Check out the Data and Misc.
Objects and then delete the relationship.
The name you entered already exists for another object of the same
type in this database. Do you want to replace the existing |?
‘|’ has been changed since the last time you opened it, either by another
user or because another instance of it was opened on your own
machine. Do you want to replace the changes that you or another user
made?
• To save your most recent changes and discard the other user’s
changes or your previous changes, click Yes.
• To save this version of the object with another name, click No.
‘|’ has been changed since the last time you opened it, either by another
user or because another instance of it was opened on your own
machine. Do you want to replace the changes that you or another user
made?
• To save your most recent changes and discard the other user’s
changes or your previous changes, click Yes.
• To cancel saving this version of the object, click No.
You must save a table or query before you can create a new object
based on it. Do you want to save and use the table or query to create a
new object?
The layout of ‘|’ has been changed since the last time you opened it,
either by another user or because another instance of it was opened on
your own machine. Do you want to replace the changes that you or
another user made?
• To save your most recent changes and discard the other user’s
changes or your previous changes, click Yes.
• To cancel saving this version of the object, click No.
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8005

You can’t save this object. You must have Administer permission for
the Database object in order to save modules, forms, or reports in a
Design Master.
The name you entered already exists for another object of the same
type in this database. Do you want to replace the existing |? You will
not be able to undo this operation.
You cannot get into Exclusive Mode right now because this database is
opened by other users or because you do not have permissions to open
exclusively.
The stored procedure executed successfully but did not return records.
Do you want to save changes to the design of |?
Do you want to save changes to |?
Do you want to delete the | and empty the Clipboard? You tried to
delete a database object that is currently on the Microsoft Access
Clipboard. If you delete it from your database, you won’t be able to
paste it later.
Do you want to delete the |? For more information on how to prevent this
message from displaying every time you delete an object, click Help.
Do you want to exit Microsoft Access and empty the Clipboard?
Microsoft Access can’t change the working directory to ‘|.’ Verify that
the drive is valid and the path is 260 characters or less in length.
|
Do you want to save changes to the layout of |?
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Do you want to remove the link to the |? If you delete the link, you
delete only the information Microsoft Access uses to open the table,
not the table itself.
The toolbar ‘|’ is partly unreadable. Microsoft Access can’t display all
the toolbar buttons. The specified toolbar may be in a different format
than the toolbars in the current version of Microsoft Access. Click OK
to close the dialog box, and then add the buttons missing from the toolbar. Microsoft Access will then update the toolbar to the latest format.
Are you sure you want to restore the default settings to the built-in
toolbar or menu bar |? If you previously customized, moved, changed
the visibility, or otherwise altered the toolbar or menu bar, or any of
the menus that cascade from it, Microsoft Access removes your
changes, returns the original buttons to their original order, and shows
or hides the toolbar based on the original setting. To return the built-in
toolbar or menu bar to its original state, click Yes.
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The source application isn’t responding. Do you want to continue waiting? The DDE channel is established, but the data exchange wasn’t
completed in the amount of time specified in the OLE/DDE Timeout
setting in the Options dialog box (Tools menu).
• To continue waiting for the data exchange to be completed, click Yes.
• To cancel the data exchange and try again later, click No.
This linked table has indexes that use an unsupported sort order. If you
modify this table, the Microsoft Jet database engine can’t correctly
maintain the table’s indexes. As a result, your data may appear in the
wrong order, and functions that use the table’s indexes may have unexpected results. Try one of the following:
• Cancel this operation. Use the application in which the table was created to re-create the indexes, making sure to specify an ASCII or
International sort order. Then try again to link the tables.
• Use this table on a read-only basis.
You can’t delete the table ‘|’ until its relationships to other tables have
been deleted. Do you want Microsoft Access to delete the relationships
now?
Do you want to permanently delete the |? If you click Yes, you won’t
be able to undo the deletion.
Microsoft Access couldn’t create the custom toolbar ‘|.’
Would you like to remove the compacted database from Source Code
Control?
Microsoft Access must close the | in order to complete this operation.
Would you like Microsoft Access to close it now?
You do not have the | checked out. Microsoft Access can’t check out an
object while it is open, and you can’t make design changes until you
check it out. If you want to make design changes to this object, first
close it, check it out, and then reopen it.
Microsoft Access must save the | in order to complete this operation.
Would you like Microsoft Access to save it now?
You do not have the Data and Misc. Objects checked out. You can’t
create a new table or save changes to a data access page.
To import tables, relationships, menus, toolbars, import/export specs or
data access pages you must have the Data and Misc. Objects checked
out.
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Are you sure you want to cut the |?
This object will be removed from your local database, but not from
source code control. The next time you get this database from source
code control, the object will reappear. Are you sure that you want to
delete the local object?
Microsoft Access was not able to add a reference to the type library for
this control because Data and Misc. Objects is not checked out. Check
out the Data and Misc. Objects and add a reference to the library ‘|’.
An error occurred while trying to create the linked table ‘|’. Check to
make sure that the source table or file is available, and then retry the
operation on the Data and Misc. Objects.
You have set |1’s Type property to Popup, which changes the toolbar to
a shortcut menu. The shortcut menu disappears because Microsoft
Access adds |2 to the Shortcut Menus toolbar. To complete the shortcut
menu, close the Toolbar Properties sheet, display the Shortcut Menus
toolbar, click the Custom category, and then add the commands you
want.
Microsoft Access must save the | to the current database in order to
complete this operation. Would you like Microsoft Access to save it
now?
An error occurred trying to add one or more references from the source
code control project. The library may not be registered on your computer. Check your project references and add any missing references
after registering the missing components that this database requires.
Restoring a database requires that no one is currently using the database. Do you want to close all objects, select a backup file, and restore
the database from backup?
Dropping a database requires that no one is currently using the database. Do you want to close all open objects, and drop the database?
Are you sure you want to delete the conflict table |? You will not be
able to undo this operation.
This database is enabled for publication. Do you want to delete existing publications and drop the database?
Access could not save your project. Do you want to cancel the close
operation?
•To cancel the close operation, click Yes.
•To close without saving, click No.
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Send a pointer to the data access page? To send an e-mail message that
contains a pointer to your data access page, click Send Pointer. This is
the recommended method. The e-mail recipient must have access to the
server or public share to view the page. To send a copy of the page,
click Send Copy. To cancel sending the page, click Cancel. For more
information, click Help.
Send a copy of the data access page? The contents of the page will be
copied into the body of the email message, however the page will connect to the data source when the recipient views the message. If this is
correct, click OK. Otherwise, click Cancel, save the page to a server or
public share, and resend a pointer to the page. It is generally more
secure to send a pointer to the page than to send a copy of the page.
For more information, click Help.
You tried to create a group filter based on a column type which cannot
be used in a filter.
Microsoft Access can’t change the working directory to ‘|.’ Please enter
a non-Internet location.
The connection string of this page specifies an absolute path. The page
might not be able to connect to data through the network. To connect
through a network, edit the connection string to specify a network
(UNC) path.
Your computer has resumed operation after Critical Suspend mode.
Any unsaved changes might have been lost. To ensure proper operation, close and reopen any files. Restarting Microsoft Access is recommended.
The database ‘|’ is read-only. You won’t be able to save changes made
to data or object definitions in this database.
You can’t make changes to the database objects in the database ‘|.’ This
database was created in an earlier version of Microsoft Access. To convert this database to the current version of Microsoft Access, close the
database, point to Database Utilities on the Tools menu, and then click
Convert Database.
The file ‘|’ already exists. Do you want to replace the existing file? If
you want to compact or convert to a different file name, click No. Enter
the new file name after the /compact or /convert option in the command line, and run the command again.
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The setting you entered is invalid. The database’s sort order can’t be
updated. The setting you entered in the New Database Sort Order
option of the Options dialog box (Tools menu) isn’t a valid sort order
for the version of the database you are compacting.
You can’t open ‘|’ for exclusive use because another user has the database open or because you do not have permissions to open exclusively.
Microsoft Access will open the database for shared access.
You can’t make changes to the database objects in the database ‘|.’ This
database was created in an earlier version of Microsoft Access. To convert this database to the current version of Microsoft Access, close the
database, point to Database Utilities on the Tools menu, and then click
Convert Database.
Does the first row of your data contain column headings?
This database is a replica created in a previous version of Microsoft
Access. You can view objects in this database, but you can’t modify
their design. If you want to modify objects in this database, convert the
Design Master for this replica set to the current version of Microsoft
Access and synchronize this replica. Do you want to open the database
anyway?
The name you entered already exists for another custom group in this
database. Do you want to replace the existing custom group |? You will
not be able to undo this operation.
Microsoft Access has made a backup of database |1 at |2. Note: Only
server-related objects have been backed up. To protect other objects,
back up the .ADP file manually
Microsoft Access successfully restored database |1 from its backup at
|2
Do you want to permanently delete the custom group ‘|’? If you click
Yes, all shortcuts in the custom group will be deleted as well, and you
won’t be able to undo the deletion.
The name you entered already exists for another shortcut in this group.
Do you want to replace the existing shortcut ‘|?’
The project ‘|’ is read-only. You won’t be able to save changes made to
object definitions in this project.
Microsoft Access encountered one or more errors during conversion.
To view a summary of these errors, open the ‘|’ table.
The HTML file associated with this link has been moved, renamed, or
deleted. File: ‘|’
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Renaming this user-defined function removes any existing permissions
and extended properties. Do you want to complete the rename action?
A form with a subform object can’t have its DefaultView property set
to Continuous Forms. You tried to add a subform to a form in Design
view. Microsoft Access will reset the property to Single Form.
You can’t modify this field because it is read-only. Some fields, such as
a calculated field, are read-only by design. However, any field can be
read-only if its Locked property is set to Yes.
Microsoft Access has reached the end of the records. Do you want to
continue searching from the beginning?
Microsoft Access has reached the beginning of the records. Do you
want to continue searching from the end?
Microsoft Access finished searching the records. The search item was
not found.
Do you want to continue to search or replace?
There isn’t enough memory to save the current filter. Close unneeded
programs. Return to the form or datasheet, and then redefine and reapply the filter. For more information on freeing memory, search the
Microsoft Windows Help index for ‘memory, troubleshooting’.
There isn’t enough memory to execute the macro that updates the
active filter. Microsoft Access is closing the Filter window.
Close unneeded programs. Then try again to open the Filter window.
For more information on freeing memory, search the Microsoft
Windows Help index for ‘memory, troubleshooting’.
Microsoft Access can’t find ‘|.’ The text string you entered in the Find
What box can’t be evaluated against the current field. Reenter the text
string so that it conforms to the data type of the field.
You won’t be able to undo this Replace operation. There isn’t enough
free memory to use the Undo command. Do you want to continue?
Microsoft Access can’t save the current record. Do you want to undo
the changes to the record and continue the Paste operation?
Records that Microsoft Access was unable to paste have been inserted
into a new table called ‘|.’ In the Database window, open the new table
to see the unpasted records. After you fix the problems that resulted in
the paste errors, copy and paste the records from the new table.
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None of the field names you pasted onto the Clipboard match the field
names on the form. Microsoft Access treats the data in the first row on
the Clipboard as field names. If you copied the data from another
application, the first row of data may have taken the place of the field
names. Do you want to paste the field names in the order you defined
with the Tab Order command?
Some of the field names for the data you tried to paste don’t match
field names on the form. Microsoft Access treats data in the first row
on the Clipboard as field names. In this case, some of those field
names don’t match the field names on the form. Do you want to paste
only that data whose names match the field names on the Clipboard?
Do you want to suppress further error messages telling you why
records can’t be pasted? If you click No, a message will appear for
every record that can’t be pasted.
You copied a large amount of data onto the Clipboard. When you copy
data onto the Clipboard, only the reference to the object is copied. If
you close the source document, however, Microsoft Access must paste
all the data from its source. Depending on the amount of data, this can
take some time. Do you want to save this data on the Clipboard?
You selected more records than can be copied onto the Clipboard at
one time. Divide the records into two or more groups, and then copy
and paste one group at a time. The maximum number of records you
can paste at one time is approximately 65,000.
Do you want to suppress further error messages telling you why
records can’t be deleted? If you click No, a message will appear for
every record that can’t be deleted.
You won’t be able to undo this Replace operation. Do you want to
continue?
You are about to delete | record(s). If you click Yes, you won’t be able
to undo this Delete operation. Are you sure you want to delete these
records?
You are about to paste | record(s). Are you sure you want to paste these
records?
You won’t be able to undo this Delete operation. The Undo command
won’t be available because this operation is too large, or there isn’t
enough free memory. Do you want to delete these items?
All timers are in use. Set the TimerInterval property back to zero so
that you can start another timer.
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Do you want to delete the custom palette information from this form or
report and revert to the default palette?
Do you want to delete the graphic from this button?
The remote data isn’t accessible. You tried to open a form or report that
includes a DDE or DDESend function in a calculated control that specifies an OLE server application. Do you want to start the application |?
Microsoft Access encountered a problem while trying to switch views
and must close this window.
Do you want to delete the group section for the database object ‘|’ and
its contents? You will not be able to undo this action. The group header
or footer you want to delete contains controls and will be deleted along
with the section.
Deleting these sections will also delete all controls in them. You will
not be able to undo this action. Do you want to delete these sections
anyway?
Do you want to delete the selected group level(s) and all associated
sections and their controls? The field or expression you’re deleting
from the Sorting and Grouping box has an associated section (a header
or footer) containing controls that will be deleted along with the section.
Relationships that specify cascading deletes are about to cause |
record(s) in this table and in related tables to be deleted. Are you sure
you want to delete these records?
The section width is greater than the page width, and there are no items
in the additional space, so some pages may be blank. For example, the
report width may be wider than the page width.
Do you want to remove this picture from the form?
Some data may not be displayed. There is not enough horizontal space
on the page for the number of columns and column spacing you specified. Click Page Setup on the File menu, click the Columns tab, and
then reduce the number of columns or the size of the columns.
When you save this form or report, any code behind it will be deleted.
You have set the HasModule property to No, creating a form or report
that opens more quickly. Any macros associated with this form or
report will not be affected, nor will code in separate modules that is
called from this property sheet. Are you sure you want to do this?
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You are about to delete this section. If you click Yes, the controls you
placed in this section will be deleted. Are you sure you want to delete
these controls?
Relationships that specify cascading deletes are about to cause
record(s) in this table and in related tables to be deleted. Are you sure
you want to delete these records?
You are about to delete one or more records. If you click Yes, you
won’t be able to undo this Delete operation. Are you sure you want to
delete these records?
Microsoft Access could not perform the delete operation. An error
occurred during the delete operation, no records were deleted.
Microsoft Access did not detect a relationship between the fields you
have chosen. Do you want a relationship to be created for you now?
You are about to delete this section and all related sections. If you click
Yes, the controls you placed in these sections will be deleted. Are you
sure you want to delete these controls?
You won’t be able to undo this paste operation. Do you want to
continue?
Microsoft Access can’t save the filter criteria you entered in the Insert
Hyperlink dialog box. Make sure that the data access page is bound to
a record source before you set the filter criteria. Also make sure that
the criteria is in the form of a WHERE clause; for example,
EmployeeID=[EmployeeID].
Microsoft Access won’t be able to undo this action or subsequent
actions. To make more resources available so that Access can record
further design actions, close and reopen this window. Do you want to
continue anyway?
The file ‘|’ is not readable by JET. If you think you have a valid JET
file then this is most likely due to the recent file format change. Do
you want to attempt to upgrade the database format?
The database ‘|’ needs to be repaired or isn’t a database file. You or
another user may have unexpectedly quit Microsoft Access while a
Microsoft Access database was open. Do you want Microsoft Access to
attempt to repair the database?
Microsoft Access was unable to load all the library modules.
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Microsoft Access couldn’t close database ‘|.’ Your last change may not
have been saved because an internal buffer was locked by another user
(whose name was given in the previous message). To avoid losing data,
wait for the other user to finish using the record, and then click OK
again. If you click Cancel, you may lose changes that haven’t been
saved.
You can’t undo this command and, once it’s completed, you won’t be
able to edit this object. Do you want to continue anyway?
Microsoft Access can’t open the file ‘|’.
|
Successfully repaired the ‘|’ database.
Microsoft Access was unable to completely repair the ‘|’ table and
deleted some Memo, OLE Object, or Hyperlink field values. To
recover the data, restore from your backup copy of the database.
Note that the data in the deleted field may have been damaged by a bad
sector on your hard disk. For more information on checking your disk’s
surface, files, and folders for errors, search the Windows Help index for
‘checking for disk errors’.
One or more records were unrecoverable and were deleted from the ‘|’
table.
The ‘|’ table was truncated; data was lost.
One or more indexes from the ‘|’ table couldn’t be repaired and were
deleted.
The Save As command can’t process any subforms contained in your
report. Do you want to proceed anyway?
An error occurred while adding this word to the custom dictionary.
• The dictionary file may be read-only.
• There may be a disk error.
An error occurred while adding this word to the Change All list. The
dictionary may be full.
An error occurred while adding the word to the Ignore All list. The
dictionary may be full.
The specified word is too large. Words can’t exceed 64 characters.
Microsoft Access can’t open the ‘|’ custom dictionary.
Microsoft Access can’t start the spelling checker because it isn’t
installed.
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Microsoft Access can’t open the main dictionary file. Verify that this
file has been correctly installed.
The spelling checker only works on text fields that contain text data.
You’re trying to check a field with a data type other than Text or
Memo.
The spelling checker can’t proceed; you must first select data from a
table, query, view, stored procedure, or form.
The spelling checker can’t proceed; form data is not updateable. The
form may be based on a query that isn’t updateable or is only partly
updateable. For information on when a query is updateable, click Help.
An error occurred while trying to modify the contents of field ‘|.’ The
field may be locked or read-only, or you may not have permissions to
change it. For information on security permissions and who can change
them, click Help.
An error occurred while trying to save spelling preferences.
The ‘|’ field can’t be modified because it’s a read-only field.
An error occurred while trying to add the word pair to the AutoCorrect
list.
The current selection does not contain any fields that can be checked
for spelling errors. You can check the spelling of text box controls with
Text or Memo data types.
You entered an invalid main dictionary. Please select a valid entry.
The spelling check is complete.
You must restart the spelling checker for the dictionary change to take
effect.
The ‘|’ custom dictionary doesn’t exist. Do you want to create it?
You have specified a word that isn’t found in the main or custom dictionary. Do you want to use this word and continue checking?
The main dictionary you selected can’t be used. It has not been correctly installed.
The spelling checker can’t undo your last change. The data in field ‘|’
has been modified by another user. To resume the spelling check, click
OK.
This database must be closed before you can create a replica. Do you
want Microsoft Access to close this database and create the replica? If
you proceed, Microsoft Access will close your database and convert it
to a Design Master. The database may increase in size.
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The Hangul Hanja Converter can’t proceed. There is no Hangul or
Hanja data to convert.
Microsoft Access can’t register the ‘|’ custom dictionary.
After you have converted this file to Access 2002 File Format, the new
file cannot be shared with Access 2000 users or Access 97 users. For
more information about conversion, click Help.
This data access page was created in a previous version of Microsoft
Access. To open this page in Design view, you must convert it to the
current version of Access. Once you have converted this page, you
can’t open it in Design view in a previous version of Access.
After you have converted this file to Access 2000 File Format, the new
file cannot be shared with Access 97 users. Any functionality specific
to Access 2002 will not be available in Access 2000. For more information about conversion, click Help.
After you have converted this file to Access 97 File Format, any functionality specific to Access 2000 or Access 2002 will be lost. For more
information about conversion, click Help.
You must first save the table. Do you want to save the table now?
You must first save the view. Do you want to save the view now?
You must first save the stored procedure. Do you want to save the
stored procedure now?
You must first save the query. Do you want to save the query now?
Do you want to permanently delete the selected field(s) and all the data
in the field(s)? To permanently delete the field(s), click Yes.
There is no primary key defined. Although a primary key isn’t
required, it’s highly recommended. A table must have a primary key for
you to define a relationship between this table and other tables in the
database. Do you want to create a primary key now?
Changing to this data type requires removal of one or more indexes.
You can’t use indexes on fields with a Memo, OLE Object, or
Hyperlink data type. If you click Yes, Microsoft Access will delete the
indexes that include that field. Do you want to continue anyway?
Deleting field ‘|’ requires Microsoft Access to delete the primary key.
Do you want to delete this field anyway?
Deleting field ‘|’ requires Microsoft Access to delete one or more
indexes. If you click Yes, Microsoft Access will delete the field and all
its indexes. Do you want to delete this field anyway?
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You can’t open the table ‘|’ for modification. A query or form bound to
the table is open, you may not have permission to open this table in
Design view, or another user has the table open. Do you want to open
this table as read-only? If you have opened a query or form bound to
this table, close it, and then try again to open the table in Design view.
Table ‘|’ is a linked table with some properties that can’t be modified.
Do you want to open it anyway?
Microsoft Access encountered errors while converting the data. The
contents of fields in |1 record(s) were deleted. Do you want to proceed
anyway?
Microsoft Access can’t retrieve field properties from the system tables.
The database needs to be repaired. If you click Yes, Microsoft Access
will open the table in Design view. The settings of the FieldName,
DataType, FieldSize, Indexed, and Primary properties will remain
intact, but the settings of other field properties will be lost.
You can attempt to redefine the lost properties, but it is recommended
that you restore the database from a backup copy, or close it and use
the Repair Database command on the Tools menu (Database Utilities
submenu).
Do you want to continue anyway?
Microsoft Access can’t save property changes for linked tables. Do you
want to continue anyway?
Microsoft Access was unable to append all the data to the table. The
contents of fields in |1 record(s) were deleted, and |2 record(s) were
lost due to key violations.
• If data was deleted, the data you pasted or imported doesn’t match
the field data types or the FieldSize property in the destination table.
• If records were lost, either the records you pasted contain primary
key values that already exist in the destination table, or they violate
referential integrity rules for a relationship defined between tables.
Do you want to proceed anyway?
Changing to this data type requires removal of the primary key. Do you
want to continue anyway?
Some data may be lost. The setting for the FieldSize property of one or
more fields has been changed to a shorter size. If data is lost, validation rules may be violated as a result. Do you want to continue anyway?
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Your computer is out of disk space. You won’t be able to undo this
paste append. Do you want to continue anyway?
Microsoft Access was unable to append all the data to the table. The
contents of fields in |1 record(s) were deleted, and |2 record(s) were
lost due to key violations.
• If data was deleted, the data you pasted or imported doesn’t match
the field data types or the FieldSize property in the destination table.
• If records were lost, the records you pasted contain primary key values that already exist in the destination table, or they violate referential integrity rules for a relationship defined between tables.
Microsoft Access can’t find the database containing the linked table ‘|.’
The properties set in Microsoft Access for the linked table will be lost.
Do you want to continue with the conversion anyway?
Data integrity rules have been changed; existing data may not be valid
for the new rules. This process may take a long time. Do you want the
existing data to be tested with the new rules?
Existing data violates the new record validation rule. Do you want to
keep testing with the new rule?
• To keep the new rule and continue testing, click Yes.
• To revert to the old rule and continue testing, click No.
• To stop testing, click Cancel.
Existing data violates the new setting for the ‘|1’ property for field ‘|2.’
Do you want to keep testing with the new setting?
• To keep the new setting and continue testing, click Yes.
• To revert to the old setting and continue testing, click No.
• To stop testing, click Cancel.
Microsoft Access deleted | indexes on the converted fields. Some data
did not convert properly.
You must save the table first. Microsoft Access can’t test your data
until you save the design changes you made. Do you want to save the
table now?
This operation will test the table’s record and field validation rules, as
well as the Required and AllowZeroLength properties, for all data in
the table. This process may take a long time. Do you want to continue
anyway?
All data was valid for all rules.
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Existing data violates the new record validation rule. Do you want to
continue testing data with this new rule?
• To continue testing for other new rule violations, click Yes.
• To continue to test only the old validation rules, click No.
• To stop testing, click Cancel.
The existing data violates the ‘|1’ property for field ‘|2.’ If you continue
testing, Microsoft Access will inform you if data violates any other
property settings in the table. Would you like to continue testing?
There is no primary key defined. Although a primary key isn’t
required, it’s highly recommended. A table must have a primary key
for you to add data to this table or to define relationships between this
table and other tables in the database. Do you want to return to table
design and add a primary key now?
There is no primary key defined. Although a primary key isn’t
required, it’s highly recommended. A table must have a primary key
for you to define relationships between this table and other tables in
the database. Do you want to return to table design and add a primary
key now?
You must first save the function. Do you want to save the function
now?
You can’t print the scrollable (unfrozen) columns on the datasheet. The
frozen columns are wider than the page. Do you want to print just the
frozen columns? If you want to print the unfrozen columns, try one or
more of the following:
• Decrease the column width and increase the row height of the frozen
columns.
• Change the page orientation to Landscape in the printer Properties
dialog box.
• Decrease the size of the left and right page margins in the Page Setup
dialog box.
The column heading is too tall to fit on the page. Part of the heading
will be cut off. Do you want to print the incomplete heading? To prevent headings from being cut off, try one or more of the following:
• Change the page orientation to Portrait in the printer Properties dialog box.
• Decrease the size of the top and bottom page margins in the Page
Setup dialog box.
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10252

At least one column is too wide to fit on the page. Data in that column
will be cut off. Do you want to print the column with incomplete data?
To prevent data from being cut off, try one or more of the following:
• Decrease the column width and increase the row height.
• Change the page orientation to Landscape in the printer Properties
dialog box.
• Decrease the size of the left and right page margins in the Page Setup
dialog box.
The row height exceeds the space between the top and bottom margins.
Do you want to print the columns with incomplete data? To prevent
data from being cut off, try one or more of the following:
• Increase the column width and decrease the row height.
• Change the page orientation to Portrait in the printer Properties dialog
box.
• Decrease the size of the top and bottom page margins in the Page
Setup dialog box.
You are about to run an update query that will modify data in your
table. Are you sure you want to run this type of action query? For
information on how to prevent this message from displaying every time
you run an action query, click Help.
You are about to run an append query that will modify data in your
table. Are you sure you want to run this type of action query? For
information on turning off confirmation messages for document deletions, click Help.
You are about to run a make-table query that will modify data in your
table. Are you sure you want to run this type of action query? For
information on how to prevent this message from displaying every time
you run an action query, click Help.
You are about to run a delete query that will modify data in your table.
Are you sure you want to run this type of action query? For information on how to prevent this message from displaying every time you
run an action query, click Help.
You are about to run a data-definition query that may modify data in
your table. Are you sure you want to run this type of an SQL query? If
not, click No and then modify the query or close it to run later.
You are about to update | row(s). Once you click Yes, you can’t use the
Undo command to reverse the changes. Are you sure you want to
update these records?
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You are about to append | row(s). Once you click Yes, you can’t use the
Undo command to reverse the changes. Are you sure you want to
append the selected rows?
You are about to paste | row(s) into a new table. Once you click Yes,
you can’t use the Undo command to reverse the changes. Are you sure
you want to create a new table with the selected records?
You are about to delete | row(s) from the specified table. Once you
click Yes, you can’t use the Undo command to reverse the changes. Are
you sure you want to delete the selected records?
Microsoft Access can’t update all the records in the update query.
Microsoft Access didn’t update |1 field(s) due to a type conversion failure, |2 record(s) due to key violations, |3 record(s) due to lock violations, and |4 record(s) due to validation rule violations. Do you want to
continue running this type of action query anyway?
To ignore the error(s) and run the query, click Yes.
For an explanation of the causes of the violations, click Help.
Microsoft Access can’t append all the records in the append query.
Microsoft Access set |1 field(s) to Null due to a type conversion failure,
and it didn’t add |2 record(s) to the table due to key violations, |3
record(s) due to lock violations, and |4 record(s) due to validation rule
violations. Do you want to run the action query anyway?
To ignore the error(s) and run the query, click Yes.
For an explanation of the causes of the violations, click Help.
Microsoft Access can’t add all the records in the update or append
query. It set |1 field(s) to Null due to a type conversion failure.
A type conversion failure is caused when the data in one or more fields
doesn’t match the DataType or FieldSize property in the destination
table. For example, leaving blank fields in a Yes/No field or entering
text in a numeric field will cause this error. Do you want to ignore the
errors and run the update or append query anyway? To ignore the
error(s) and run the query, click Yes.
Microsoft Access can’t delete |2 record(s) in the delete query due to
key violations and |3 record(s) due to lock violations. Do you want to
run this action query anyway?
To ignore the error(s) and run the query, click Yes.
For an explanation of the causes of the violations, click Help.
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10513

The existing | will be deleted before you run the query. Do you want to
continue anyway?
You won’t be able to undo the changes this action query is about to
make to the data in a linked table or tables. Do you want to run this
action query anyway?
Microsoft Access was unable to update all the records in the update
query. Microsoft Access didn’t update |1 field(s) due to a type conversion failure, |2 record(s) due to key violations, |3 record(s) due to lock
violations, and |4 record(s) due to validation rule violations. For an
explanation of the causes of the violations, click Help.
Microsoft Access can’t append all the records to the table. Microsoft
Access set |1 field(s) to Null due to a type conversion failure, and it
didn’t add |2 record(s) due to key violations, |3 record(s) due to lock
violations, and |4 record(s) due to validation rule violations. For an
explanation of the causes of the violations, click Help.
Microsoft Access can’t add all the records in the make-table query. It
set |1 field(s) to Null due to a type conversion failure. A type conversion failure is caused when the data in one or more fields doesn’t
match the DataType or FieldSize property in the destination table. For
example, leaving blank fields in a Yes/No field or adding text in
numeric field will cause this error.
Microsoft Access can’t delete all the records in the delete query.
Microsoft Access didn’t delete |2 record(s) due to key violations and |3
record(s) due to lock violations. For an explanation of the causes of the
violation, click Help.
There isn’t enough disk space or memory to undo the data changes this
action query is about to make. Do you want to run this action query
anyway? For information on freeing disk space or freeing memory,
search the Microsoft Windows Help index for ‘disk space, freeing’ or
‘memory, troubleshooting’.
Do you want to save the changes made to the SQL statement and
update the property? The RecordSource or RowSource property contained a SQL statement when you invoked the Query Builder, so the
original SQL statement was modified. To close the Query Builder without changing the original SQL statement, click No.
Do you want to save the changes made to the query and update the
property? The RecordSource or RowSource property contained the
name of a query when you invoked the Query Builder, so the original
query was modified. To close the Query Builder without changing the
original query, click No.
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You invoked the Query Builder on a table. Do you want to create a
query based on the table?
You are about to run a pass-through query that may modify data in
your table. Are you sure you want to run this type of an SQL query?
For information on how to prevent this message from displaying every
time you run an SQL query, click Help.
| output column(s) in the query were unnamed and will not show any
data.
Do you want to save the changes made to the SQL Statement and
update the text editor? The Stored Procedure or Function contained an
SQL statement when you invoked the Query Builder, so the original
SQL statement was modified. To close the Query Builder without
changing the original SQL statement, click No.
Are you sure you want to permanently delete the selected relationship
from your database?
A relationship already exists. Do you want to edit the existing relationship? To create a new relationship, click No.
The field name is missing in row |. You haven’t selected a matching
field for this relationship in each row of the grid. Select fields so that
the grid has the same number of fields on the left and right sides, and
then try to create the relationship again.
This relationship has been modified or deleted by another user since
you opened the Relationships window. Do you want to edit the relationship and overwrite the other user’s changes? To update your
Relationships window to include the other user’s changes, click No.
This relationship has already been deleted by another user. To update
your view, click OK.
The layout of the Relationships window will be cleared. Do you want
to continue?
You can’t display queries or linked tables in the Relationships window
for this database. The database ‘|’ was created in an earlier version of
Microsoft Access. If you want to convert this database to the current
version of Microsoft Access, use the Convert Database command on
the Tools menu (Database Utilities submenu).
The relationship has been created as a one-to-many relationship
because there are duplicate entries in the related field. You’ve tried to
create a one-to-one relationship, but the data in the tables suggests that
a one-to-many relationship is more appropriate.
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10608

To create a relationship, use the mouse to drag a field from one table to
another.
This document was previously formatted for the printer |1 on |2, but
that printer isn’t available. Do you want to use the default printer |3 on
|4?
This document was previously formatted for the printer ‘|1 on |2’, but
that printer isn’t available. The page settings shown in the Print Setup
dialog box are for the current default printer ‘|3 on |4’. Do you want to
continue?
You must save the macro before you run it. Do you want to save the
macro now?
• To save the macro and then run it, click Yes.
• To return to the Macro window for this macro or to the window you
executed the Run Macro command from, click No.
Some of the macro actions you are trying to save cannot be performed
in Access 97. These actions will be permanently deleted from the
macro in the Access 97 version of your database.
Microsoft Access finished adding the index ‘|.’ Add another index from
the Select Index Files dialog box, or click Close.
The Microsoft Access index information (.inf) file for ‘|’ already exists.
Do you want to replace the existing Microsoft Access .inf file for the
dBASE or Microsoft FoxPro file you’re linking?
• To create a new .inf file, click Yes.
• To use the existing file, click No.
If the .inf file contains invalid or outdated information, you must click
Yes to create a new .inf file before you can link the table.
The database object ‘|’ already exists. Do you want to replace the existing database object with the one you are exporting? If you want to
export this object without replacing the existing database object, click
No. You can then export the object again and rename it in the Export
dialog box.
Not all of the import specifications could be imported due to name
conflicts. Conflicts existed in | of the specifications. Rename the conflicting import specifications, and try the import operation again.
Invalid CDF file name
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A form with a bound ActiveX control or an embedded object bound to
a data source can’t have its DefaultView property set to Continuous
Forms. You tried to add a bound ActiveX control to a form in Design
view. Microsoft Access will reset the DefaultView property to Single
Form.
Either the data access page file has been opened by another user or you
don’t have write permission to the file. If you make changes, you will
have to save them to another file.
An unexpected error occurred while saving document properties to the
data access page.
You tried to drop an OLE or binary column onto your data access
page. There is no HTML control which binds correctly to this column
type.
You have chosen to permanently delete the data access page. Do you
want to delete both the link and page file(s), or delete just the link?
| There is a problem with Internet Explorer registry settings. Please
reinstall Internet Explorer.
Microsoft Access data access pages can only be viewed in Microsoft
Internet Explorer, but it is not your default Browser. Do you want to
open Internet Explorer to view this page?
A link to this data access page could not be created because the Data
and Misc. Objects are not checked out.
The save operation was successful. A folder was created for your supporting files at the save destination. This directory had to be created
because the server does not support long file names.
You must save your data access page before you can preview it. Do
you want to save now?
The data access page has been saved, but one or more of the supporting files (i.e., image, sound, video files) are missing. You may need to:
• Delete and recreate the HTML object(s) on the page.
• Reapply the theme, if the page has a theme.
The save completed, but files for the selected theme are missing.
Please apply a new theme to your data access page, and save again.
Do you want Microsoft Access to set the DataPageSize property of this
group level to All?
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10905

You have opened a page that was last designed using Access 2000. The
page must be saved using Office 2002 Office Web Components before
you can edit this document. Would you like to convert this page?
Are you sure you want to delete this account? You can’t undo the deletion of a user or group account. To restore a user or group account that
has been deleted, you must recreate the account using the same name
and personal identifier (PID).
You don’t have permission to modify ‘|.’ To modify this object, you
must have Modify Design permission for it. If the object is a table, you
must also have Delete Data and Update Data permissions for it. Do you
want to save a copy of the object as a new object?
You don’t have permission to view this macro. To view a macro, you
must have Read Design permission for it. Do you want to continue to
run the macro?
You don’t have permission to modify ‘|.’ To modify this object, you
must have Modify Design permission for it. If the object is a table, you
must also have Delete Data and Update Data permissions for it. Do you
want to open it as read-only?
You changed the permissions of ‘|1’ for ‘|2.’ Do you want to assign
these permissions now?
You don’t have permission to open ‘|’ for exclusive use. Microsoft
Access is opening the database for shared access. To open a database
for exclusive access, you must have Open Exclusive permission for it.
For more information on permissions and who can set them, click
Help.
;LCID=0x0409
You haven’t entered a workgroup ID. To ensure that your workgroup
information file is unique, enter a unique workgroup ID of up to 20
numbers or letters. Continue without a workgroup ID?
The file ‘|’ already exists. Replace existing file?
Workgroup Files (•.mdw)
Select Workgroup Information File
Open
You have successfully created the workgroup information file ‘|.’
Could not find file: ‘|’
You have successfully joined the workgroup defined by the workgroup
information file ‘|’
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It is strongly recommended that you change the system administrator
(SA) password when this operation is complete. To change the SA
password point to Security on the Tools menu, and then click Set
Login Password.
There isn’t enough memory to create an input area. Close unneeded
programs. Then try to create the input area again. For more information on freeing memory, search the Microsoft Windows Help index for
‘memory, troubleshooting’.
Microsoft Access failed to save module ‘|.’ Your computer may be low
on disk space. For information on freeing memory or disk space,
search the Microsoft Windows Help index for ‘memory, troubleshooting’ or ‘disk space, freeing’.
Microsoft Access failed to create the Visual Basic module ‘|.’ If your
database is on a network drive, check your network connection, and
then try again.
Microsoft Access failed to convert or enable your code modules. Your
computer may be low on disk space or memory.
The new procedure name you provided is invalid.
The procedure ‘|’ already exists. Choose another procedure name.
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Microsoft Access failed to create a Debug window toolbar. The system
may be out of resource memory. Close unneeded programs and try
again. For more information on freeing memory, search the Microsoft
Windows Help index for ‘memory, troubleshooting’.
During the paste or import operation, Microsoft Access failed to convert the ‘|’ module from an earlier version of a Microsoft Access database. Your computer may be low on disk space or memory.
Microsoft Access couldn’t create storage space for a Visual Basic module. If your database is on a network drive, check your network connection, and then try again.
Microsoft Access couldn’t open the storage space for a Visual Basic
module. Your computer may be low on disk space. For information on
freeing memory or disk space, search the Microsoft Windows Help
index for ‘memory, troubleshooting’ or ‘disk space, freeing’.
The function name is too long. Microsoft Access will truncate the
function name to 255 characters.
Microsoft Access failed to save the database. Your computer may be
low on disk space. For information on freeing memory or disk space,
search the Microsoft Windows Help index for ‘memory, troubleshooting’ or ‘disk space, freeing’.
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This action will reset the current code in break mode. Do you want to
stop the running code?
• To halt the execution of the program so the Module window can be
closed, select Yes.
• To leave the code in the current state, select No.
You can’t add a reference to a Microsoft Access workgroup.
You can’t remove this reference. Microsoft Access needs this reference
in order to work properly.
You can’t add a reference to the open database.
The database | was created in an earlier version of Microsoft Access.
Convert this database to the current version of Microsoft Access by
using the Convert Database command on the Tools menu (Database
Utilities submenu).
You can’t use a standard module for this operation.
The module name ‘|’ is invalid.
• The module name may start with the prefix Form_ or Report_.
• The module can’t be named Forms, Reports, Modules, Application,
Screen, Assistant, CommandBars, References, or DoCmd.
• The module name may have too many characters.
Another user has modified this database. To see the current version,
close the database and open it again.
This operation isn’t available while there is a module in break mode.
Reset the executing code and try the operation again.
There were compilation errors during the conversion or enabling of this
database. The database has not been saved in a compiled state. The performance of this database will be impaired because Microsoft Access
will need to recompile the database for each session. For information
on improving performance, click Help.
There are calls to 16-bit dynamic-link libraries (.dll) in modules in this
database. These won’t work under Microsoft Windows 95 or Microsoft
Windows NT. Change your code to call equivalent 32-bit dynamic-link
libraries (.dll).
The current user account doesn’t have permission to convert or enable
this database. To convert or enable a database, ensure the following:
• You must join the workgroup that defines the user accounts used to
access the database.
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• Your user account must have Open/Run and Open Exclusive permissions for the database object.
• Your user account must have Modify Design or Administer permissions for all tables in the database, or it must be the owner of all
tables in the database.
• Your user account must have Read Design permission for all objects
in the database.
• Request that other users close the database.
There are calls to 16-bit dynamic-link libraries (.dll) in modules in this
database. These won’t work under Microsoft Windows 95 or Microsoft
Windows NT. Translate these calls to equivalent 32-bit dynamic-link
libraries.
The database that you are trying to open or convert is currently in use,
or you do not have permission to open it exclusively. When you convert a database, or the first time you open an earlier version database,
another user can’t have the database open. Try one of the following:
• Request that other users close the database.
• Using the version of Microsoft Access in which the database is written, have your workgroup administrator grant you the permission to
open the database exclusively.
Multiple users can share the database after you convert it, or after you
open it for the first time.
Microsoft Access was unable to save the project. Another user is saving the project now. Do you want to retry?
The Save operation failed.
You are trying to open a read-only database. The first time you open an
earlier version database, you must be able to write changes to the database.
• The database file’s read-only attribute may be set; clear this attribute.
• You may have chosen the Open Read Only command in the Open
dialog box. Don’t choose this command the first time you open the
database.
• Your license to use this application may have expired.
Microsoft Access can’t establish a reference to the specified database.
The referenced database can’t be found, or it’s locked exclusively by
another user so it can’t be opened. Restore the referenced database
from a backup copy or ask the user that has the database locked to
open the database in nonexclusive mode.
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Microsoft Access can’t create or open the requested database now. The
database may be locked exclusively by another user.
The ‘|’ module is open; Microsoft Access can’t set the permissions on
an open module.
Microsoft Access can’t add references to a replicated database; changes
will be ignored.
Microsoft Access is unable to import the module from the source
replica. Synchronize the source database.
Microsoft Access is currently unable to rename the form, report, or
module to ‘|’. Close the database, reopen it, and then try the rename
operation again.
One or more forms or reports contains an ActiveX control that could
not be loaded. These controls will not function properly until you register them, open the forms or reports in Design view, and save the
forms or reports.
One or more forms or reports contains an ActiveX control that could
not be loaded. These controls will not function properly until you register them, open the forms or reports in Design view, and save the
forms or reports.
Microsoft Access has converted the code in ‘|’ to your current version
of Visual Basic. To improve the performance of this database, do the
following:
1. Open any module in this database in Design view.
2. On the Debug menu, click Compile And Save All Modules.
DAO version 3.0 is not compatible with this version of Microsoft
Access. Create a reference to DAO version 3.5. For information on setting references, click Help.
You can’t import, export, create, modify, or rename any forms, reports,
pages or modules in an MDE database.
You can’t create a module for a form or report if it is read-only, or if
the database is read-only.
Microsoft Access was unable to open the Visual Basic project for this
database. Another user is saving the project now. Do you want to retry?
MDE databases can’t reference MDB databases. MDE databases can
only reference other MDE databases or type libraries.
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You can’t refer to a form or report module from Form view or Report
preview if the form’s or report’s HasModule property is set to No.
Switch to Design view or set the HasModule property to Yes in order
to refer to the module.
Microsoft Access couldn’t compile this database because one or more
references couldn’t be resolved. The database has not been saved in a
compiled state. The performance of this database will be slower
because Microsoft Access will need to recompile the database for each
session. For information on improving performance, click Help.
The current user account doesn’t have permission to make an MDE file
from this database. To make an MDE file, do the following:
• Join the workgroup that defines the user accounts used to access the
database.
• Make sure the user account has Open/Run and Open Exclusive permissions for the database object.
• Make sure the user account has Modify Design or Administer permissions for the MSysModules2 table in the database.
• Request that other users close the database.
The Visual Basic for Applications project in the database ‘|’ can’t be
converted to the current Visual Basic format. If the database is an
MDE, you will need to rebuild the MDE from the source MDB. If you
don’t have the source MDB, you will need to obtain a new version of
the MDE that is compatible with the current version of Visual Basic.
Microsoft Access can’t create any more controls on this form or report.
If you have deleted controls from this form or report in the past, you
may be able to rename the form or report and then add more controls
to it.
Microsoft Access can’t add, rename, or delete the control(s) you
requested.
The form or report ‘|’ has too many controls. Reduce the number of
controls on the form or report before using it in this version of
Microsoft Access.
Someone else is using ‘|’ and the Visual Basic for Applications project
does not match your version of Visual Basic. You need to open the
database exclusively in order to upgrade the Visual Basic for
Applications project in this database.
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The database ‘|’ is read-only and the Visual Basic for Applications project does not match your version of Visual Basic. You need to open the
database read-write in order to upgrade the Visual Basic for
Applications project in this database.
You can’t create a module for a form or report while an instance of the
form or report is in browse mode.
Microsoft Access was unable do display the module.
File not found.
There were compilation errors during the conversion or enabling of this
database. This might be due to old DAO syntax that is no longer supported. For an example on how to fixup the code, click Help.
The module name ‘|’ is misspelled or refers to a module that doesn’t
exist. If the invalid module name is in a macro, an Action Failed dialog
box will display the macro name and the macro’s arguments after you
click OK. Open the Macro window, and enter the correct module name.
The Visual Basic for Applications project in the database is corrupt.
You do not have exclusive access to the database at this time. If you
proceed to make changes, you may not be able to save them later.
Microsoft Access can’t save design changes or save to a new database
object because another user has the file open. To save your design
changes or to save to a new object, you must have exclusive access to
the file.
You do not have exclusive access to the database. Your design changes
cannot be saved at this time. Do you want to close without saving your
changes?
You do not have exclusive access to the database. You cannot convert
this database at this time.
Microsoft Access cannot complete this operation. You must stop the
code and try again.
Microsoft Access cannot save the digital signature at this time.
• You may be in a database under Source Code Control.
• You may be in a database which is read only.
Your Microsoft Access database or project contains a missing or broken reference to the file ‘|1’|2
• To ensure that your database or project works properly, you must fix
this reference.
• To learn how to fix this reference, click Help.

29058
29059
29060
29061

29062

29063
29064
29065

29066

29067
29068
29069

29070

Access 2002 and Jet 4 Errors
APPENDIX E

ErrorString

29071
29072

Missing or broken VBE reference to the file ‘|1’.
Microsoft Access has detected corruption in this file. To try to repair
the corruption, first make a backup copy of the file. Then, on the Tools
menu, point to Database Utilities and click Compact and Repair
Database. If you are currently trying to repair this corruption then you
will need to recreate this file or restore it from a previous backup.
You do not have exclusive access to the database. You cannot continue
with the Source Code Control command.
Microsoft Access failed to create the Visual Basic module. If your
database is on a network drive, check your network connection, and
then try again.
Microsoft Access could not find the SQL Server specified. Verify that
the server name is correct.
Microsoft Access could not find the database on the server. Verify that
the database name is correct.
Microsoft Access could not log on to the server. Verify that the log on
information is correct.
The Default Max Records setting must be between 0 and 2147483647.
Missing SQL command
Access was not able to perform this operation because the project is
not connected to a SQL Server database.
Can’t sort on one or more fields specified in ‘Order By’ property or
sorting/grouping dialog.
The server you are trying to access is case sensitive. Objects of the
same name but of different case are not supported. Using these objects
may result in a loss of data.
Another user or application has deleted this record or changed the
value of its primary key.
Cannot apply Filter on one or more fields specified in the Filter
property.
Cannot get column information for the database object being browsed.
A Server Filter cannot be applied to a stored procedure Record Source.
Filter not applied.
You can’t update the record because another user or application deleted
it or changed the value of its primary key.
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30014

The data was added to the database but the data won’t be displayed in
the form because it doesn’t satisfy the criteria in the underlying record
source.
The specified record source contains duplicate names for some output
fields. Use aliases in your SELECT statement to give each field a
unique name.
The field ‘|’ is read only.
This database is not enabled for publication.
Cannot create objects of type ‘|’ against current SQL backend. Please
check your permissions and server setup.
Microsoft Access cannot copy a table with a name that is longer than
64 characters.
Cannot find column ‘|’.
Cannot use domain functions on stored procedures.
The Access project could not be opened. You may not have adequate
permissions, or the project may be read-only.
Cannot use domain functions on scalar functions.
Your password will not be encrypted before it is saved to the file. Users
who view the source contents of the file will be able to see the account
user name and password.
Invalid SQL Statement. Check the server filter on the form record
source
Access is unable to connect to ‘|1’ database on the ‘|2’ server. Make
sure that the database still exists and that the server is running.
The value you entered is not consistent with the data type or length of
the column.
The database name for the attached database file is blank. Enter a name
for your database.
You must specify criteria for all conditional formats.
A conditional format expression can’t be longer than 946 characters.
Microsoft Access can’t modify the control’s conditional formats right
now. Your program tried to modify the conditional format of a control
while the conditional format was being evaluated.
The setting for this property is too long. You can enter up to either 255
or 2,048 characters for this property, depending on the data type.
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31500

Microsoft Access can’t send this format in a mail message. To send
this format in a mail message, click Export on the File menu, or use
the OutputTo method to create the files and attach them to a mail message.
Microsoft Access can’t find the Microsoft Office international
dynamic-link library (DLL). Reinstall Microsoft Office.
Invalid field data type.
Cannot load the Office Web Components. Access had a problem loading the Office Web Components Version 9.0. Try going through set-up
to re-install them.
Cannot load the Office Web Components. Access had a problem loading the Office Web Components Version 10.0. Try going through set-up
to re-install them.
Microsoft Access can’t load the dynamic-link library |. You need to
resolve the failure and start Access again.
You have chosen to alter the mode in which SQL syntax will be interpreted in this database. This will mean:
• Existing queries may return different results or not run at all.
• The range of data-types and reserved words will change.
• Different wildcards will be used.
It is recommended that you make a backup copy of this database
before continuing. If you agree to continue, Access will close this database, compact it, and re-open in the new mode. Select OK to continue.
Microsoft Access can’t open the mail session. You may not have configured an e-mail client on this computer. Ensure that your e-mail software has been installed and configured properly.
All open objects must be closed prior to converting to a different version. Do you want Microsoft Access to close the objects?
Microsoft Access can’t convert this database to a different version
because one or more objects are open. Close all objects and try again.
Your database is using SQL Server Compatible Syntax (ANSI 92) for
which Access 2000 has limited support. This will mean:
• Access 2000 users may not be able to see some queries.
• Existing queries may return different results or not run at all.
• The range of data-types and reserved words will change.
• Different wildcards will be used.
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31516

31517

31518

31519
31520
31521
31522
31523

31524

31525

31526

ErrorString
It is recommended that you change the SQL Server Compatible Syntax
(ANSI 92) setting before converting this database to the Access 2000
file format. Select Cancel to abort the conversion process and change
the SQL Server Compatible Syntax (ANSI 92) setting.
Microsoft Access can’t convert this database to the requested version
because it has been ‘enabled’ to work with newer versions of Microsoft
Access than it was originally created with. You can convert this database to a newer format, and then retry this operation with the newly
converted database.
Microsoft Access can’t convert this database to the requested version
because it is from an older version of Microsoft Access. You can convert this database to a newer format, and then retry this operation with
the newly converted database.
The following controls contain expressions that can’t be represented in
a Microsoft Access project PivotTable or PivotChart view: |. Do you
still want to switch to PivotTable or PivotChart view?
You cannot import this file. You cannot import a text file unless it has
one of these extensions: |.
You cannot import this file. You cannot import a text file that has one
of these extensions: |.
Cannot establish connection to the server.
Microsoft SQL Server Desktop Engine must be on the machine running Microsoft Access.
Microsoft Access was unable to open the file ‘|’. The file may not be an
Access file, the path or filename specified may be incorrect, or the file
can not be opened exclusively. To repair the file manually, on the Tools
menu, point to Database Utilities, and then click Compact and Repair
Database.
Microsoft Access can’t transfer the user-defined function ‘|’. Userdefined functions can only be transferred between Microsoft SQL
Servers that are version 8.0 or higher.
The selected object can’t be pasted because the version of either the
source or the destination server is less than 7.0. Microsoft Access can
only copy and paste this object if both Microsoft SQL Servers are version 7.0 or higher.
You can’t create a Microsoft Access MDE database from a database in
Microsoft Access 2000 file format. Close the database and convert it to
the current version of Microsoft Access. Then create the MDE database.
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Path not found: |.
Table ‘|’ is in use. Please close the table and retry import.
View ‘|’ is in use. Please close the view and retry import.
Procedure ‘|’ is in use. Please close the procedure and retry import.
Microsoft Access cannot create table(s) using the information contained in the document(s) you are trying to import.
Microsoft Access was unable to export the data.
Invalid filename.
Your database is using SQL Server Compatible Syntax (ANSI 92) for
which Access 97 has limited support. This will mean:
• Existing queries may return different results or not run at all.
• The range of data-types and reserved words will change.
• Different wildcards will be used.
It is recommended that you change the SQL Server Compatible Syntax
(ANSI 92) setting before converting this database to the Access 97 file
format. Select Cancel to abort the conversion process and change the
SQL Server Compatible Syntax (ANSI 92) setting.
Invalid parameters for ExportXML. Press Help for more information.
The XML schema properties do not match the existing table structures.
Overwrite existing structures?
There is already an object named ‘|’ in the database.
Microsoft Access cannot create this file. To create the file, you must
give the file a unique name, provide a valid connection string and user
ID, and you must have the necessary connection and file creation permissions.
There was an error loading the XSL transformation file. Please make
sure that the file is a properly formatted XSL file and is the correct file
to use for the data supplied.
There was an error loading the XML data file. Please make sure that
the file is a properly formatted XML file.
Microsoft Access cannot open this file. This file is located outside your
intranet or on an untrusted site. Microsoft Access will not open the file
due to potential security problems. To open the file, copy it to your
machine or an accessible network location.
The startup action associated with this file may not be safe. Do you
want to execute the startup action as you open the file?
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31543

The startup action associated with this file may not be safe. If you
choose not to execute the startup action, Microsoft Access will not
open the file. Do you want to execute the startup action and open the
file?
Microsoft Access cannot open this file. The author of this file has set it
to open only when a startup action is executed, and Microsoft Access is
currently set to disable startup actions. To address this problem, contact
the author of the file or your system administrator.
Microsoft Access cannot open this file. The Internet Security Zone
Manager is missing or not correctly installed and therefore the safety
of this file cannot be verified. To address this problem, reinstall
Microsoft Internet Explorer or the appropriate Office System Pack.
This database is a Microsoft Access 7.0/8.0/9.0 Design Master. If you
click OK, the database you selected will be renamed to |1 and then
converted to |2. Everyone using a replica of this database will have to
upgrade to Microsoft Access 2002 after the next synchronization.
Microsoft Access cannot export this object to XML when it is open in
Print Preview. Close the object and try again.
Microsoft Access cannot export a table to XML when it is open in
Design. Close the object and try again.
Finished importing document ‘|’.
Not all of your data was successfully imported. Error descriptions with
associated row numbers of bad records can be found in the Microsoft
Access table ‘|’.
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